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1 Introducere

Suita ELO ECM va ofera un pachet complet pentru actualizarea modalitatii de management al informatiilor
digitale din compania dumneavoastra. Suita poate fi adaptata la nevoile dumneavoastra individuale, pentru
procese eficiente si un flux impecabil al informatiilor.

Toate documentele business importante sunt salvate intr-un spatiu central, utilizand o structura logica si in
conformitate cu normele legislative, pe parcursul intregii durate de viata a informatiei. Astfel, suita ELO ECM
inglobeaza toate cunostintele companiei intr-o platforma informationala centrala si va ofera acces facil si imediat
la orice detaliu cautat, permitand reactii rapide si informari aproape instantanee. Mecanismele inteligente de
cdutare sustin aceste functii.

Suita ELO ECM integreaza documentele companiei si informatiile disponibile in procesele business — chiar si
atunci cand informatiile provin din terte aplicatii. Acestea sunt disponibile intotdeauna la locul potrivit in
momentul potrivit. Beneficiati de procese de business accelerate si sisteme informatice care adauga valoare
companiei.

Digitizarea activitatilor manuale si convertirea depozitelor fizice, bazate pe hartie, in formate electronice, reduc
pierderile de timp si de bani concomitent cu sporirea transparentei in cadrul companiei. Toate modificarile aduse
documentelor sunt inregistrate si pot fi urmarite si datate cu usurinta.

Suita ELO ECM a fost dezvoltata intr-o abordare moderna pe mai multe nivele, are o structura modulara flexibila,
este bazata pe o arhitectura de tip SOA (Service Oriented Architecture) si pe standarde deschise. O caracteristica
remarcabild a suitei o reprezinta depozitul central de documente si informatii care permite accesarea serviciilor
de tip ECM (Enterprise Content Management) de catre utilizatori prin intermediul mai multor tipuri de clienti,
functie de rolul si de locatia acestora. Serviciile de tip ECM au fost dezvoltate complet in Java si ofera
independenta fata de platforma, ruland pe orice sistem de operare (Windows, Linux, Unix, Solaris, etc).

Prin suita ELO ECM va oferim un sistem ECM deosebit de puternic. Alegeti din numeroasele componente flexibile
pentru a ajusta suita la nevoile individuale ale companiei dumneavoastra.

Principalele beneficii pe care suita ELO ECM le ofera sunt urmatoarele:

- Imbunitateste si standardizeaza organizarea documentelor

- Oferad acces rapid si usor la informatie

- Elimina timpul pierdut pentru regdsirea documentelor

- Pregateste compania pentru trecerea la un birou fara hartii, in conformitate cu reglementarile legii
privind semndtura electronica

- Oferd un acces securizat la informatii prin stabilirea drepturilor de acces bazate pe ACL-uri, in
conformitate cu o schema de securitate cu caracter preemptiv si reactiv

- Permite reducerea spatiului de stocare al documentelor fizice

- Permite optimizarea proceselor de lucru si proceselor de luare a deciziilor

- Oferd un instrument de raportare si de audit

- Permite automatizarea proceselor de lucru

- Imbunétateste colaborarea angajatilor pe documente si informatii

- Arhivare in conformitate cu legislatia in vigoare

- Permite mentinerea compliantei si a standardelor ISO din cadrul companiei

- Oferad posibilitatea de lucru cu documentele indiferent de locatia angajatilor
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2 Arhitectura sistemului

Din punct de vedere tehnologic, suita ELO ECM a fost dezvoltata folosind tehnologia Java. O atentie sporita a fost
alocata pentru a se asigura conformitatea cu standardele si protocoalele tehnologice internationale recunoscute
pe plan mondial, cum ar fi: JSR 168, HTML, XML, JavaScript, Java, Web Services, XSL, WSDL, JMS, JEE, LDAP, SOAP,
REST, SMTP si HTTP/S si altele, care permit o integrare perfecta cu alte aplicatii web.

Arhitectura serverului Apache Tomcat sta la baza ELO Application Server, care lucreaza ca un container pentru
modaulele individuale si servletii ELO.

Suita ELO ECM este compatibila OpenlJDK.

2.1  Mediul ELO

Imaginea de mai jos ne aratd modul de conexiune intre serverul ELO si clientii ELO, impreuna cu protocoalele
folosite pentru comunicarea intre acestea. Sistemul ELO necesita un server web si o baza de date pentru a rula.
Tipurile de baza de date suportate sunt Microsoft SQL Server, Oracle Database, IBM DB2 si PostgreSQL. Pentru
versiunile comerciale, exista suport si pentru variantele gratuite sau expres disponibile. De cele mai multe ori, nu
este necesara interactiunea directa cu baza de date dupa ce aceasta a fost instalata. Pentru serverul web, ELO
utilizeaza Apache Tomcat pentru gestiunea si livrarea serviciilor catre clienti. Cele patru componente esentiale
ale serverului ELO sunt: ELO Indexserver, Access Manager, Document Manager si iSearch.

Figura 1 Comunicare server ELO si clientii ELO

Serverul ELO este robust, dovedit a fi imbatabil in ceea ce priveste performanta datorita arhitecturii acestuia,
componentele sistemului pot fi folosite pe componente hardware separate. Acest lucru creste atat scalabilitatea
sistemului céat si eficienta acestuia, asigurand recuperarea dedicata a datelor.

n cazul unei erori, toate componentele sistemului afectate vor fi incircate din alte sisteme hardware. Serverul
ELO suporta de asemenea instalare in mod cluster si modul de lucru hot standby. Ulterior, permite de exemplu
un sistem 1n oglinda care sa fie tinut functional pentru cazurile de urgenta.
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Prin arhitectura sistemului se asigura o flexibilitate ridicata a sistemului. Standardele folosite, mecanismele de
interoperare slab cuplate, permit modelarea arhitecturala a sistemului dupa nevoile beneficiarului. Astfel, pe
parcusul utilizarii sistemului, se pot extinde modulele curente ale solutiei sau se pot implementa noi
functionalitati. Sistemul ofertat este scalabil pe orice nivel tehnologic (baza de date, server de aplicatii sau ferma
de server web) putand fi configurat pentru a suporta un numar practic nelimitat de utilizatori.

Sistemele hardware pot fi usor schimbate pentru a se asigura performante superioare, distributia pe masini a
modulelor software facandu-se pornind de la criteriile de performanta ale masinilor si nu pe baza caracteristicilor
tehnice ale acestora.

Scalabilitatea sistemului este asigurata de tehnologiile de ultima ora utilizate. Infrastructura de tip n-tier pe care
este construit sistemul permite replicarea componentelor sale pe oricate servere, permitand astfel scalarea
intregului sistem pentru a suporta o incarcare mult mai mare decat cea ceruta initial. Locatia serviciilor poate fi
definita Tn mod liber, functie de specificul fiecarui proiect si de necesarul de hardware pentru asigurarea unei
performante optime.

Fig. Scalabilitatea suitei ELO

Serverul ELO depoziteaza toate documentele in format electronic, iar pentru o cantitate mare de informatii se
poate conecta la sisteme de depozitare de tip HSM, NAS sau SAN sau la depozite modulare de stocare pe termen
lung, precum tonomate sau ECM Centera.

Documentele arhivate pot fi stocate in arhive de tip online, nearline si offline, fiind suportate o mare varietate
de tipuri de medii de stocare, precum: MOD, WORM, RAIDS5, FCAL, SAN, DAS, NAS, HSM.

ELO dispune de o arhitectura orientata pe servicii (SOA). Aceasta inseamna ca toate functionalitatile ELO ruleaza
ca aplicatii individuale in cadrul aplicatiilor server. De exemplu, caracteristica fluxului de lucru ELO este o aplicatie
autonoma care ruleaza independent.
Aceasta are urmatoarele avantaje:
- O actualizare afecteaza doar aplicatia respectiva. Alte functionalitati ale sistemului continua sa
functioneze normal.
- Aplicatiile pot fi gazduite pe servere separate sau masini virtuale pentru o mai buna echilibrare a
sarcinii serviciilor. Acest lucru creste performanta ELO si poate fi util de exemplu daca aveti mai multe
fluxuri de lucru simultane sau interogari de cautare.

Urmatoarea figura prezinta in detaliu arhitectura ELO ECM Suite.
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Fig. Arhitectura n-tier a suitei ELO ECM

2.2 ELO Document Manager

Este componenta care controleaza documentele si metadatele asociate stocate in depozitul ELO. Comunica cu
Access Manager pentru a se asigura de drepturile de acces si cu Indexserver pentru a livra documentele catre
clientii ELO. Fiecare depozit de documente ELO are propriul ELO Document Manager. Acesta este responsabil de
stocarea, gestiunea si livrarea documentelor in functie de cererile primite. De asemenea, serviciul de backup si
interfata pentru EMC Centera sunt rulate de Document Manager, daca aceste componente sunt instalate.

Fiecare Document Manager detine propria sa schema de baza de date care va avea acelasi nume cu cel al
depozitului de documente ELO pe care il gestioneaza.
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Figura 2 Arhivarea documentelor

2.3 ELO Access Manager

Este componenta care se ocupa de securitatea documentelor si informatiilor, verificand daca utilizatorii au
permisiuni pentru accesul la documentele si informatiile din depozitul ELO. De asemenea, se ocupa de
autentificarea utilizatorilor, prin intermediul Indexserver. Clientii ELO fac o cerere de acces, aceasta ajunge la
Indexserver, care trimite cererea la Access Manager pentru verificare. Odata raspunsul primit, acesta este
transmis de Indexserver catre client si autentificarea se realizeaza in conformitate cu schema de securitate
stabilita.

Access Manager este responsabil de administrarea centralizata a utilizatorilor, a utilizatorilor autentificati si de
drepturile de acces si permisiunile acestora. Fiecare client si proces de server se inregistreaza la start in Access
Manager. Acesta ofera un ticket care identifica tipul de client si care este necesar in comunicarea cu procesele
serverului ELO.

Tot ELO Access Manager este responsabil si de managementul licentelor, iar integrarea cu LDAP / Active Directory
intra tot in sarcina acestei componente. Un singur Access Manager poate fi utilizat pentru a rula mai multe
depozite de arhiva ELO, dar in acest caz ele vor partaja utilizatorii si alte setari. Access Manager-ul are propria
schema de baza de date denumita eloam.

Figura 3 Procesul de autentificare

24 ELO iSearch

Modulul ELO iSearch este instalat pe propriul server de aplicatie Tomcat si seteaza baza de date fulltext utilizata
la cautdri. Impreund cu Indexserver, stocheaza informatia continut3 in documente si in arhivele electronice ELO
si impreuna cu baza de date ELO este capabil sa livreze rezultatele cautarilor efectuate de utilizatori, atat cele
aflate n fisiere cat si cele din metadatele asociate acestora. Mai multe informatii despre ELO iSearch se regasesc
n capitolul dedicat cautarii documentelor.
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2.5 ELO Indexserver

Aceasta componenta este de fapt “inima” suitei ELO. Este punctul de contact al serverului oferit clientilor ELO
care realizeaza autentificarea la server prin cereri transmise catre interfata Indexserver. Indexserver este, de
fapt, un serviciu web care expune toate functionalitatile platformei ELO si prin care se realizeaza accesul la
acestea.

Orice numdr de componente Indexserver se pot instala pentru orice numar de depozite de arhiva electronica
ELO. Aplicatiile externe se pot conecta la serviciile puse la dispozitie de Indexserver prin intermediul HTTP/HTTPS
sau SOAP sau printr-o interfata proprietara Indexserver. Suita ELO pune la dispozitie un standard API (Application
Programming Interface) exhaustiv, care permite refolosirea componentelor existente. Sunt suportate limbajele
de programare Java, .NET, JavaScript, C++, PHP, etc, astfel incat integrarea ELO in infastructura software existenta
este posibila si relativ usor de realizat.

Exista posibilitatea de implementare a unui cache de flux de lucru, ceea ce asigura faptul ca listele de sarcini si
activitati, precum si prezentarea fluxului de lucru sunt incarcate mai rapid.

2.6 ELO Automation Services

ELO Automation Services (ELOas) este componenta responsabild de automatizarea anumitor sarcini de lucru din
cadrul unui depozit de documente ELO, prin implementarea de reguli de business. Acesta functioneaza prin
procesarea unui numar de seturi de reguli de business, care sunt, de fapt, instructiuni bazate pe XML pentru un
anumit tip de actiune. Seturile de reguli sunt stocare in directorul de Administrare din depozitul ELO. Orice numar
de instante ELOas pot fi instalate pentru un depozit ELO. Seturile de reguli de business sunt de doua tipuri: seturi
directe si seturi care se ruleaza la un anume interval de timp definit Tn cadrul unei reguli. Acestea din urma nu
necesita interactiune cu utilizatorul final.

ELO Automation Services ofera, in mod predefinit, la instalare o serie de librarii care pot fi utilizate in crearea de
reguli de business.

2.7 ELO Forms Services / ELO Web Forms (ELOwf)

ELO Forms Services (ELOwf) este componenta de server care se ocupa de managementul componentelor de
formulare electronice aferente fluxurilor de lucru, de managementul fluxurilor de informatii aferente
documentelor si de componentele aplicatiilor ELO (ELO Apps). Aceasta componenta e necesar a fi instalata pe
aceesi instanta de server cu ELO Automation Services deoarece sunt multe cereri care sunt transmise de la ELOwf
la ELOas, cum ar fi regulile directe.

ELO Apps sunt afisate ca un website static.
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3 Clientii ELO

Utilizatorul acceseaza depozitul de documente ELO prin intermediul unui client ELO si beneficiaza astfel de
intregul domeniu functional al suitei. Clientii ELO comunica si schimba informatii cu serverul, iar serverul executa
comenzile primite de la utilizatorul sistemului prin intermediul clientului. Functie de rolul utilizatorului din
companie, se poate alege tipul de client ELO care se muleaza pe nevoile acestuia — aceasta este strategia multi-
client a ELO Digital Office.

Un mare avantaj al clientilor ELO este reprezentat de imensa varietate functionald a produsului software,
conectat la o interfata intuitiva si usor de utilizat. Datorita arhivei electronice simplu de structurat, ELO faciliteaza
administrarea optima a proceselor si a documentatiei aferente activitatii zilnice. Gestionarea automatizata a
versiunilor, fluxurile de lucru, instiintarile si copiile logice automate asigura manevrarea eficienta in procesarea
documentelor. Astfel, toate aplicatiile Office, precum si cele de fax si e-mail, pot fi conectate fara probleme la
ELO. Legatura catre Microsoft Outlook si Microsoft Exchange precum si integrarea in suitele Microsoft Office si
OpenOffice, sunt incluse ca dotari standard in ELO.
Suita ELO ofera suport multi-limba, fiind disponibila in peste 25 de limbi, utilizatorii avand posibilitatea la
autentificare sa aleaga limba preferata.
Depinzand de drepturile de acces pe care le au utilizatorii, clientii ELO le pun la dispozitie o serie de functionalitati
care le permite un management eficient al documentelor. Din multitudinea de optiuni existente amintim pe cele
mai importante:

e Addugarea de documente si elemente de structura a arhivei electronice

e Arhivarea documentelor

e Tiparirea documentelor

e Creare de documente pe baza de sabloane

e Transmiterea documentelor prin fax/email

e Transferul de documente intre utilizatori

e Generarea de legaturi si transmiterea lor in extern pentru acces securizat la anumite documente

e Stabilire drepturi de acces

e Vizualizare documente si unelte pentru imbunatatirea vizualizarii (rotire, zoom, etc)

e Salvarea setarilor de zoom in previzualizarea documentului in clientul de Java

e  Check-in si check-out documente

e inghetare documente

e Transmiterea de mesaje intre utilizatori

e Transmiterea de sarcini de lucru

e  Mutarea documentelor in depozitul de arhiva si crearea de legaturi si referinte

e Transformarea fitierelor in formatele TIFF si PDF

e Scanarea documentelor

e Adnotarea documentelor (notite, marcare, stampile, etc)

e  Addugarea de atasamente documentelor

e Versionarea documentelor (controlul versiunilor)

e Compararea versiunilor

e Addugarea de metadate pentru orice tip de document si indexarea documentelor

e Pornirea fluxurilor de lucru predefinite sau ad-hoc

e Importul si exportul de documente, arhive si sectiuni de arhive

e  Elaborarea si vizualizarea rapoartelor

e  Restaurarea documentelor sterse

e Recunoasterea optica a caracterelor

e  (Criptarea si decriptarea documentelor
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e Operatiunea de criptare/decriptare este realizata server-side
e (Cdutarea si regasirea documentelor

e Recunoasterea codurilor de bare

e Semnarea electronicd a documentelor

e Accesul la help contextual si help general pentru utilizare

e Configurarea modului de afisare si incarcare a clientului

3.1 ELO Java Client

Clientul ELO Java este clientul desktop al suitei si este necesar a fi instalat pe toate statiile de lucru care utilizeaza
aceasta modalitate de conectare la serverul ELO.

Clientul ELO Java este cel mai complet client ELO, fiind disponibile toate functionalitatile puse la dispozitie
utilizatorilor standard, dar ofera si functionalitati necesare administratorilor, cum ar fi designer-ul de fluxuri de
lucru.

3.1.1 Functionalitati de baza ale clientului

Clientul ELO Java este utilizat pentru accesarea depozitului de arhiva ELO. Acest client va permite sa gestionati,
cautati si sa regasiti documente si informatii. In plus, puteti utiliza acest client pentru a defini fluxuri de lucru,
remindere sau pentru a afisa documente si pentru a posta comentarii.

Clientul ELO Java poate fi utilizat pe sistemul de operare Microsoft Windows, precum si pe alte sisteme de
operare, cu conditia ca un mediu Java corespunzator sa fie disponibil pentru operarea sistemului.

3.1.1.1  Autentificare client

Autentificarea in sistem se realizeaza printr-un dublu click pe iconita clientului. Se deschide o fereastra care
permite introducerea username-ului si a parolei dedicate, precum si selectia arhivei la care sa se realizeze
autentificarea si a limbii de incarcare a interfetei.

In situatia existentei unei erori in momentul autentificarii sau cand sistemul este in modul de administrare,
clientul Java nu se va deschide iar mesajele de eroare vor fi afisate cu galben (pentru mesaje cu privire la parola
eronata de exemplu) sau cu rosu (pentru cazul erorilor externe precum conexiunea la server).
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3.1.1.2 Interfata utilizator
Clientul ELO Java se deschide in zona de lucru MyELO.

In zona din partea stanga sunt afisate tile-urile - butoanele pentru acces rapid al diverselor zone din aplicatie, iar
in zona centrala sunt noutatile din sistem, filtrate pe zi, saptamana sau luna, in functie de autorul postarii,
formularul de indexare folosit sau tipul de postare. Aici apar mesajele din aplicatie sau se pot accesa documentele
utilizate recent.
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Sunt disponibile o serie de meniuri care sustin utilizatorii in activitate, meniuri care sunt similare cu cele din suita
Office, din Word si Excel.

Meniul din partea superioara a ecranului:

Fiecare buton al meniului detine o serie de functionalitati diverse. Butoanele au iconite intuitive, iar la plasarea
mouse-ului deasupra acestora — se afiseaza o scurta descriere a activitatii pe care o poate intreprinde acel buton.

Al doilea meniu, cel din partea inferioara a ecranului, face legatura cu diferite zone ale sistemului:

e  Primul buton conduce in permanenta utilizatorul la pagina de start — My ELO

e Se afiseaza apoi zona de Arhiva unde sunt structurate toate documentele si folderele
e Zona de Cautare — ce ne permite realizarea diferitelor tipuri de cautare

e Zona de Activitati — unde utilizatorii primesc taskurile pe care trebuie sa le desfasoare
e Zona de Intray — unde este permisa scanarea documentelor direct in sistem
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3.1.1.3  Configurare tile-uri

Butoanele pentru acces rapid al diverselor zone din aplicatie pot fi personalizate, pot fi adaugate butoane noi
sau pot fi ascunse din cele existente. Printre setarile ce pot fi configurate pentru fiecare tile in parte se regasesc:
numele, culoarea, pictograma, dimensiunea, optiuni precum fixarea pe bara de navigare, afisarea numarului de
intrari sau vizualizarea unei scheme circulare pe cadrul careia este descris procentul de intrari cu o anumita
culoare (aceasta optiune poate fi utilizata, de exemplu, pentru vizualizarea procentului de activitati extinse).

Tile-urile afisate pot fi grupate in categorii, precum arhiva, activitati, altul, precum se vede in imaginea
urmatoare.

3.1.1.4 Customizarea meniului ribbon si a interfetei

Meniul de tip ribbon (pozitionat in zona superioara a ecranului) ofera acces la diferite functii ELO. Ribbon-ul este
organizat in file care grupeaza functiile cu referire la un subiect relativ comun. Prin intermediul acestor file se
realizeaza comutarea intre meniuri. Pentru a fi usor de utilizat, anumite file se afiseaza doar in situatia apelarii
unei anumite zone de lucru — exemplu: fila Fisier este afisata doar cand utilizatorul se gaseste in zona de lucru
Intray.

Optiune de pin/unpin functii

In timp ce unele functii sunt vizibile in meniul ribbon, altele sunt disponibile in meniurile derulante. Utilizatorul
are posibilitatea de a anula fixarea functiilor dintr-un meniu derulant si fixarea acestora in meniul ribbon.
Optiunea se acceseaza prin click dreapta asupra meniului.
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Zona de configurare

Clientul detine o zona dedicata pentru configurarea accesului la functii, zona care se acceseaza din meniul ELO,
butonul Configurare.

Apasarea acestui buton deschide o fereastra de configurare cu multiple optiuni. Administratorul de sistem sau
utilizatorul cu drepturi de administrare are posibilitatea de a selecta din aceasta fereastra utilizatorul sau grupul
de utilizatori pentru care sa realizeze modificari de profil din punct de vedere al afisarii functiilor in meniul ribbon.

Clientul ELO Java prin care se acceseaza sistemul poate fi configurat si personalizat pentru fiecare utilizator sau
grup de utilizatori in parte, astfel incat experienta de folosire sa fie cat mai placuta.

Categoriile care pot fi configurate sunt cele referitoare la:

- Afisare: unde se pot stabili detalii precum durata mesajului de feedback in secunde, optiuni de aspect
pentru afisare numai arbore sau arbore si tabel, fontul utilizat, optiuni de cautare precum durata de
stocare a intrarilor de cautare in iSearch (stergere imediata, stergere la inchiderea ELO sau nu se sterge
niciodata), numar de sinonime afisate, numar maxim de rezultate per pagina, numar de sugestii de
cautare pentru fiecare camp, numarul coloanelor de indexare si rezultatele cautarii, se pot configura
optiunile de afisare lista cu setarea intervalului de reimprospatare a listei in minute, sau afisarea
activitatilor de efectuat intr-un numar de zile in viitor, etc
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Schema de culoare: permite selectarea schemei de culoare care sa se aplice clientului. Schema de
culoare poate fi afisata pe un fundal deschis/inchis la culoare, cu contrast puternic, etc.

Casetele de dialog: in aceasta zona se pot seta detaliile generale cu privire la modul in care se afiseaza
casetele de dialog, ordinea butoanelor, comentariile pentru versiune, notificarile (ex. Afisarea unui
mesaj la amanarea unui flux de lucru, daca a fost setata perioada de pastrare, la stergerea fisierelor din
Intray sau la suprascrierea meadatelor existente prin indosariere in serie.
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3.1.1.5 Modalitati de vizualizare ale rezultatelor cautarii

Solutia ELO ofertata permite modalitati de vizualizare diferite a cautarilor: vizualizate sub forma de lista, tabel
cu mai multe coloane, arbore sau cadre (thumbnails - miniaturi).

Ecranul de cautare ELO iSearch permite afisarea documentelor in structura de foldere. In partea dreapta a
ecranului, in partea de examinare (preview) se afiseaza documentul si structura din care face parte.

Modalitati vizualizare rezultate cautare:
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Vizualizare serii de imagine in forma miniaturi (Thumbnail) cu previzualizare:

3.1.1.6  Export in format tiff sau pdf

Documentele redactate pot fi convertite in versiuni needitabile: imagine, pdf sau sau alte formate criptate si
securizate de fisier care sa ofere minim permisiuni de imprimare restrictionate, protectie prin parola sau
expirarea fisierului. Acest lucru se realizeaza utilizand functiile Conversie PDF si Conversie TIFF.

3.1.1.7 Generare documente

Generarea automata a unui document in sistem se realizeaza avand la baza un sablon preconfigurat si o serie de
metadate deja existente in aplicatie. Este permisa alegerea tipului de document ce urmeaza a fi generat, este
permisa inclusiv includerea unui QR code care, la citirea cu un dispozitiv mobil pe care a fost instalat clientul ELO
pentru dispozitive mobile, sa poata conduce utilizatorul catre documentul din arhiva:
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Template-ul de document este completat cu datele din sistem. Pentru acestea exista inclusiv optiunea de semnare
electronica.

3.1.1.8 Notificari in sistem

ELO ECM Suite permite integrarea cu un server de email pentru a facilita transmiterii notificarilor pe email.

Functia de notificare permite transmiterea notificarilor zilnice prin email cu noutati din ELO, inclusiv un sumar al
activitatilor curente si feedul ELO. Utilizatorii pot configura ce noutati vor sa primeasca.
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E-mail notifications X

+1 Enable e-mail notifications

E-mail notification settings

Show news from My ELO

Language for notifications en =

Workflow notifications

Including group tasks

Includina subsfitution tasks

OK Cancel

Solutia standard cuprinde un template de email care se adapteaza tipului de dispozitiv utilizat. Asta inseamna ca

utilizatorii de smartphone vizualizeaza un display adaptat.

Sunt disponibile o serie de optiuni de configurare. In cazul in care sunt activate notificarile pe email, utilizatorul
va primi emailuri zilnice cu postari din ELO feed sau sarcini de lucru. In cazul in care nu sunt noutati disponibile,
nu se va transmite nicio notificare.

Solutia ELO ofertata permite notificarea prin e-mail referitor la aparitia unui eveniment pe flux si va conduce
utilizatorul automat in pagina unde acesta poate interveni.

Emailul de notificare prezinta si un link catre fluxul din aplicatie, care va conduce utilizatorul spre activitatea
respectiva sau catre documentul insotitor, in functie de configurarile realizate.

Notificarile pe email pot fi configurate astfel incat sa se transmita emailuri la frecventa dorita cu privire la statusul
fluxului in fiecare nod, la finalizarea acestuia sau la initierea oricarei activitati/eveniment din cadrul fluxului.

3.1.1.9 ELO Mobile Connector

Solutia dispune de mecanisme de sincronizare a datelor continute intr-un dosar al arhivei electronice cu un
sistem extern de fisiere de date (file-system).
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Instrumentul nativ inclus este reprezentata de Mobile Connector care permite sincronizarea simpla a activitatii
si datelor cu arhiva centrala in mod offline, pentru situatiile in care utilizatorul nu se afla la birou. Sincronizarea
se realizeaza intre un dosar/structura de foldere din arhiva cu un sistem de fisiere extern/dispozitiv

mobil/calculator local.
- Ofera posibilitatea utilizarii documentelor offline

- Sincronizare automata cu datele din depozitul de arhiva
- Ofera posibilitatea de a aplica automat modificari

In prima instanta se configureaza folderul pentru sincronizare cu optiunea Add folder.

Aceasta deschide o fereastra care permite configurarea optiunilor de sincronizare, cu selectarea folderului tinta
din file system.
Aceasta deschide o fereastra care permite configurarea optiunilor. Pot fi stabiliti parametri de export de tipul:

- Sincronizare, cu metadate

- Sincronizare, fara metadate

- Salvare ca si copie, fara metadate

- se exporta automat cand porneste ELO

- se exporta si referintele

Stabilirea folderelor pentru sincronizarea informatiei prin intermediul Mobile Connector:
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Exportul structurii de directoare este initiat prin apelarea optiunii Deschideti Mobile Connector:

Fereastra de initiere a exportului:

Configurarea Mobile Connector permite vizualizarea si utilizarea documentelor offline sau prin intermediul unui
browser web, astfel:

3.2 ELO Web Client

Clientul ELO Web este clientul care permite accesarea depozitului de arhiva electronicad ELO prin intermediul unui
browser web, fara a fi necesara instalarea pe statia de lucru. Clientul ELO Web este o aplicatie HTML5, de aceea
are nevoie de un browser modern care sa fie compatibil cu ultimele standarde HTMLS5, CSS si JavaScript.

Pagina 25 din 337



Accesarea clientului web ELO se realizeaza prin introducerea adresei web specifice in bara de adrese a browser-
ului web, de exemplu: http(s)://<host>:<port>/web-<repositoryname>/.

Functia the single sign-on (SSO) ruleaza automat via Indexserver.

Din punct de vedere al interfetei utilizator, aceasta este foarte asemanatoare cu cea de la clientul ELO Java. Chiar
daca ofera mai putine functionalitati decat acesta, este disponibild o paleta larga de functionalitati care ajuta
utilizatorul sa lucreze la fel de eficient cu documentele si informatiile.

3.2.1 Autentificare

Prima pagina este cea de autentificare utilizator, unde se introduc numele utilizatorului si parola, precum si limba
n care se va incarca interfata:

3.2.2 Exemple de variante de browsere ce permit accesarea si utilizarea clientului ELO

Clientul web ELO — accesat din Browser Google Chrome

Clientul web ELO — accesat din Browser Microsoft Edge
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Clientul web ELO — accesat din Browser Internet Explorer

Clientul web ELO — accesat din Browser Mozilla

3.2.3 Interfata ELO Web Client

O imagine sugestiva a interfetei utilizator a clientului web ELO si o evidentiere a elementelor principale care
formeaza aceasta interfata se poate observa in imaginea de mai jos:
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1. My ELO button - deschide zona de lucru My ELO, pagina de start a depozitului de arhiva ELO.

Pentru a se deschide ecranul de start My ELO, se pot utiliza si tastele CTRL + WINDOWS.

Dacd My ELO Button este evidentiat in verde, inseamna ca utilizatorul are noutati in My ELO:
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2. Ribbon (Meniu) - se poate vizualiza atunci cand utilizatorul se afla intr-o zona de lucru si ofera acces la
aproape toate functionalitatile ELO. Unele functii pot fi accesate din meniul contextual prin utilizarea click
dreapta pe o intrare din ELO. Meniul este organizat in tab-uri standard care sunt intotdeauna afisate si in tab-uri
contextuale, care apar cand functionalitatile tab-ului sunt utilizate.

Tab-uri standard:

e  Favorites (Preferinte)
e New (Nou)

e View (Vizualizare)

e  Output (lesire)

e Organize (Organizare)

e  Task (Activitate)

Tab-uri contextuale:

e Document — apare cand este selectat un document

e Search (Cautare) — apare cand utilizatorul apasa click in zona de lucru Search (Cautare)
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e Clipboard — apare cand se realizeaza copieri, referinte sau mutari ale intrarilor

Tn meniu apar functionalitatile cele mai importante, iar altele pot fi gasite in meniuri de tip drop-down. Alte
functionalitati care apar in meniu sunt inactive, de culoare gri, care nu pot fi utilizate in pozitia curenta din ELO,
dar pot fi utilizate n alte zone.

Optiunea Search functions (Cautare functii) este un camp distinct ce permite cautarea functiilor in acest meniu.

Rezultatele obtinute sunt doar acele functionalitati disponibile Tnh contextul specific.
Printr-un click pe functia gasita se permite accesul direct la respectiva functie.

3. Navigation Bar (Bara de navigare) — ofera acces rapid la cateva zone din depozitul de arhiva ELO si specifica
zona de lucru in care se afla utilizatorul in momentul respectiv.

Pot fi fixate cadrane (tile-uri) in bara de navigare prin click dreapta pe cadran (tile) si selectarea optiunii: Pin to
the navigation bar (Fixare pe bara de navigare).
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4. User Menu - prin click pe acest meniu se deschide un alt meniu de tip drop-down care permite configurari
pentru contul utilizatorului. Tot din acest meniu, utilizatorul poate utiliza functia Log off (Deconectare) pentru a
se deloga din ELO.
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5. Profile — prin click pe zona unde este fotografia, utilizatorul isi poate accesa profilul ca sa insereze informatii
despre el (date de contact, functie, departament etc.) si poate incarca fotografia sa.

6. News/Most Recently used — aceastd zona este impartita in tab-ul News si tab-ul Recently Used.

Tab-ul News ajuta utilizatorul sa fie la curent cu modificarile, noutatile din ELO printr-un feed de postari ce sunt
afisate automat in tab-ul News. Se aplica feedurilor pentru care utilizatorul s-a abonat sau in care a fost
mentionat de catre un alt utilizator. Hashtagurile urmarite, fluxurile de lucru escaladate sau initiate recent sunt
alte informatii ce sunt afisate in aceasta zona.

Pentru mai multe informatii, consultati capitolele My ELO si ELO Feed.

7. Tile navigation — aceastd zona ajuta pentru navigarea rapida in sistem. Cadranele (tile-urile) pot fi utilizate
pentru a accesa zone de lucru, vizualizari, cautari favorite etc.
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Urmatoarele tile-uri sunt standard, afisate by default:

e Repository (numele depozitului de arhiva) — zona de lucru pentru Arhiva
e Search (Cautare)

e  Tasks (Activitati)

e Inuse (in lucru)

e Clipboard

Cadranele sunt organizate in grupuri. Zona Tile navigation se poate personaliza in functie de nevoile utilizatorului.
Pentru mai multe informatii, consultati capitolul Personalizarea ELO Web Client.

3.2.4 Prezentare zone de lucru din interfata ELO Web Client

Interfata clientului ELO contine mai multe zone de lucru. Utilizatorii pot trece de la o zona de lucru la alta, sa
navigheze printre zonele de lucru utilizand urmatoarele optiuni:

e My ELO —click pe My ELO pentru a ajunge la zona de lucru dorita utilizind tile-urile disponibile. Aceasta
optiune este intotdeauna disponibila.
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e Bara de navigare — click pe zona de lucru dorita direct in bara de navigare. Aceasta optiune este
disponibild doar daca zona de lucru este fixata pe bara de navigare asa cum se descrie in capitolul
Personalizare ELO Web Client.

3.24.1 MyELO

My ELO - este pagina de start a clientului care functioneaza ca un tablou de bord al utilizatorului. De aici se pot
accesa restul zonelor de lucru prin utilizarea tile-urilor disponibile in partea stanga a ecranului. Fluxurile de
informatii aferente documentelor si inregistrarilor din depozitul ELO sunt afisate in zona din partea dreapta. Sunt
afisate fluxuri de informatii la care utilizatorul s-a abonat sau cele in care a fost mentionat. Fluxurile pornite
recent sau cele care au fost escaladate si care sunt relevante pentru utilizator sunt si acestea afisate in zona de
lucru My ELO.

Postarile din My ELO sunt afisate in ordine cronologica (cele mai noi sunt primele). Acestea sunt grupate si afisate
pe baza optiunilor de filtrare, dupa data, formular de indexare, tip, hashtag, etc. Utilizatorii au posibilitatea sa
marcheze anumite documente si informatii ca fiind importante, pot renunta la subscriere sau pot sterge din
MyELO informatiile si documentele care nu mai sunt relevante pentru ei.

Mai mult, se pot vizualiza fluxurile care au fost escaladate, adica cele pentru care s-au depasit termenele limita.

Cu un click pe fluxul de lucru respectiv, se deschide sarcina de lucru impreuna cu actiunile pe care utilizatorul
trebuie sa le realizeze, cum ar fi o aprobare sau o distributie.

News

Prin Tab-ul News (Stiri) utilizatorul este la curent cu modificarile, noutatile din ELO printr-un feed de postari ce
sunt afisate automat in tab-ul News. Se aplica feedurilor pentru care utilizatorul s-a abonat sau in care a fost
mentionat de catre un alt utilizator. Hashtagurile urmarite, fluxurile de lucru escaladate sau initiate recent sunt
alte informatii ce sunt afisate in aceasta zona. Este disponibil inclusiv un hashtag cloud cu ultimele hashtaguri
utilizate in sistem.

Majoritatea functiilor din zona de lucru My ELO sunt functii pentru feed. Pentru mai multe informatii, consultati
capitolul ELO Feed.
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Most recently used

Tab-ul Most Recently used (Utilizate recent) contine o lista de documente pe care utilizatorul le-a
vizualizat/editat recent. Utilizatorul poate fixa in lista intrari pe care le utilizeaza in mod frecvent prin click pe

pictograma pentru fixare intrare (Pin entry).

Pentru configurarea tab-ului Utilizate recent se apasa click pe User menu [your name] > Configuration > Display
> List of recently used entries (Meniu utilizator > Configurare > Afisare > Listd de intrdri utilizate recent).
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Settings

Se pot realiza diverse setari (settings) pentru feed accesand butonul din partea dreapta a zonei dedicate fluxurilor
de informatii (feed).
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Se va deschide fereastra Settings (Setari) care cuprinde zonele:

e My ELO settings (Setdri ELO personal)
e My subscribed hashtags (Hashtagurile mele la care sunt abonat(d))

e My polls (Sondaje personale)
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Show current hashtags

Butonul Show current hashtags apare in cazul in care ecranul My ELO nu este suficient de incapator pentru a
afisa informatii cu privire la hashtag-uri. Utilizatorul poate apasa click pe acest buton pentru afisarea acestor
informatii.

Hashtag cloud

intr-un hashtag cloud sunt afisate Hashtag-uri care au fost utilizate in siptimanile recente. Dacd utilizatorul
apasa click pe un hashtag, va putea vedea toate elementele de feed care contin acel hashtag, cu conditia sa aiba
permisiunea sau dreptul de a vizualiza acele elemente de feed.
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Show workflows

Butonul Show workflows (Afisare fluxuri de lucru) apare in cazul in care ecranul My ELO nu este suficient de
incdpator pentru a afisa informatii cu privire la fluxuri de lucru. Utilizatorul poate apasa click pe acest buton
pentru afisarea acestor informatii deasupra feed-ului la care s-a abonat.

Escalated workflows

n zona Escalated workflows (Fluxuri de lucru escaladate) se pot vizualiza fluxurile de lucru in care este implicat
utilizatorul. Daca se apasa click pe numele fluxului, se deschide automat zona de lucru Activitati care afiseaza
respectivul flux de lucru.
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Recently started workflows

in zona de lucru Recently started workflows (Fluxurile de lucru personale incepute recent) se pot vizualiza
fluxurile de lucru incepute de curdnd de catre utilizator. Daca se apasa click pe numele fluxului, utilizatorul este
redirectionat automat in arhiva, catre intrarea (document sau folder) pentru care utilizatorul a deschis
respectivul flux de lucru.
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Show filter options

Butonul Show filter options (Afiseaza optiuni filtrare) apare in cazul in care ecranul My ELO nu este suficient de
incdpator pentru a afisa filtrele.

Utilizatorul poate apasa click pe acest buton pentru afisarea filtrelor, iar pentru ascunderea lor, poate apasa pe
butonul Hide filter options.

Filtre in My ELO

n zona My ELO sunt disponibile categorii variate de filtre, majoritatea fiind intuitive.
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Optiunea Post type (Tip postare) permite filtrarea zonei My ELO dupa tipul postarii. Sunt disponibie doua tipuri
de baza pentru postari:

e Postdri create automat (de exemplu o noua versiune de lucru)

e Postdri create de utilizatori (de exemplu postari ale utilizatorilor).

Activare si negare filtre

Pentru a se aplica un filtru, se apasa click (se bifeaza) pe filtrul corespunzator din lista.
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Setarea standard pentru toate filtrele este ca acestea sa fie afisate in modul is (este). Pentru a se seta filtrul in
modaul is not (nu este), se apasa click pe numele categoriei filtrului si is se va transforma automat in is not.

Resetare filtru

Pentru a se sterge/reseta toate filtrele, se apasa click pe butonul Reset filters (Resetare filtre).
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Butonul Mark as important

Butonul Mark as important (Marcare ca important), reprezentat de pictograma care afiseaza un steag, permite
fixarea unei postari in zona My ELO. Postarea ramane vizibila in zona My ELO chiar daca este mai veche de o
luna.

Se pot recunoaste postarile importante pe baza pictogramei care afiseaza un steag rosu.
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Anularea marcarii Mark as important

Se poate anula marcatorul addugat la o postare apdsand click pe butonul reprezentat de pictograma care afiseaza
un steag rosu. De indata ce postarea va fi mai veche de o luna, nu va fi mai fi afisata in zona de lucru My ELO.

Ascundere postare

Se poate ascunde o postare in zona de lucru My ELO apdsand click pe butonul Remove from My ELO (Eliminare
din ELO personal).

Functia Remove from My ELO ascunde doar postarile in zona My ELO, fara sa fie sterse intrarile.
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Butonul Undo (Anulare)
Dupa ce s-a ascuns o postare, se poate reveni la anularea ascunderii ei apasand click pe butonul Undo (Anulare).
Butonul Undo dispare in mod implicit dupa cinci secunde.

Se poate modifica timpul de afisare al mesajului de anulare al ascunderii postarii din My ELO > Settings > My ELO
settings (My ELO > Setdri > Setdri ELO personal), prin optiunea Number of seconds to display the "Undo" button
before it disappears (Numdrul de secunde de afisare a butonului ,,Anulare” inainte ca acesta sd dispard).
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Se va deschide fereastra dedicata setarilor My ELO in care se poate insera numarul de secunde de afisare a
butonului Undo inainte ca acesta sa dispara.

3.24.2 Arhiva
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Arhiva - aceasta este zona principald de lucru pentru utilizator. Veti gasi toate folderele si documentele create in
ELO Tn zona de lucru Arhiva.

incarcarea, editarea si managementul documentelor se realizeaza din aceasta zond. Se pot efectua actiuni de
adaugare documente si directoare sau foldere noi, vizualizare documente sau editarea acestora si a metadatelor
aferente, precum si multe alte optiuni de lucru cu documentele.

Aceasta zona de lucru este impartita in doua zone:

1. Structura arborescenta a arhivei: prezentare generala a intrarilor (foldere sau documente)

2. Panoul de vizualizare: afisarea intrarilor selectate in structura arborescenta

Structura arborescenta prezinta folderele si documentele din arhiva si este situata in partea stanga a ecranului.

Sunt disponibile urmatoarele optiuni de navigare in cadrul arhivei:

v" Prin intermediul mouse-ului

v" Prin intermediul tastaturii

Navigare prin intermediul mouse-ului: se apasa click pe o intrare folosind mouse-ul. Prin click pe un folder se
poate vizualiza continutul respectivului folder in panoul de vizualizare.
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Prin click pe sdgeata de langa folder, se poate vizualiza structura arborescenta a folderului respectiv.
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Navigare prin intermediul tastaturii: se poate naviga 1n sus si in jos in structura arborescenta folosind tastele cu
sageti indreptate Tn sus si in jos.

Apdsand tasta cu sageata indreptata in dreapta se va putea deschide un folder. Apasand tasta cu sageata
indreptata in stanga se va putea inchide folderul.

Intrarile (foldere sau documente) care au o pictograma care contine o sageata reprezinta referinte.

Se poate ajunge la intrarea initiala prin selectarea intrarii si apoi apasand click in meniu pe View > Go to
(Vizualizare > Salt Ila).

Se mai poate ajunge la intrarea initiala prin selectarea intrarii si apasand click dreapta pentru deschiderea
meniului contextual, iar apoi prin click pe Go to (Salt la).
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Documentul care afiseaza o sdgeatd galbena langd pictograma documentului si numele utilizatorului intre
paranteze, este documentul procesat prin check-out de respectivul utilizator. Documentul poate fi vizualizat,
dar nu poate fi editat de alti utilizatori.
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Panoul de vizualizare afiseaza continutul folderelor sau preview-ul documentelor selectate in structura
arborescenta.

Preview documente:

Continut foldere:

Utilizatorii au libertatea de a selecta elemente de previzualizare din bara de instrumente dedicata pentru a se
potrivi propriilor cerinte si nevoi de utilizare. Astfel, pentru fiecare folder/document exista 3 optiuni pentru
vizualizarea informatiilor:
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Contents Metadata

(Cuprins) WIEELEE)

Utilizatorul poate schimba optiunile de vizualizare prin butonul Configure preview (Configurare preview) si apoi
prin click in cdmpurile Feed, Contents sau Metadata.

Tn exemplul de mai jos, utilizatorul a setat afisarea tuturor optiunilor, in urmatoarea ordine: Contents, Metadata
si apoi Feed.

Setarile realizate pentru o intrare sunt salvate automat. Aceste setari nu se aplica si altor intrari.

Panou vizualizare care contine Contents, Metadata si Feed:

Prin click pe butonul X, se inchide panoul de vizualizare si se extinde structura arborescenta a arhivei.
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Panoul de vizualizare va aparea din nou imediat dupa ce utilizatorul selecteaza o intrare din structura
arborescenta a arhivei.

Tn urma apésarii pe butonul X, se poate vizualiza in imaginea urmatoare ci panoul de vizualizare este inchis si a
fost extinsd structura arborescenta a arhivei.
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1 Contents (Cuprins)

Folder: Daca s-a selectat un folder, se vor putea vizualiza folderele secundare si documentele din cadrul acestuia.

Utilizatorii au urmatoarele optiuni:

(1) Pot cduta in folder in campul Search this folder (Cdutare in acest folder)

(2) Pot modifica sortarea documentelor si folderelor secundare aflate in respectivul folder.

Sunt disponibile pentru sortare urmatoarele optiuni:

(o}

o
o
(0]

Manual (Manual)

Alphabetical (Alfabetic)

Alphabetical descending (Invers alfabetic)
Filing date (Datd indosariere)
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0 Filing date descending (Datd indosariere descrescdtoare)
0 Document date (Datd document)
0 Document date descending (Dupd data documentului, descendent).

¢ Pot apasa tasta CTRL sau SHIFT si click pe intrari pentru a selecta intrari multiple. Acest lucru nu este posibil in

structura arborescenta a arhivei
¢ Dacd este nevoie de mai multe informatii despre intrarile individuale, pot modifica modul de vizualizare prin

click in meniu pe View > Table (Vizualizare > Tabel).

Document: Daca a fost selectat un document, acesta va fi afisat daca este posibil. Daca documentul nu poate fi

afisat, acesta poate fi:
v salvat local prin click in meniu pe Output > Save as (lesire > Salvati ca).
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v deschis in modul doar citire prin click in Meniu pe Document > Open in read-only mode (Document >
Deschidere in modul doar citire).

supus unei setari privind modul lui de vizualizare. Sunt disponibile urmatoarele optiuni pentru afisarea

continutului unui document:

¢ Original document: automat daca nu este selectata nicio alta optiune.

¢ Image preview (Examinare imagine): Disponibil in Meniu prin click pe View > Image preview
(Vizualizare > Examinare imagine)

¢ Full text (Text complet): disponibil in Meniu prin click pe View > Full text (Vizualizare > Text complet)
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Pentru mai multe informatii, consultati capitolul Afisarea textului si previzualizarea imaginilor.

2 Metadata/Form
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Metadatele pentru o intrare sunt afisate in panoul de vizualizare prin click pe Metadata (Metadate). Daca se
apasa click pe butonul Edit (Editare) din partea de jos a formularului, se vor putea edita metadatele chiar in
panoul de vizualizare.

Daca s-a selectat o intrare cu un formular, formularul este afisat si se va putea deschide. Se vor putea edita
metadatele prin click in Meniu pe Organize > Metadata (Organizare > Metadate).

3 Feed
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Tn zona Feed se vor gisi informatii generate automat pentru intrarea respectivi si se poate discuta despre intrare
cu alti utilizatori. Dupa ce utilizatorii se aboneaza la un feed pentru o intrare, orice postari noi din feed sunt
afisate pe ecranul de pornire My ELO. Daca sunt etichetati utilizatorii cu @, postarea va aparea si in feedul lor
din ecranul de start My ELO, chiar daca nu s-au abonat la feed. Pentru mai multe informatii, consultati capitolul
Feed.

Elemente aditionale

Sunt disponibile urmatoarele elemente aditionale in cadrul zonei de lucru Arhiva:
e  Margin notes (Note de margine)

e  Link-uri (Legaturi)

e Atasamente
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Margin notes (note de margine)
Pictograma pentru notele de margine pentru o intrare se poate vizualiza pe bara din panoul de vizualizare. Nota
de margine se deschide prin click pe pictograma ei.
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Link-uri (legaturi)
Pictograma reprezentand un lant reprezinta o legatura. Prin click pe pictograma se deschide o prezentare
generala a link-urilor (legaturilor). De asemenea, se pot crea suplimentar noi link-uri.

Atasamente

Pictograma reprezentand o agrafa reprezintd un atasament adaugat la documentul selectat. Prin click pe
pictograma se va deschide atasamentul.
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3.2.4.3 Cautare

Cautare - reprezinta zona de lucru din care se pot efectua cautdriin Arhiva si se pot vizualiza rezultatele acestora.

ELO iSearch are disponibile filtre variate pentru cautare.

Utilizatorul poate accesa si folosi mai multe functii prin click pe sageata din dreptul fiecarei functii afisate in tab-
ul Search (Cdutare). Astfel, se va extinde un meniu din care se pot selecta alte functii utile pentru cdutarea in
Arhiva.
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3.2.4.4  Activitati

Activitati — reprezintd zona de lucru in care utilizatorul primeste sarcinile de lucru si notificarile referitoare la
acestea. De asemenea, aici poate avea o imagine de ansamblu referitoare la fluxurile de lucru. Utilizatorii pot
porni un flux de lucru, pot edita sau organiza fluxurile de lucru in care sunt implicati, pot stabili inlocuitori in cazul
n care nu sunt disponibili sau pot amana sarcinile de lucru.

Sunt disponiibile urmatoarele tipuri de activitati pe care utilizatorul le poate recunoaste pe baza pictogramei
afisate in dreptul activitatii.

Bl Fluxuride lucru [l  Remindere Bl Monitorizare

Noile intrari in zona de lucru Activitati sunt marcate cu o bulind verde pozitionata imediat langa denumirea
activitatii.

Pentru a vizualiza mai multe detalii cu privire la o activitate, utilizatorul poate schimba modul de vizualizare in
cel sub forma de tabel prin click in Meniu pe View > Table (Vizualizare > Tabel). Daca butonul Table (Tabel) este
activat, intrdrile sunt afisate sub forma de tabel.

Pagina 65 din 337



Daca se doreste revenirea la modul de vizualizare sub forma de lista, se apasa din nou pe butonul Table (Tabel)
si automat se revine la acest mod de vizualizare.

Vizualizarea activitatilor sub forma de tabel contine informatii cu privire la: Prioritate, Tip activitate, Pas, Tip,
Nume, Utilizator, Data scandenta, Data activitatii, Nota, Data amanare. Activitatile pot fi ordonate, sortate de
utilizator in functie de aceste detalii mentionate anterior.
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Utilizatorul are posibilitatea de a vizualiza detalii privind activitatea prin click pe aceasta, afisandu-se astfel
continutul activitatii in partea din mijloc a ecranului, iar in partea dreapta este afisata zona de Feed. Pentru
renuntarea la acest mod de vizualizare, se apasa pe butonul X.
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Pentru fluxuri de lucru ce contin un formular, acesta poate fi vizualizat, editat si transmis mai departe direct in
tab-ul Metadata din ecranul Activitati.

Pentru fiecare tip de activitate in parte, activitatile dispar din acest ecran astfel:
e  Fluxuri de lucru —1n mod activ:
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0 Utilizatorul transmite fluxul de lucru mai departe fie utilizdnd formularul, fie prin functia
Transmitere flux de lucru mai departe accesata prin click in Meniu pe Task > Pass workflow
forward (Activitate > Transmitere flux de lucru mai departe)

0 Utilizatorul deleaga fluxul de lucru sau il preda prin click in Meniu pe Task > Edit > Delegate
workflow/Hand off workflow (Activitate > Editare > Delegare flux de lucru/Predare flux de

lucru.

Fluxuri de lucru —in mod pasiv: un flux de lucru adresat unui grup de utilizatori care este acceptat de un alt

membru al grupului de utilizatori.
Remindere si monitorizare: se sterge activitatea prin ckick in Meniu pe Organize > Delete (Organizare >

Sterge).
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3.24.5 Iinuz

Tn uz —n aceastd zona de lucru se poate regési o listd cu documentele la care utilizatorul lucreaza la un moment
dat, adica sunt blocate pentru editare pentru alti utilizatori in urma optiunii de check out pentru editarea
documentului. Cat timp se afla in aceastad zona, documentele pot fi doar vizualizate de catre alti utilizatori.
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Documentele dispar automat din aceastd zond In use (In uz), imediat ce se anuleazd sau finalizeazi editarea
documentului.

3.2.4.6 Clipboard

Clipboard — este o zona de stocare temporara a documentelor. Aici se pot stoca pe termen scurt sau se poate
crea o lista de documente sau foldere favorite.

Pentru a adauga intrari in Clipboard, se selecteaza documentul/folderul dorit si apoi se apasa click in Meniu pe
View > Copy to Clipboard (Vizualizare > Copiere in clipboard).

Pagina 71 din 337



Intrarile din Clipboard se pot edita in acelasi mod ca si intrarile din zona Arhiva. Modificarile realizate in Clipboard
se aplica automat si in documentele/folderele din zona Arhiva.
O intrare ramane in Clipboard pana la eliminarea ei de catre utilizator apasand click in Meniu pe View > Remove

from Clipboard (Meniu > Vizualizare > Eliminare in clipboard).

3.2.4.7 Afisarea textului si previzualizarea imaginilor

ELO Web Client oferd elemente suplimentare de control in zona de vizualizare pentru fisiere de tip imagine (JPG,
TIFF, PNG etc.) si fisere de tip text (TXT, HTML, JS etc.) sau pentru continutul full text al documentelor.

Full text (Text complet)
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Modul de vizualizare Full text (Text complet) este utilizat pentru a afisa integral informatiile text ale
documentelor care au fost adaugate la baza de date cu text integral.

Full text:

Modul de vizualizare full text se obtine prin click in Meniu pe View > Full text (Meniu > Vizualizare > Text
complet). Prin acest mod de vizualizare se ofera mai multe optiuni de configurare a documentelor.

Modul de vizualizarea full text contine un meniu cu mai multe functii.

Functiile Large font (Font mare) si small font (font mic) pemit marirea sau micsorarea dimensiunii fontului
textului afisat:
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Marirea fontul afisat

Functia Fixed font width (Ldtime fixd font) modifica fontul textului intr-un font neproportional astfel incat toate
caracterele sa fie afisate cu aceeasi spatiere. Aceasta functie permite cresterea lizibilitatii.
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Functia Word wrap (incadrare automata cuvinte) permite ca liniile s3 fie incadrate automat.
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Functia Highlight (Evidentiere) este utilizata pentru a cauta un termen in baza de date cu text integral. Se
introduce termenul in cdmpul Evidentiere si apoi se apasa click pe butonul Search (Cdutare) pentru a marca sau
a evidentia acele cuvinte cdutate in text prin functia Evidentiere.
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Prin functiile Show previous hit (Afisare potrivire precendentd ) si Show next hit (Afisare potrivire urmdtoare)
se trece la anteriorul sau urmatorul cuvint evidentiat prin functia Evidentiere.
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Image preview (Examinare imagine)

Modul de vizualizare Image preview (Examinare imagine) este utilizat pentru preview-ul documentelor si
contine mai multe functii, inclusiv vizualizarea adnotarilor (sticky notes), fara ca acestea sa poata fi editate.

Modul Examinare Imagine contine un meniu cu mai multe functii.

Functia Show annotations (Afisare adnotdri) permite vizualizarea adnotarilor aplicate documentului.

Notele adezive (Sticky notes) pot fi create numai in ELO Java Client.
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Functiile Next or previous page (Pagina urmatoare sau Pagina precedenta) permit afisarea paginii urmatoare
sau precedente a unui document cu pagini multiple.
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Functiile Zoom in or zoom out (Micsorare si Mdrire) permit micsorarea sau marirea imaginii afisate.

Functia Zoom to 100% (Zoom la 100%) permite ca imaginea sa fie afisatd la dimensiunea originala.
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Functia Fit image width to the frame (Adaptati Iatimea imaginii la cadru) permite ca dimensiunea imaginii sa
se potriveasca latimii panoului de vizualizare.

Functia Fit image size to the frame (Adaptare dimensiune imagine la cadru) permite ca imaginea sa fie
ajustata naltimii panoului de vizualizare astfel incat sa fie afisata intreaga pagind a documentului.
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Functiile Rotate all pages 90 degrees (Rotati toate paginile la stdnga, cu 90 de grade si Rotati toate paginile la
dreapta, cu 90 de grade) permit rotarea previzualizdrii documentului cu 90 de grade.
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3.2.4.8 ELO Feed

Zona de feed este utilizata pentru distribuirea informatiilor despre o intrare (document/folder) in ELO si despre
noutati/modificari. Sunt disponibile urmatoarele tipuri de mesaje in Feed:

e Postari create de utilizatori

v' Se pot realiza postari cu mentionarea anumitor utilizatori sau grupuri de utilizatori utilizind butonul cu
simbolul @.
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@[Anderann”

E A # @ Create

v Se pot realiza postéri cu referire la anumite intrari din Arhiva utilizAnd butonul

v' Se pot realiza postari cu addgare de hashtag-uri pentru a clasifica anumite postari si comentarii,
folosint butonul cu simbolul #.
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Utilizatorii se pot abona la hashtag-uri prin butonul de abonare sau pot filtra noutatile din
zona My ELO in functie de aceste hashtag-uri.

v Utilizatorii pot seta cine poate vizualia respectiva postare folosind butonul pentru vizibilitate.
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e Comentarii la o postare

e Sondaje
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e Evenimente (de exemplu cand apar o noua versiune sau o modificare pentru un document)
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Pe langa realizarea de comentarii, utilizatorii au posibilitatea in Feed sa:
v Caute si s filtreze anumite informatii

v' S3 se aboneze la postari
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v' S3 editeze postérile

3.2.5 Personalizarea ELO Web Client

Clientul web ELO poate fi configurat si personalizat pentru fiecare utilizator sau grup de utilizatori, in functie de
preferintele acestora.

Pot fi realizate personalizari privind urmatoarele:
e Tile Navigation

e Meniu (Ribbon)
e Panou de vizualizare
e Configurari

e Setadri personale

Tile Navigation

Utilizatorul poate personaliza modul de vizualizare si continutul unui cadran (tile) prin:
e Modificarea culorii

e Modificarea pictogramei

e Modificarea dimensiunii

e Fixarea/Anulare fixare pe bara de navigare
e Ascunderea tile-ului

e Crearea modului de vizualizare

e Crearea si editarea grupurilor de accesare rapida
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Prin click dreapta pe cadran se deschide un meniu contextual prin care se pot realiza urmatoarele setari:
e Fixarea/Anularea fixarii pe bara de navigare, 1anga numele utilizatorului
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e  Modificarea dimensiunii

e  Ascunderea cadranului (tile-ului)
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e Modificarea setarilor pentru un cadran (culoare, dimensiune, pictograma)

Prin click pe Settings (Setdri) se va deschide automat o fereastra cu diverse optiuni pentru personalizarea unui
tile:
e Culoare

e Pictograma
e Dimensiune
e Fixare/anulare fixare pe bara de navigare

e Afisare/anulare afisare numar intrari

Modificarile realizate asupra unui tile sunt salvate automat.
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In Tile Navigation se pot adauga tile-uri cu anumite foldere de interes din arhiva, care sunt utilizate frecvent sau
se pot adauga tile-uri cu anumite activitati de interes, care sunt prioritare.

Prin click pe aceste tile-uri adaugate se asigura accesul direct la acele foldere/activitati pentru accesul rapid la
informatiile de interes.

Pentru adaugarea unui folder in Tile Navigation, se utilizeaza calea: Repository work area (zona de lucru Arhiva)
- selectare folder dorit, iar apoi Th meniu se apasa click pe View > Create view (Vizualizare > Creare vizualizare).
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Pentru redenumire sau stergere tile, utilizatorul apasa click pe tile si apoi click in meniu, pe:
e View >Views > Rename view (Vizualizare > Vizualizari > Redenumire vizualizare) pentru redenumire

vizualizare

e View >Views > Delete view (Vizualizare > Vizualizari > Stergere vizualizare) pentru stergere vizualizare.
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Pentru adaugarea unei activitati in Tile Navigation, se utilizeaza calea: Tasks work area (zona de lucru Activitati)
- selectare activitate doritd, iar apoi in meniu se apasa click pe View > Create view (Vizualizare > Creare
vizualizare).

Pentru redenumire sau stergere tile, utilizatorul apasa click pe tile si apoi click in meniu, pe:
e View > Views > Rename view (Vizualizare > Vizualizari > Redenumire vizualizare) pentru redenumire

vizualizare

e View > Views> Delete view (Vizualizare > Vizualizari > Stergere vizualizare) pentru stergere vizualizare.
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n fereastra New task view (Vizualizare activitdti noi) se pot defini criterille pentru afisarea activitatilor in Tile
Navigation.

Utilizatorul poate crea un tile pentru cautari favorite in Tile Navigation pentru acele cautari pe care le utilizeaza
n mod frecvent. Tn zona de lucru Ciutare se pot configura aceste ciutdri favorite prin click in meniu si apoi pe
Search > Search favorites > Add favorite (Cdutare > Preferinte de cdutare > Addugare preferintd).
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Dupa ce se seteaza cdutarea favorita, se creeaza automat un tile in Navigation Tile, zona Hidden Tiles (Cadre
ascunse).
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Utilizatorul poate suprascrie sau sterge cautarile favorite prin click pe butonul Overwrite (Suprascriere) si Delete
(Stergere) urmand calea Search > Search favorites >[Name of the search favorite] > Overwrite / Delete (Cdutare
> Preferinte de cdutare > Numele cdutarii favorite > Suprascriere / Stergere.
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Pentru gruparea tile-urilor (cadrelor), utilizatorul poate utiliza butonul @ din partea dreapta, jos, a ecranului
My ELO. Pentru a schimba pozitia unui grup, utilizatorul apasa click pe numele grupului si cu mouse-ul poate
trage grupul in pozitia doritd. Daca este sters un grup, tile-urile din grup sunt mutate automat in Hidden Tiles
(Cadre ascunse).

Meniu (Ribbon)

Utilizatorul poate personaliza meniul pentru a gasi rapid functiile de care are nevoie prin:
e  Fixarea functiilor din meniurile de tip drop down in meniu sau in tab-ul Favorites

e Eliminarea functiior addaugate in meniu sau in tab-ul Favorites

o Afisarea doar a pictogramei unei functii prin ascunderea textului
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Fixarea functiilor din meniurile de tip drop down in meniu sau in tab-ul Favorites, se realizeaza prin click dreapta
pe functie si apoi click pe butonul Pin here (Fixare aici) pentru adaugare in meniu sau prin butonul Pin to favorites
(Fixare la preferinte) pentru addugarea in tab-ul Favorites (Preferinte).

Eliminarea functiior adaugate in meniu sau in tab-ul Favorites (Preferinte), se realizeaza prin click dreapta pe
functia respectiva si apoi click pe butoanele Unpin from favorites (Anulare fixare la preferinte) sau Unpin from
here (Anulare fixare aici).
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Afisarea doar a pictogramei unei functii prin ascunderea textului se realizeaza prin click dreapta pe o functie si
apoi click pe butonul Hide text (Ascundere text).

Dupa ce se utilizeaza Hide Text, dispare textul si ramane doar pictograma pentru functia respectiva.

Pentru afisarea textului din nou, se utilizeaza butonul Show text (Afisare text).
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Panou vizualizare

Fiecare intrare in ELO (folder sau document) contine elementele:
v' Contents (Cuprins)
v'  Metadata (Metadate)
v" Feed (Flux)

Se poate personaliza modul de vizualizare cu aceste elemente, in functie de nevoia fiecarui utilizator prin:
e Combinarea elementelor pentru preview
Contents (Cuprins) si Metada (Metadate) sunt pozitionate in partea stanga a Feed-ului care este

pozitionat mereu in partea dreapta. Utilizatorul poate schimba optiunile de vizualizare intre Contents si
Metadata utilizand aceste tab-uri.

Contents Metadata Feed

Mai multe detalii puteti vizualiza in capitolul despre zona de lucru Arhiva.

o Afisarea intrarilor

In tab-ul Contents (Cuprins) se poate vizualiza continutul unei intrari (folder sau document). Utilizatorul
poate modifica modul de afisare al intrarilor in tab-ul View (Vizualizare).

Foldere
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Folderele sunt afisate in mod standard (by default) sub forma de lista. Vizualizarea continutului
folderelor sub forma de tabel si afisarea metadatelor, se realizeaza prin click pe butonul Table (Tabel).
Afisarea doar a anumitor informatii se realizeaza prin click pe pictograma cu sageata, asezata imediat
langa capul de tabel si se bifeaza doar coloanele dorite pentru afisare.

Prin click pe butonul Group by field, utilizatorul poate grupa documentele in functie de metadate. Prin
debifarea acestei optiuni, tabelul este afisat fara gruparea documentelor.

Afisare cu gruparea documentelor in functie de nume

Documente
Moduri de afisare a documentelor: Full Text si Image Preview. Mai multe detalii gasiti in capitolul

Afisarea textului si imaginilor.
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Configurare

Sunt disponibile o multitudine de optiuni de configurare accesand butonul Configuration (Configurare) din
meniul utilizatorului - User menu [your name] > Configuration.

Utilizatorul poate modifica setdrile prin butonul din dreapta ecranului de configurare Reset my view data
(Resetare date de examinare personale), prin care se revine la setarile initiale.
Pentru cautarea une anumite categorii se poate utiliza zona de Search (Cdutare) situata imediat sub categoriile

de configurat.
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Setari personale

Setarile personale se acceseaza din meniul utilizatorului, fiind disponibile urmatoarele optiuni pentru
modificarea setarilor personale:

e Editare profil
e Modificare parola de access

Editare profil

Uizatorul poate insera informatii despre el (date de contact, functie, departament etc.) si poate insera fotografia
sa. Profilul este vizibil pentru alti utilizatori prin click pe nume sau pe fotografie in cadrul Feed-ului.
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Modificare parola de access

Utilizatorul isi poate modifica parola de cate ori doreste acest lucru. Pentru a insera o noua parola, utilizatorul
trebuie sa stie vechea parola. In cazul in care utilizatorul a uitat parola, acesta trebuie sa contacteze
administratorul. Daca noua parola este refuzata de sistem, inseamna ca nu indeplinese toate criteriile conform
regulilor din companie.
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3.2.6 Adaugare intrari in ELO Web Client
3.2.6.1 Creare foldere

Sunt disponibile urmatoarele functii pentru crearea de foldere:
e Create folder (Creare folder)
e Dynamic folder (Folder dinamic)

Creare folder

Utilizatorul selecteaza mai intai folder-ul parinte unde doreste crearea unui folder in subordinea lui si apoi apasa
click pe New > New folder. Un nou folder este creat imediat in cadrul folder-ului selectat. Ca si in cazul dosarelor
fizice dintr-o arhiva, intr-un folder din ELO se pot adauga alte foldere in subordine (child folder) sau documente.

O alta metoda de creare a unui folder: utilizatorul selecteaza folderul parinte (in subordinea caruia va fi creat
noul folder) si prin click dreapta afiseaza meniul contextual si selecteaza optiunea New folder (Folder nou).
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Se va deschide o fereastra pentru completarea metadatelor.
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Dynamic folder (Folder dinamic)

ELO permite salvarea operatiunilor de cautare dupa anumite criterii, sub forma unui folder dinamic care se
populeaza automat in momentul in care intrari ce corespund criteriilor de cautare sunt arhivate in depozitul de
arhiva, pentru a permite cdutari ulterioare mai rapide. Pasi pentru crearea unui folder dinamic:

1. Realizarea unei cautariin ecranul Search (Cautare)

2. Click pe Result > Dynamic folder (Rezultat > Folder dinamic)
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3. Se deschide fereastra care permite crearea folderului dinamic. Se va selecta folderul in care se doreste
indosarierea folderului dinamic (se poate inclusiv crearea unui folder nou).

4. Utilizatorul va introduce numele si metadatele noului folder dinamic
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Folderul dinamic va fi disponibil in ELO in zona selectata si va contine referinte catre toate
documentele din sistem care corespund criteriilor de cautare. Acest folder se va popula automat cu
informatie pe masura ce noi documente care corespund criteriilor de cautare sunt arhivate in ELO.

3.2.6.2 indosariere documente

Utilizatorul are trei optiuni pentru a adduga/indosaria documente intr-un folder prin:

1. Functia Insert file (Inserare fisier)
2. Drag-and-drop
3. Functia Document from template (Document din sablon)
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Functia Insert file (Inserare fisier)

Se selecteaza folder-ul in care se doreste indosarierea documentului si se apasa click pe New > Insert file.

Se deschide o fereastra care permite inserarea documentului salvat local.

Utilizatorul are doua optiuni pentru adaugarea documentului:
- Selectarea documentului dorit si inserarea lui prin click pe butonul Open
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- Aducerea documentului in zona Drop file here

Dupa ce este utilizata una din metodele descrise mai sus pentru adaugarea unui document, se deschide o

fereastra Insert file (Inserare fisier), care permite adaugarea unor informatii minimale legate de noul document:
formularul de indexare asociat cu campurile de indexare specifice formularului. Dupa apasarea butonului OK,

documentul este addugat in arhiva electronica.
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Drag-and-drop

Se selecteaza folder-ul in care se doreste indosarierea documentului, apoi se apasa click pe document si prin
drag-and-drop se insereaza in ELO Web Client direct in folder-ul selectat anterior.
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Dupa ce este utilizata metoda de inserare prin drag-and-drop, se deschide o altd fereastra Insert file (Inserare
fisier) care permite adaugarea unor informatii minimale legate de noul document: formularul de indexare asociat
cu campurile de indexare specifice formularului. Dupa apasarea butonului OK, documentul este adaugat in arhiva
electronica.

Functia Document from template (Document din sablon)

ELO permite utilizarea de documente pe post de sabloane, pe baza carora se pot crea alte documente. Utilizatorii
pot crea sabloanele de documente pe care apoi sa le salveze intr-o zona speciala din arhiva electronica si utiliza
prin intermediul butonului Document from template (Document din sablon).

Se selecteaza folder-ul in care se doreste indosarierea documentului si se apasa click pe New > Document from
template (Document din sablon).

Se deschide o fereastra care permite selectarea template-ului pentru noul document.
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Dupa ce este utilizata metoda de inserare prin drag-and-drop, se deschide o alta fereastra Insert file (Inserare
fisier) care permite adaugarea unor informatii minimale legate de noul document: formularul de indexare asociat
cu campurile de indexare specifice formularului. Dupa apasarea butonului OK, documentul este adagat in arhiva
electronica si in acelasi timp se deschide automat o fereastra Check Out (Procesare prin check-out) pentru

editarea imediata a documentului.

Folosind una din cele doua optiuni — Save as (Salvare ca) sau Edit in Microsoft Office (Editare in Office), se poate
deschide pentru editare noul document creat din sablon, iar in ELO documentul va fi marcat ca fiind blocat la
editare de catre ceilalti utilizatori prin afisarea numelui utilizatorului care 1l editeaza in dreptul numelui

documentului sub forma: [Nume utilizator] Nume document.

Utilizatorul va realiza modificarile necesare in document, va salva documentul si apoi va realiza actiunea de
Upload and check in (Incdrcare si procesare prin check-in) pentru inserarea documentului inapoi in ELO prin
fereastra de Check out care contine si functia de Upload and check in, daca editarea a avut loc imediat dupa

check out.
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Actiunea de check in se mai poate realiza prin click pe Document > Upload and check in (incdrcare si procesare
prin check-in).
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3.2.6.3 Metadate

Metadatele reprezinta informatii referitoare la o intrare (folder sau document) si includ informatii atat despre
intrarea in sine, de exemplu despre data cand a fost indosariat un document sau numele din arhiva electronica,
cat si informatii despre permisiuni, adica ce utilizatori au access la documente/foldere.

Formulare electronice

Formularele electronice cu metadate permit organizarea documentelor intr-un mod standardizat si indosarierea
rapida in ELO, avand ca efect cautarea mai rapida si usoara a documentelor in ELO.
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Formularele electronice contin un sablon (template) dedicat pentru fiecare tip de document. Toate documentele
de acelasi tip primesc aceleasi permisiuni si sunt indosariate in ELO pe baza formularului completat. Utilizatorul
completeaza campurile de indexare din formularele electronice la indosarierea unui document, dar au
posibilitatea sa si editeze aceste campuri de indexare ale documentelor indosariate deja.

Daca este instalat modulul ELO Barcode, se pot extrage automat metadatele din codurile de bare. Mai multe
informatii despre acest subiect gasiti in capitolul despre ELO Barcode.

Campuri de indexare

Metadatele pentru un document sunt completate in campurile din formularele electronice. Exista mai multe
tipuri de campuri de indexare care pot fi configurate diferit in functie de formularul electronic. Tipul de camp
determina informatia ce trebuie completata.

Daca un camp din cadrul formularului contine un simbol, aceasta inseamna ca ELO ajuta la inserarea informatiei
in campul respectiv prin urmatoarele tipuri de campuri:

e Calendar

e Liste cu cuvinte cheie

e  Meniuri de tip drop-down
e  Link-uri
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Calendar

Liste cu cuvinte cheie

Process owner

Pentru campurile fara liste de cuvinte cheie, se poate utiliza tasta F7 pentru a se deschide o lista cu intrarile
anterioare in campurile respective, utilizatorul putdnd naviga prin lista afisata pentru a gasi informatia de care

are nevoie pentru completare.
Meniuri de tip drop-down
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Link-uri

Partners

Pentru a deschide lista cu link-uri, utilizatorul apasa click pe simbolul reprezentind un lant, dupa care poate naviga
n lista si poate sorta rezultatele folosind meniul de tip drop-down situat imediat langa capul listei — Short name.
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Tab-uri in formularele electronice

Fereastra pentru completarea metadatelor din formulare este impartita in tab-uri. Toate formularele au tab-urile
Basic (De bazd), Extra text (Text suplimentar), Options (Optiuni) si Permissions (Permisiuni). Formularele pot avea
si tab-uri suplimentare, iar cdmpurile din fiecare tab depind de formularul selectat.

Tab-ul Basic (De baza)

Short name (Nume scurt): numele scurt este numele intrarii (folder sau document) care este afisat in structura
arborescenta din zona de lucru Arhiva.

Date (Data):

e Pentru documente: in acest camp apare automat data la care un document a fost creat sau editat cel mai
recent.

Daca se doreste schimbarea datei in afisarea datei in care se arhiveaza un document, se bifeaza optiunea de
langa Adjust document date (set to today).

Daca nu se activeaza aceasta optiune, se va afisa data la care a fost creat documentul in cdmpul Date (Data), iar
data arhivarii documentului se va afisa in cdmpul Filing date (Data indosariere). Un alt termen pentru data este
Document Date.

¢ Pentru foldere: Campul poate fi completat dupa cum doresc utilizatorii.
Doar pentru foldere:

ELOINDEX: Acest camp este doar pentru arhivarea documentelor. La arhivarea documentelor automat, ELO
identifica unde sa arhiveze documentul prin intermediul ELOINDEX.
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Tab-ul Extra text (text suplimentar)

n acest cadmp se pot introduce informatii care nu sunt acoperite de celelalte cdmpuri, de exemplu o descriere
mai exactd sau un comentariu.
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Tab-ul Options (Optiuni)

Mai multe informatii despre campurile Personal identifier (ldentificator personal), End of deletion period
(Terminare perioadd de stergere) si End of retention period (Terminare perioada de pastrare) se gdsesc in
capitolul Date cu caracter personal.

Starting point for replication (Punct de pornire pentru replicare): Dacd aceastd optiune este activata, se va
replica doar intrarea selectata si nu si folderele parinte. Aceasta optiune permite sa fie reproduse anumite zone,
parti din arhiva care nu sunt indosariate in structuri identice din arhiva.

n primul rand, trebuie activata aceasta optiune si apoi atribuiti folderul unui set de replicare. Din meniu se apas3
click pe Organize > Properties> Assign replication sets (Organizare > Proprietdti > Atribuire seturi de replicare).
Mai multe informatii veti gasi in capitolul Seturi de replicare.
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Doar pentru foldere:

Sortare: Se poate defini ordinea de sortare a continutului folderului in campul Sorting field. Daca selectati
Manual, puteti muta manual intrarile in folder prin selectarea folderului din structura arborescenta. Tn panoul de
vizualizare, se apasa click pe intrarea dorita si apoi se poate muta prin tragerea ei in pozitia in care se doreste.
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Enable quick preview for documents in the folder (Activati examinarea rapidd pentru documentele din folder):
se utilizeaza aceasta optiune pentru a se vizualiza primul document dintr-un folder in panoul de vizualizare de
indata ce se apasa click pe folder.

Doar pentru documente:

Document status: Tn acest cdmp se poate configura modul in care se comportd documentul in cazul unor
modificari.

Version control disabled: O singura versiune a documentului este salvata. O noua versiune inlocuieste versiunea
anterioard, care este stearsa si nu mai este disponibila.

Daca selectati aceasta optiune, versiunea anterioara este suprascrisa de fiecare data cand salvati. The View >
Document > Versions > Load new version.

Non-modifiable: Nici documentul, nici metadatele associate nu pot fi editate. Atentie, statusul Non-modifiable
nu poate fi inversat.

Encryption key: acest camp este completat automat in functie de formularul de metadate selectat si nu poate fi
modificat.

File name: numele anterior al documentului este introdus automat in acest camp. Numele pe care I-ati introdus
in Short name din Basic este afisat in structura arborescenta si nu acest nume.
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Tab-ul Permissions (Permisiuni)

Tn acest tab se pot configura ce grupuri si utilizatori au drepturi in cadrul arhivei la documente si foldere.
User/group (Utilizator/grup): Se pot selecta selecta optiunile Owner permissions (Permisiuni proprietar) si
Parent permissions (Permisiuni pdrinte) din meniul de tip drop-down.

Daca se selecteaza optiunea Owner permissions, se atribuie toate drepturile la intrare (folder sau document).
Permisiunile proprietarului pot fi transferate daca utilizatorul paraseste compania.

Daca se selecteaza optiunea Parent permissions pentru a atribui noii intrari (folder sau document) aceleasi
drepturi ca si intrarea parinte.

Selectare permisiuni: Pentru a edita setarile de permisiuni pentru o persoana selectatad, utilizator sau grup,
selectati utilizatorul sau grupul si apoi activati sau dezactivati optiunile individuale.

Sunt disponibile urmatoarele optiuni:

e R (View) - vizualizare — poate vizualiza obiecte ELO (documente, elemente de structura) precum si
informatiile indexate. Nu poate modifica intrarea, dar poate adauga note de margine

e W (Change metadata) — scriere — utilizatorul poate edita sau modifica informatiile indexate sau
metadatele intrarilor

e D (Delete) — stergere — utilizatorul poate sterge obiecte ELO

e E (Edit) — editare — utilizatorul poate doar sa editeze obiecte ELO. Aceasta inseamna ca poate verifica
documentul, poate incdrca o versiune noua si poate modifica versiunea de lucru.

Pagina 129 din 337



Utilizatorii cu acest drept nu pot accesa informatiile indexate. Acest fapt inseamna ca se poate desemna
unui utilizator dreptul de editare asupra documentelor fara ca acestia sa aiba dreptul de a modifica
informatiile de indexare.

e L (Edit lists) — editare liste — Aceasta permisiune se aplica strict folderelor. Utilizatorii ce detin
permisiunea de Edit lists pot schimba continutul respectivului folder. De exemplu, pot crea documente
in folder sau pot muta documente din folder.

e P (Permission) — permisiuni — acest drept permite utilizatorilor sa gestioneze schimbarile in permisiuni
si drepturi de acces asupra obiectelor ELO din arhiva (documente, foldere). Utilizatorii ELO care au
drepturi de acces pe un anumit obiect ELO pot schimba setarile de permisiuni.

Personal (Personal): Acest buton se foloseste pentru a atribui acces unic la respectiva intrare. Daca alti utilizatori
sau grupuri au avut permisiuni, acestea sunt eliminate.

AND group (Si grup): pentru a crea un Sl grup, selectati doua grupuri din coloanal din mijloc si apasati click pe Sl
grup. Sl grupurile ofera permisiuni doar utilizatorilor care sunt membri ai ambelor grupuri.

Show members (Afisare membri): pentru a afisa membrii unui grup, selectati grupul, apoi apasati click pe Show
members (Afisare membri).
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Inserare metadate prin intermediul ELO Click OCR

Caracteristica integrata de recunoastere a textului poate fi folosita ca instrument de introducere a metadatelor.
ELO Click OCR transfera textul dintr-un document in formularul de metadate. OCR functioneaza pe documente
TIF si in previzualizarea imaginii. Din meniu se apasa click pe View > Image preview (Vizualizare > Examinare
imagine).

Pentru a utiliza aceasta metoda, mai intai trebuie salvat documentul si apoi se selecteaza respectivul document
al carui metadate se doresc a fi editate.

Urmatorul pas este configurarea panoului de previzualizare astfel incat fie vizualizate atat metadatele, cat si
documentul.
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Apoi se apasa click pe butonul Edit (Editare) in partea de jos a casetei de dialog metadate.

Urmatorul pas este sa se apese click pe pe campul caruia se doreste aplicarea unei valori din respectivul
document. Tinand apdsata tasta CTRL si butonul stang al mouse-ului. Se poate desena un cadru in jurul
informatiilor din document pe care doriti sa le utilizati pentru metadate.

Informatie: daca doriti sa transferati mai multi termeni unul dupa altul, selectati individual fiecare termen
folosind butonul stang al mouse-ului in timp ce tineti apasat tastele CTRL + SHIFT. Eliberati butonul mouse-ului
dupa fiecare termen. Se repeta procesul pana cand sunt transferati toti termenii doriti.

Dupa acesti pasi, se pot elibera tastele si mouse-ul. ELO Click OCR citeste continutul text al zonei selectate.
Informatia text recunoscuta este transferata in campul selectat.

Informatie: Daca nu s-a selectat un camp, este afisat textul recunoscut in caseta de dialog OCR. Se poate copia
textul de care este nevoie si apoi poate fi lipit in Clipboard.
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Ultimul pas este sa se apese click pe butonul Save (Salvare) pentru a parasi modul de editare si a se accepta
modificarile.

3.2.6.4 Date cu caracter personal

Marcarea datelor cu caracter personal

ELO detine campul Personal Identifier (Identificator personal) din tab-ul Options (Optiuni) din cadrul formularelor

electronice, cdmp in care se poate aloca un cod abstract pentru fiecare document, corespunzator unei anumite

persoane, permitand anonimizarea datelor si marcarea informatiei ca fiind sensibila.

Astfel toate documentele care apartin de o persoana se pot cauta dupa acest cod fara a folosi numele persoanei

respective.

Campurile End of deletion period (Terminare perioadd de stergere) si End of retention period (Terminare perioadd
de pdstrare) reprezinta termene limita de stergere si pastrare pentru documente, permitand setarea unei perioade
maxime de pastrare si stergerea automata cand aceasta perioada a expirat.

Cautare intrari cu date cu caracter personal

Cautarea datelor cu caracter personal se realizeaza prin click pe Search > Search logic > Search Metada (Cdutare
> Proces logic de cdutare > Cdutare metadate).

Se va deschide fereastra Search metadata (Cautare metadate) in care se pot completa criteriile de cautare a
datelor cu caracter personal. Campul Personal Identifier (Identificator personal) se poate completa cu
identificatorul personal setat pentru o anumita intrare sau cu simbolul *, daca se doreste cautarea tuturor
intrarilor carora le-a fost setat un identificator personal.
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Stergerea intrarilor ce contin date cu caracter personal

Scopul marcarii datelor cu caracter personal este si pentru a se gestiona steargerea intrarilor care contin date
cu caracter personal in concordanta cu cerintele legale pentru acest tip de informatii.

Pentru stergerea intrarilor cu date cu caracter personal, mai intai se cauta aceste intrari in functie de campurile
End of deletion period (Terminare perioadd de stergere) sau End of retention period (Terminare perioadd de
pdstrare). Dupa gasirea acestor intrari, se pot sterge prin click pe Organize > Delete (Organizare > Stergere).
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Intrarile nu sunt sterse permanent, sunt doar marcate ca si sterse pentru a interveni utilizatorul cu rol de
administrator si sa stearga permanent respectivele intrari din ELO.
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3.2.6.5 Atasament

ELO Web Client permite adagarea de atasamente la documentele din arhiva. Utilizatorul selecteaza documentul
pentru care doreste sa incarce un atasament, apoi apasa click pe Document > Attachment > Add attachment
(Document > Atasare > Addugare atasare).

Utilizatorul are doua aptiuni pentru adaugarea atasamentului: fie apasa click pe butonul din dreapta campului
Select file (Selectare fisier) si selecteaza documentul salvat local, pe care doreste sa il ataseze, fie trage
documentul dorit in zona Drop file here (Fixati fisierul aici).

Utilizatorul va recunoaste existenta atasamentelor la un document pe baza pictogramei care afiseaza o agrafa
de birou si care poate fi folosita pentru deschiderea atasamentului prin click pe aceasta pictograma.

e Contents Form b X
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3.2.6.6 Note de margine

ELO Web Client permite adaugarea de notite de margine asupra documentelor si folderelor din sistem. Sunt
permise trei tipuri de note de margine:

e Notite generale (galbene) care sunt vizibile pentru toti utilizatorii

e Notite personale (verzi) care sunt vizibile doar creatorului

e Notite permanente (rosii) care nu se pot sterge si sunt vizibile pentru toti utilizatorii.
Toate notele de margine se aplica in aceeasi modalitate.
Din meniul principal, se apasa click pe Document > Margin notes > General margin note / Personal margin note /
Permanent margin note (Document > Note pe margine > Notd pe margine generald /Notd pe margine personald /
Notd pe margine permanentd).

Se va deschide o fereastra unde se va redacta textul notei si la final se apasa butonul OK.
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Pentru vizualizarea notei de margine se apasa click pe pictograma notei de margine aferenta documentului.

Nota de margine se aplica intregului document, nu doar versiunii curente.

3.2.7 Editare intrari

Prin editarea unui document sau indosarierea unei noi versiuni a documentului/atasamentului, se va crea o noua
versiune a acestuia, utilizatorii avand posibilitatea de a se intoarce oricand la o versiune anterioara, cu conditia
ca aceasta sa nu fi fost stearsa. ELO ofera posibilitatea de a suprascrie continutul documentelor fara a modifica
versiunea documentului.

Daca Version control disabled este activatad in ferestra Metadata (Metadate), tab-ul Options (Optiuni),
versiunea anterioara va fi suprascrisa la fiecare salvare a documentului.

Functia Load new version (incdrcare versiune noud) suprascrie peste versiunea curentd si nu creeazd o noud
versiune, de aceea nu este recomandat de utilizat.
Document > Versions > Load new version (Document > Versiuni document > incdrcare versiune noud)

3.2.7.1 Editare documente

Sunt disponibile urmatoarele optiuni pentru editarea documentelor:

* Functiile Check out si Upload and Check in

¢ Functia Edit in Office

® Functia Edit online (functie disponibila la utilizarea interfetei ELO pentru Microsoft Office Online)

* Functia Collaborate (functie disponibila la utilizarea interfetei ELO pentru Microsoft Office Online)

ELO permite nativ procesarea si versionarea documentelor prin functionalitati de tip ,,Check In - Check Out”, cu
blocarea versiunii la editare pentru alti utilizatori pe perioada editarii.

Functia Check out (Procesare prin check-out)
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Se foloseste functia Check out pentru editarea documentului, timp in care va ramane blocat la editare pentru alti
utilizatori, care vor putea deschide respectivul document doar in modul read only. Dupa finalizarea editarii, se
foloseste functia Upload and check in pentru inserarea documentului editat in ELO. Tn ELO documentul este
marcat ca fiind blocat la editare de catre ceilalti utilizatori prin afisarea unei sageti galbene si a numelui
utilizatorului care 1l editeaza in dreptul numelui documentului sub forma: [Nume utilizator] Nume document.

Pentru utilizarea functiei Check out, mai intdi se selecteaza documentul care se doreste editat, apoi se apasa
click pe Document > Check out (Document > Procesare prin check-out) sau prin click dreapta pe document care
deschide un meniu contextual din care se alege Check out (Procesare prin check-out).
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Se va deschide fereastra Check out. Daca se apasa butonul Close din fereastra Check out, nu se va anula editarea,
documentul va aparea tot in check out.

Pentru editare, se va apdsa mai intai butonul Save as (Salvare ca) prin care documentul este salvat in folderul
standard Downloads. Pentru a se salva modificarile aduse documentului, acesta trebuie salvat local in
computerul utilizatorului pentru editare si apoi incarcat inapoi in ELO cu noua versiune.

n timpul editarii documentului, acesta va aparea in zona de lucru In use (in uz) si va dispirea automat din aceasts
zona de lucru in momentul cand iese din starea check out.
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Functia Upload and check in

Daca se editeaza un document imediat dupa check out, ramane deschisa fereastra Check out cu functia Upload
and check in (Iincdrcare si procesare prin check-in) prin care se poate selecta documentul si insera in ELO.

Pentru a se procesa un document prin check in, se apasa click pe Document > Upload and check in (Document >

fncdrcare si procesare prin check-in).
Se deschide fereastra Upload and check in din care se selecteaza documentul editat prin butonul Select file

(Selectare fisier) sau prin tragerea documentului in zona Drop file here (Fixati fisierul aici).
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Documentul este indosariat cu o alta versiune.

Revocare editare document

Pentru anularea editarii unui document se foloseste functia Cancel editing prin click pe Document > Versions >
Cancel editing (Document > Versiuni > Revocare editare)
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Revocarea editdrii se mai poate realiza si prin click dreapta pe documentul selelctat si apoi din meniul contextual
care se deschide, se va selecta butonul Cancel editing (Revocare editare).

Functia Edit in Office (Editare in Office)

Pentru editarea unui document Microsoft Office, acesta se poate deschide utilizdnd functia Edit in Office (Editare
in Office)

Mai intai se selecteaza documentul care se doreste sa fie editat, apoi se apasa click pe Document > Edit in Office
(Document > Editare in Office).
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Aceasta functie este disponbila si in fereastra Check Out, prin click pe Document > Check out (Document >
Procesare prin check-out)

n timpul editérii documentului, acesta apare cu starea Checked out pentru alti utilizatori. Nu este nevoie de
procesare prin check-in pentru ca imediat ce este salvat documentul Microsoft Office, modificarile sunt salvate
n ELO.

Functia Edit online

Aceasta functie este disponibila la utilizarea interfetei ELO pentru Microsoft Office Online. Functia Edit online
permite utilizatorului sa deschida si sa editeze online documente Microsoft Office.
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Mai intai se selecteaza documentul care se doreste sa fie editat, apoi se apasa click pe Document > Edit online,
se selecteaza aplicatia cu care se doreste deschiderea documentului si apoi se confirma increderea in sursa
fisierului. Documentul se va deschide pentru editare intr-un tab nou al browserului. Modificarile sunt salvate in
ELO imediat ce se inchide tab-ul ce contine documentul.

Functia Collaborate (Colaborare)

Aceasta functie este disponibila la utilizarea interfetei ELO pentru Microsoft Office Online.

Prin click pe Document > Collaborate (Document > Colaborare), utilizatorul deschide documentele Microsoft
Office online si le editeaza in colaborare cu alti utilizatori. Documentul este deschis intr-un tab nou al browserului
pentru editare. in timp ce utilizatorul editeazd documentul, acesta este prezentat in arhiva ca fiind check-out.
Daca mai multi utilizatori editeaza documentul, utilizatorul ELO Service este afisat ca editor. Modificarile sunt
salvate Tn ELO imediat ce se inchide tab-ul ce contine documentul.

3.2.7.2  incircare o noui versiune a unui document

Utilizatorul are posibilitatea de a incarca o noua versiune a unui document daca nu a folosit functia de procesare
prin check-out pentru editarea versiunii curente a documentului din arhiva ELO.
Pentru a incarca o nouad versiune, utilizatorul are disponibile optiunile:

e  Functia Load new version

e Drag-and-drop

Functia Load new version (incircare versiune noud)

Mai intai se selecteaza documentul pentru care se doreste incdrcarea unei noi versiuni a lui si apoi se apasa click
pe Document > Versions > Load new version (Document > Versiuni > Incdrcare versiune noud).

Se va deschide fereastra Load new version (incdrcare versiune noud), din care se selecteaza documentul editat
prin butonul Select file (Selectare fisier) sau prin tragerea documentului in zona Drop file here (Fixati fisierul aici).
Pentru ca documentul sa fie blocat la stergere, se bifeaza optiunea Non-deletable version (Versiune blocata la
stergere).
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Drag-and-drop

Mai Tntai se selecteaza documentul reprezentind o noua versiune pentru care se doreste incarcarea in ELO si apoi
se trage direct in ELO tinand apasat butonul mouse-ului.
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Functia Document versions (Versiuni document)

Doar versiunea curenta a documentului este afisata in arhiva. ELO permite ca utilizatorul sa se poata intoarce la
vechile versiuni ale documentelor utilizand functia Document versions.

Mai intai se selecteaza documentul a carui versiuni se doresc vizualizate, apoi se apasa click pe Document >
Versions > Document versions (Document > Versiuni > Versiuni Document).

Se va deschide fereastra Document versions (Versiuni document), in care se va recunoaste imediat versiunea
curenta de lucru prin simbolul cu care este marcata.
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Set as working version (Setare ca versiune de lucru)

Pentru setarea unei versiuni anterioare ca versiune de lucru, se selecteaza versiunea dorita pentru aceasta setare
si apoi se apasa click pe butonul Set as working version (Setare ca versiune de lucru). Noua versiune selectata va
fi afisata in zona de lucru Arhiva.

Istoric al versiunilor fisierelor in ELO
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Set as non-deletable (Setare ca versiune blocata la stergere)

Pentru setarea ca versiune blocata la stergere, se selecteaza versiunea dorita pentru aceastd setare si apoi se
apasa click pe butonul Set as non-deletable version (Setare ca versiune blocatd la stergere). Versiunea respectiva
nu va putea fi stearsa, dar va permite incarcarea altor versiuni a documentului.

3.2.7.3  incarcarea unei versiuni noi a unui atasament

Pentru incarcarea unei versiuni noi a unui atasament, se utilizeaza functia Add attachment. Utilizatorul selecteaza
documentul pentru care doreste sa incarce un atasament, apoi apasa click pe Document > Attachment > Add

attachment (Document > Atasare > Addugare atasare). Versiunea anterioara nu se va pierde, va rdmane
disponibild ca versiune.
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Daca uilizatorul apasa click pe pictograma cu simbolul unei agrafe de birou, atunci va vizualiza versiunea curenta
a atasamentului.
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Pentru a vizualiza versiunile anterioare ale atasamentelor se utilizeaza functia Attachments prin click pe
Document > Attachment > Attachments (Document > Atasare> Atasari).

Pagina 151 din 337



Daca o versiune nu este marcata ca versiune blocata la stergere, utilizatorul o poate sterge prin butonul Delete
version (Stergere versiune).
n ELO Java Client atasamentele pot fi marcate doar ca si versiuni blocate la stergere.

3.2.8 Creare si editare sarcini

3.2.8.1 Pornire flux de lucru

Folosind fluxurile de lucru, puteti atribui sarcini altor utilizatori sau grupuri de utilizatori. O functie integrata de
gestionare a escaladarii va permite sa urmariti daca termenele stabilite sunt respectate odata ce un flux de lucru
este Tnceput.

Urmatoarele optiuni sunt disponibile pentru pornirea fluxurilor de lucru:
¢ Functia Pornire flux de lucru ad-hoc

e Functia Pornire flux de lucru

Pornire flux de lucru ad-hoc

Fluxul de lucru ad-hoc este potrivit pentru procese simple care pot fi secventiale sau paralele (de exemplu, cateva
documente care ar trebui sa fie partajate intre mai multi angajati). Se utilizeaza atunci cand nu exista un sablon
predefinit sau Tn cazuri in care se lucreaza in echipe si atunci se pot transmite documentele cu usurinta tuturor
membrilor echipei pentru informare.

Pentru a porni un flux de lucru ad-hoc, mai intai se selecteaza intrarea pentru care se doreste inceperea unui flux
de lucru ad-hoc si apoi se apasa click in meniu pe New > Create task > Ad hoc workflow (Nou > Creare activitate
> Flux de lucru ad-hoc).
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Un flux de lucru ad-hoc poate fi pornit de catre orice utilizator care are drepturi de pornire fluxuri de lucru si tot
ceea ce trebuie sa facd este sa selecteze utilizatorii sau grupurile carora doreste sa le trimita documentele si tipul
de flux de lucru ad-hoc.

Exista patru tipuri de fluxuri de lucru ad-hoc care se pot selecta din zona Type (Tip):
v' aprobare in serie

aprobare in paralel

informare/distribuire in serie

informare/distribuire in paralel.

ANANERN
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In fereastra de pornire a fluxului de lucru ad-hoc se completeaza utilizatorul/utilizatorii care trebuie sa primeasca
sarcina si instructiuni specifice, daca este cazul. Se poate seta un timp de rezolvare pentru rezolvarea sarcinii prin
setarea unui termen limita, cu completarea persoanei catre care sa se raporteze termenul limita omis, daca este
cazul, In campul Report missed deadline to (Raportati termenul limitd omis la) din fereastra Escalation
management (Gestionare extindere), care se acceseazd prin click pe butonul Escalation management (Gestionare
extindere) din fereastra de pornire a fluxului de lucru ad-hoc.
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Excluderea zilelor nelucratoare se realizeaza din fereastra Escalation management, prin bifarea optiuni Exclude
weekends (Numai zile lucrdtoare).

Pentru a modifica ordinea destinatarilor in fluxurile de lucru ad-hoc seriale, apasati click pe un destinatar si
schimbati-i pozitia utilizand butoanele sus si jos reprezentate de sageti.

Butonul Expand (Extindere) va permite sa vizualizati membri unui grup. Marcati un grup pe care I-ati selectat si
apoi apasati click pe Expand (Extindere). Se pot elimina membri prin click pe pictograma X.
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Butonul Show members (Afisare membri) permite vizualizarea membrilor grupului.

n partea dreaptd a ferestrei de pornire a fluxului de lucru ad-hoc este prezenta optiunea Finish (Terminare). Prin
click pe aceastd optiune, se deschide zona Finish (Terminare) in care se pot realiza setari suplimentare pentru
fluxul de lucru ad-hoc.
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Campul Recipient (Destinatar): utilizati meniul derulant din cdmpul Destinatar pentru a selecta utilizatorul care
trebuie sa fie notificat dupa finalizarea fluxului de lucru ad-hoc.

Campul Success message (Mesaj de reusitd): textul din acest camp este afisat destinatarilor din cdmpul Recipient
(Destinatar), imediat ce fluxul de lucru ad-hoc a fost finalizat. Apare in zona de lucru Tasks (Activitati) a
destinatarului.

Campul Cancellation message (Mesaj de revocare) — doar in cazul fluxurilor de lucru de aprobare: textul din acest
camp este afisat destinatarului setat daca fluxul de lucru ad-hoc a fost anulat. Apare in zona de lucru Tasks
(Activitati) a destinatarului.

Campul End script (Script de terminare): daca este necesar, puteti introduce numele unui script care va fi rulat
cand fluxul de lucru ad-hoc este finalizat.

Optiunea Withdraw the workflow from all users as soon as one user does not approve it (Retrageti fluxul de lucru
de la toti utilizatorii imediat ce unul dintre utilizatori nu-I aproba) este folositd numai pentru fluxuri de lucru ad-
hoc de aprobare paralela. Daca aceasta optiune este activata, toti destinatarii trebuie sa aprobe fluxul de lucru.
Tn caz contrar, fluxul de lucru ad-hoc este anulat complet si sarcina este eliminatd din zona de lucru Tasks
(Activititi) a celorlalti utilizatori selectati. in zona dvs. Tasks (Activitati) siin ecranul de pornire, veti primi mesajul
Neaprobat in My ELO, in sectiunea My recently started workflows (Fluxurile de lucru personal incepute recent).
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Pornire flux de lucru predefinit

Fluxurile de lucru reprezinta procese recurente cu diferite niveluri de complexitate in cadrul companiei
dumneavoastra, adaptata cerintelor dumneavoastra.

Interfata grafica asigurd gestionarea tuturor sabloanelor de fluxuri de lucru predefinite, permitandu-le
utilizatorilor sa versioneze fluxurile de lucru, sa modifice, sa exporte si sa stearga sabloanele de fluxuri de lucru.

Pentru pornirea unui flux de lucru predefinit, mai intai se selecteaza intrarea pentru care doriti sa incepeti un
flux de lucru, iar apoi se apasa click in meniu pe New > Create task > Start workflow (Nou > Creare activitate >
Porniti fluxul de lucru). Urmatorul pas este sa se selecteze din lista sablonul fluxului de lucru dorit pentru pornire.
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Zona Preview (Examinare): in aceasta zona se vizualizeaza pasii individuali ai fluxului de lucru. Nu trebuie sa
configurati setari aditionale pentru ca fluxul de lucru este deja configurat.

Pe langa pasii fluxului de lucru, veti putea editorii si timpul de escaladare pentru pasul fluxului de lucru (zile:
minute: secunde), daca este setat.
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3.2.8.2 Editare fluxuri de lucru

Daca ati fost selectat ca editor intr-un flux de lucru, va aparea fluxul de lucru respectiv in zona dvs. de lucru Tasks
(Activitati). Puteti primi fluxuri de lucru ca utilizator, ca membru al grupului sau ca inlocuitor.

Utilizatorii au posibilitatea de a afisa fluxurile de lucru in functie de diferite criterii.

In meniu apasati click pe Task > x active (Task > x active). Puteti selecta daca doriti sa vizualizati activitati de grup,
activitati de inlocuire sau extinderi (escaladari).

Optiunea Escalations (Extinderi): daca bifati aceasta optiune, se pot vizualiza activitatile pentru care termenul
limita a fost depasit si pentru care ati fost introdus ca utilizator care trebuie instiintat.

Folosind functia Show workflow (Afisare flux de lucru), puteti vedea ce pas are termen limitd depasit.

Veti recunoaste un flux de lucru bazat pe pictograma fluxului de lucru. Un nou flux de lucru este marcat cu un
punct verde si cu font-ul marcat cu bold.

Cand primiti un flux de lucru, aveti urmatoarele optiuni disponibile:

* Functia Show workflow (Afisare flux de lucru)

® Functia Pass Workflow forward (Transmitere flux de lucru mai departe)
® Functia Accept workflow (Acceptare flux de lucru)

e Functia Return workflow (Returnare flux de lucru)

¢ Functia Delegate workflow (Delegare flux de lucru)

¢ Functia Hand off workflow (Predare flux de lucru)

® Functia Postpone workflow (Amdnare flux de lucru)

® Functia Forward workflow prin formular

Functia Show workflow (Afisare flux de lucru)
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Functia Afisare flux de lucru permite vizualizarea detaliilor pentru fluxul de lucru selectat Tn zona de lucru Tasks
(Activitati). Se acceseaza prin apasare click in meniu pe Tasks > Show workflow (Activitati > Afisare flux de lucru).

Patratul albastru din vizualizarea minimizata a fluxului de lucru se poate muta cu mouse-ul pentru a se modifica
automat sectiunea afisata cu diagrama fluxului de lucru, situata in partea din mijloc a ferestrei Show workflow.
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Pentru a obtine mai multe informatii cu privire la setarile nodului, se apdsa click pe nodul dorit din cadrul
diagramei fluxului de lucru.

Functia Pass Workflow forward (Transmitere flux de lucru mai departe)

Aceasta functie se utilizeaza dupa ce ati finalizat sarcina pentru transmiterea fluxului de lucru catre urmatorul
editor.
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Mai intai se selecteaza din zona de lucru Activitati acel flux de lucru care se doreste sa fie transmis mai departe,
iar apoi se apasa click in meniu pe Task > Pass workflow forward (Activitate >Transmitere flux de lucru mai
departe).

Dupa apdsarea pe butonul Transmitere flux de lucru mai departe, se va deschide fereastra Forward workflow in
care se poate redacta un comentariu pentru utilizatorul din urmatorul pas de lucru.

Pagina 163 din 337



Butonul Transmitere flux de lucru mai departe poate fi inactiv din doua motive:
1. Ati primit fluxul de lucru ca parte a unui grup. Tn acest caz, trebuie si-l acceptati mai intai selectand
fluxul si apoi apasand click in meniu pe Task > Accept workflow (Activitate > Acceptare flux de lucru).

2. Fluxul de lucru contine un formular. Veti vedea formularul in panoul de vizualizare din mijlocul
ferestrei Tasks (Activititi). In acest caz, redirectionati fluxul de lucru ficand click pe butonul din
formular.

Functia Accept workflow (Acceptare flux de lucru)

Pagina 164 din 337



Daca ati primit un flux de lucru ca parte a unui grup, trebuie sa il acceptati inainte de a-I putea procesa si
transmite. Acest lucru previne situatia in care fluxul de lucru este procesat de mai multi utilizatori simultan.
Mai intai se selecteaza fluxul de lucru pe care doriti sa 1l acceptati si apoi in meniu apasati click pe Task > Accept

workflow (Activitate > Acceptare flux de lucru).
Odata ce fluxul de lucru este acceptat, acesta este eliminat din zona de lucru Tasks (Activitati) a celorlalti membri

ai grupului. Utilizati functia Return workflow pentru a anula acceptarea fluxului de lucru.
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Functia Return workflow (Returnare flux de lucru)

Puteti returna un flux de lucru pe care I-ati primit ca membru al grupului si pe care |-ati acceptat cu functia Accept
workflow (Acceptare flux de lucru).

Mai intai se selecteaza fluxul de lucru pe care doriti sa il returnati si apoi Tn meniu se apasa click pe Task > Edit>
Return workflow (Activitate > Editare > Returnare flux de lucru).

Fluxul de lucru va aparea in zona de lucru Tasks (Activitati) a tuturor membrilor grupului catre care fluxul a fost
trimis.

Functia Delegate workflow (Delegare flux de lucru)

Puteti delega un flux de lucru pe care l|-ati primit catre alti utilizatori/grupuri de utilizatori cu functia Delegate
workflow (Delegare flux de lucruy).

Mai Tntai se selecteaza fluxul de lucru pe care doriti sa 1l delegati si apoi in meniu se apasa click pe Task > Edit >
Delegate workflow (Activitate > Editare > Delegare flux de lucruy).
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Tn campul Recipient (Destinatar), puteti selecta un utilizator/grup sau mai multi utilizatori/grupuri. Dac3 selectati
mai multi utilizatori sau grupuri, acestia vor primi fluxul de lucru in ordinea in care apar in lista. Pentru a schimba
ordinea destinatarilor, apasati click pe un destinatar si schimbati-i pozitia folosind sagetile sus si jos.

Optiunea Show members (Afisare membri) permite vizualizarea membrilor grupului setat in campul Recipient

((Destinatar).

Daca este bifata optiunea Notify after processing the node (Notificare dupd procesarea nodului), veti primi o
notificare dupa ce fluxul de lucru este procesat. Acest lucru va ofera posibilitatea de a verifica starea procesarii
fnainte de a se transmite fluxul de lucru mai departe la urmatorul destinatar.
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Tn prezentarea generald a fluxului de lucru din cadrul functiei Show workflow (Afisare flux de lucru), veti fi in
continuare afisat ca editor al pasului dvs. Utilizatorii carora le-ati delegat fluxul de lucru reprezinta un pas
suplimentar in fluxul de lucru.

Functia Hand off workflow (Predare flux de lucru)

Puteti transfera pasul fluxului de lucru altui utilizator sau grup. Spre deosebire de functia Delegare flux de lucru,
va predati in intregime pasul de procesare al fluxului de lucru si nu mai sunteti notificati cu privire la progresul
fluxului de lucru.

Mai Tntai se selecteaza fluxul de lucru pe care doriti sa il predati si apoi Tn meniu se apasa click pe Task > Edit >
Hand off workflow (Activitate > Editare > Predare flux de lucru).

n prezentarea generala a fluxului de lucru din cadrul functiei Show workflow (Afisare flux de lucru), nu mai sunteti
afisat ca editor al pasului dvs., veti fi inlocuit de utilizatorul caruia i-ati predat fluxul de lucru.
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Functia Postpone workflow (Amdnare flux de lucru)

Mai intai se selecteaza fluxul de lucru pe care doriti sa il amanati si apoi in meniu se apasa click pe Task >Edit >
Postpone workflow (Activitate > Editare > Amdnare flux de lucru).
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Aceasta functie va permite sa nu se mai afiseze fluxul de lucru in zona de lucru Tasks (Activitati) panala o anumita
data setata la amanarea fluxului de lucru. Imediat dupa expirarea respectivei date, fluxul de lucru va putea fi din
nou vizualizat in lista de sarcini din Activitati.

Puteti afisa amanarile sau le puteti sterge. Pentru vizualizarea amanarilor fluxurilor de lucru, se utilizeaza functia
Create view (Creare vizualizare) prin click pe View > Create view (Vizualizare > Creare vizualizare) si se bifeaza
optiunea Show postponed workflows (Afisare fluxuri de lucru amdnate).
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Se va crea automat un cadru (tile) in ecranul dvs. de start My ELO, care va duce utilizatorul direct la fluxurile de
lucru amanate din zona de lucru Tasks (Activitati).

Pentru a anula o amanare, aveti nevoie mai intai de crearea vizualizarii cu fluxurile de lucru amanate. Apoi, din
zona de lucru Tasks (Activitati), se selecteaza fluxul de lucru pentru care se doreste anularea amanarii si se apasa
click pe Task > Edit > Cancel postponement (Activitate > Editare > Revocare amdnare).

Functia Forward workflow prin formular printscreen
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3.2.8.3 Creare, editare si stergere reminder (memento)

Reminderele (memento-urile) sunt utilizate ca sa reaminteasca de intrari (foldere sau documente) in ELO. Daca
o intrare in ELO devine relevanta la un moment dat pentru anumiti utilizatori sau grupuri de utilizatori, puteti
crea un memento pentru ei. Intrarea apare in zona de lucru Tasks (Activitati) a utilizatorului/utilizatorilor la
momentul configurat sau putin mai devreme.

Pentru a crea un reminder, se selectecteaza intrarea pentru care doriti sa creati un memento, apoi in meniu se
apasa click pe New > Create task > Reminder (Nou > Creare activitate > Memento).

n fereastra Reminder (Memento) se poate configura reminder-ul.
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Campul Priority (Prioritate): prioritatea este afisatd in prezentarea generald a activitatilor atunci cand un
memento este primit.

Campul Data: selectati data la care trebuie finalizata sarcina. Data va apdrea in prezentarea generald a
activitatilor ca si data a activitatii. in functie de setarile pentru modul in care sunt afisate sarcinile, memento-ul
poate aparea si in zona de lucru Tasks (Activitati) a utilizatorilor selectati in configurarea reminder-ului.

Campul For user/group (Pentru utilizator/grup): Selectati destinatarii memento-ului din meniul derulant.
Pentru a elimina din utilizatorii selectati, apasati click pe pictograma X.

Butonul Show members (Afisare membri): daca ati selectat un grup, prin click pe acest buton se vor afisa membrii
grupului.
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Ora la care memento-ul apare in zona de lucru Tasks (Activitdti) depinde de setarea din User menu [your name]
> Configuration > Display > Task list display options > Show tasks due in the following number of days (meniu
utilizator [numele tdu] > Configurare > Afisare > Optiuni de afisare listd de activitdti > Afisati activitdti de efectuat
in urmdtorul numdr de zile in viitor).
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Editare si stergere reminder (memento)

Va puteti modifica propriile memento-uri dupa ce sunt create, acestea fiind situate Tn zona dvs. de lucru Tasks
(Activitati).

Selectati memento-ul pe care doriti sa il editati, apoi in meniu, apasati click pe Task > Edit > Edit reminder
(Activitate > Editare > Editare memento).
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Daca editati un memento, acesta va aparea in Zona de lucru Tasks (Activitati) si va suprascrie intrarile anterioare
realizate Tn memento.

Mementourile pe care le-ati creat pentru alti utilizatori nu mai pot fi editate. Daca ati creat un memento pentru
dvs. si pentru alti utilizatori si adaugati alti utilizatori, memento-ul lor nu este schimbat. in schimb, noii utilizatori
primesc un nou memento.

Dupa ce au finalizat sarcina, utilizatorii pot sterge memento-ul prin selectarea lui, apoi in meniu, apasa click pe
Organize > Delete (Organizare > Stergere).

3.2.9 Monitorizare modificari

3.29.1 MyELO

Ecranul de start My ELO va informeaza despre modificari in diferite moduri:
e prin Butonul My ELO

e prin numere in cadrele (Tiles) din My ELO

e prin tab-ul News (Stiri)

Butonul My ELO

Daca My ELO Button este evidentiat in verde, inseamna ca utilizatorul are noutati in My ELO:
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Afisare numere in cadrele (tiles) din My ELO

Pentru a avea o imagine de ansamblu asupra modificarilor din ELO, utilizatorul poate seta afisarea numarului de
intrari in cadre (tile-uri) prin click dreapta pe cadrul (tile-ul) dorit sa afiseze numarul de intrari, apoi click pe
Settings (Setdri). Se va deschide fereastra cu setdri unde se bifeaza optiunea Show number of entries (Afisare
numdr de intrdri).
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Cadrele (tile-urile) care au fost fixate pe bara de navigare si care au setata optiunea Show number of entries
(Afisare numdr de intrdri), vor afisa si ele numarul modificarilor.

Tab News (Stiri)

Utilizatorii isi pot configura tab-ul de Stiri din My ELO pentru a beneficia de ele cat mai mult posibil. Pentru mai
multe informatii, consultati capitolele My ELO si Feed.

Se pot realiza diverse setdri pentru feed accesand butonul din partea dreapta a zonei dedicate fluxurilor de
informatii (feed).
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3.2.9.2  Monitorizare intrari

ELO permite monitorizarea modificarilor pentru intrarile selectate (foldere sau documente), din zona de lucru
Arhiva, prin functiile:

¢ Functia de monitorizare a modificarilor

¢ Functia de monitorizare generala

Functia de monitorizare a modificarilor
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Utilizatorii isi pot monitoriza intrarile individuale. Daca s-au realizat modificari pentru intrari monitorizate, veti fi
notificat in zona dvs. de lucru Tasks (Activitati).

Daca monitorizati un folder, primiti o notificare de indata ce alti utilizatori adauga intrari in acest folder.

Daca monitorizati un document, primiti o notificare de indata ce alti utilizatori Tncarca versiuni noi ale
documentului.

Pentru setarea monitorizarii, mai intai selectati intrarea pe care doriti sa o monitorizati, apoi apasati click pe New
> Create task > Monitor changes (Nou > Creare activitate > Monitorizare modificdri).
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Veti recunoaste notificarile privind modificarile pentru intrarile pe care le monitorizati pe baza pictogramei care
reprezinta o camerd, din zona de lucru Tasks (Activitati). Sub numele intrarii, veti vedea textul pe care I-ati
introdus la crearea monitorizarii. Veti vedea, de asemenea, numele utilizatorului care a inregistrat monitorizarea.

Pentru a elimina notificarea din zona de lucru Tasks (Activitati), selectati notificarea, apoi apasati click in meniu,
pe Organize > Delete (Organizare > Stergere).

Functia de monitorizare generala

Pentru a urmari activitatile dvs. de monitorizare, puteti obtine o prezentare generala a acestora prin click in

meniu, pe Organize > Overviews > Monitoring overview (Organizare > Prezentari generale > Prezentare generala
monitorizare).

Se va deschide o fereastra cu toate monitorizarile setate de utilizator. Functiile din caseta de dialog devin active
imediat ce apasati click pe un obiect monitorizat.
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Butonul Go to (Salt la) va duce direct la folderul/documentul monitorizat in Zona de lucru Arhiva.

Butonul Edit monitoring (Editare monitorizare) deschide aceeasi fereastra ca si pentru crearea unei monitorizari,
unde se pot edita detaliile monitorizarii obiectului.
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Butonul End monitoring (Finalizare monitorizare) are ca efect stoparea monitorizarii setate, fara nicio confirmare
suplimentara.

3.2.9.3 Prezentare generala (overview)

Prezentadrile generale va ajutd sa urmariti fluxurile de lucru si obiectele monitorizate. Sunt disponibile
urmatoarele prezentari generale:

e Fluxuri de lucru pentru aceasta intrare (Workflows for this entry)
* Prezentare generala flux de lucru (Workflow overview)

® Prezentare generala monitorizare (Monitoring overview)

Fluxuri de lucru pentru aceasta intrare

Puteti afisa toate fluxurile de lucru incepute pentru o intrare (folder sau document) selectand intrarea ale carei
fluxuri de lucru doriti sa le vizualizati si apoi in meniu, apasati click pe Organize > Overviews > Workflows for this
entry (Organizare > Prezentari generale > Fluxuri de lucru pentru aceasta intrare).
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Setarile din fereastra Fluxuri de lucru pentru aceasta intrare sunt aceleasi cu setarile din cadrul functiei de
prezentare generala a fluxului de lucru.

Prezentare generala flux de lucru

Puteti afisa toate fluxurile de lucru incepute pentru care aveti permisiunea prin click in meniu pe Organize >
Overviews > Workflow overview (Organizare > Prezentare generald > Prezentare generald a fluxului de lucru).
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ELO permite vizualizarea datelor relevante sub forma grafica (diagrama) tabelara si lista.

Fluxurile de lucru sunt afisate sub forma tabelara in partea stanga. Fluxul de lucru selectat este prezentat sub
forma de diagrama in partea dreapta, in care se pot vizualiza nodurile (pasii) fluxului si persoanele care sunt
implicate in flux pe fiecare pas in parte, precum si starea documentului si utilizatorul la care se afla documentul
la un moment dat. Pe fiecare nod in parte sunt marcate data si ora trecerii si a utilizatorului prin nodul respectiv.
Statusul unui nod din diagrama fluxului este indicat prin culori astfel:

e Verde: Nodul din cadrul fluxului a fost finalizat cu success

¢ Albastru: Nod curent, arata nodurile in care fluxul se lucru se regaseste in acest moment
¢ Rosu: Nod escaladat

¢ Gri: Nod viitor

Utilizatorii au posibilitatea sa configureze setdrile pentru afisarea fluxurilor de lucru.
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Pentru a vizualiza statusul unui flux de lucru, exista posibilitatea selectiei uneia dintre optiunile disponibile:
active, finalizate, toate fluxurile, doar cele cu termen limita depasit.

Pentru o viziune mai clara asupra statusului fluxurilor, este permisa cumularea optiunilor de tipul fluxuri de lucru
cu termen limita depasit, cu optiuni precum fluxuri active, finalizate sau toate fluxurile.

Optiunea Passed deadlines only (Numai termene limitd depdsite): afiseaza numai fluxurile de lucru escaladate.
Aceasta optiune poate fi selectatd numai in combinatie cu fluxuri de lucru active, finalizate sau toate fluxurile.

Optiunea pentru selectare utilizatori: puteti selecta un utilizator/grup din meniul derulant. Dupa ce ati selectat
un utilizator/grup, puteti restrange lista selectand optiuni suplimentare de filtrare:

Optiunea Owner (Proprietar): afiseazd numai fluxurile de lucru in care utilizatorul/grupul selectat este
proprietarul.

Optiunea Any node (Orice nod): afiseaza numai fluxurile de lucru in care utilizatorul/grupul selectat este editor
al cel putin un nod.

Optiunea Active node (Nod activ): afiseaza numai fluxurile de lucru in care utilizatorul/grupul selectat este editor
al nodului.

Optiunea from (de la) si to (in): in cdAmpurile from (de la) si to (in), puteti specifica perioada de timp dorits pentru
afisarea fluxului de lucru.

Pentru a obtine mai multe informatii cu privire la setarile nodului, se apdsa click pe nodul dorit din cadrul
diagramei fluxului de lucru.
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Prezentare generala monitorizare

Aceasta functie afiseaza o prezentare generala a monitorizarilor intrarilor in prezent. Se poate vizualiza locatia in
Arhiva a intrarii monitorizate, se pot edita sau finaliza monitorizare. O descriere mai detaliata regasiti in capitolul

1.11.2 Monitorizare intrari - Functia de monitorizare generala.
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3.2.10 Organizare zona de Arhiva

3.2.10.1 Mutare intrari

Mutarea intrarilor (foldere sau documente) este disponibila in zona de lucru Arhiva si se poate realiza prin una
din urmatoarele optiuni:

* Functia Move (Mutare)

¢ Drag-and-drop

Functia Move (Mutare)

Functia Mutare poate fi accesata in douda moduri:

1. Utilizatorul selecteaza folder-ul/documentul pe care doreste sa il mute si prin click dreapta afiseaza
meniul contextual din care selecteaza optiunea Move (Mutare). Va aparea tab-ul Clipboard in care
utilizatorul selecteaza din structura arborescenta folderul destinatie si apasa butonul Move entry
(Mutare intrare).

Daca se selecteaza folder-ul gresit, se poate corecta acest lucru prin click pe folder-ul corect, selectia
folderului fiind schimbata imediat.
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2. Utilizatorul selecteaza folder-ul/documentul pe care doreste sa il mute si apasa click in meniu, pe
Organize > Structure > Move (Organizare > Structurd > Mutare). Va aparea tab-ul Clipboard in care
utilizatorul selecteaza folderul destinatie si apasa butonul Move entry (Mutare intrare).
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Mutare prin drag-and-drop

Pentru mutarea intrarilor prin drag-and-drop, mai intai apasati click pe intrarea pe care doriti sa o mutati si o
trageti cu mouse-ul in folderul destinatie tinand apdsat butonul mouse-ului.
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Se va deschide o fereastra din care se va selecta optiunea Move entry (Mutare intrare).

3.2.10.2 Adaugare referinta

Crearea referintelor pentru intrari (foldere sau documente) este disponibild in zona de lucru Arhiva si se utilizeaza
cand se doresc mai multe pozitii sau locatii ale intrarilor in zona Arhiva. Spre deosebire de mutare, dupa crearea
referintei, intrarea ramane in pozitia initiala si se creeaza referinta in cadrul arhivei.

Addugarea referintei se poate realiza prin una din urmatoarele optiuni:
¢ Functia Reference (Referintd)

¢ Drag-and-drop
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Functia Reference (Referinta)

Utilizatorul selecteaza folder-ul/documentul pentru care doreste sd adauge o referinta si apasa click pe Organize
> Structure > Reference (Organizare > Structurd > Referintd). Va aparea tab-ul Clipboard in care utilizatorul
selecteaza din structura arborescenta folder-ul destinatie in care doreste sa adauge referinta si apasa butonul
Create reference (Creare referinta).

Daca se selecteaza folder-ul gresit, se poate corecta acest lucru prin click pe folder-ul corect, selectia folderului
fiind schimbata imediat.

Adaugare referinta prin drag-and-drop
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Pentru adagarea unei referinte prin drag-and-drop, mai intai apasati click pe intrarea la care doriti sa creati
referinta si o trageti cu mouse-ul in folder-ul destinatie tinand apasat butonul mouse-ului.

Se va deschide o fereastra din care se va selecta optiunea Create reference (Creare referintd).

3.2.10.3 Copiere intrari
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Copierea intrarilor (foldere sau documente) este disponibila in zona de lucru Arhiva si se utilizeaza cand se doresc
aceleati intrari in mai multe pozitii sau locatii din Arhiva. Spre deosebire de referinta, cele doua intrari rezultate
nu sunt legate intre ele dupa copiere, astfel incat ele pot fi editate separat una de alta.

Utilizatorul selecteaza folder-ul/documentul pe care doreste sa il copieze si apasa click pe Organize > Structure >
Copy (Organizare > Structurd > Copiere). Va aparea tab-ul Clipboard in care utilizatorul selecteaza din structura
arborescenta folder-ul destinatie Tn care doreste sa copieze intrarea si apasa butonul Insert copy (Inserare copie).
Daca se selecteaza folder-ul gresit, se poate corecta acest lucru prin click pe folder-ul corect, selectia folderului
fiind schimbata imediat.

Utilizatorul poate modifica copia utilizand butonul Copy Options (Optiuni Copiere).

Optiuni pentru documente copiate intr-un folder selectat:
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Optiuni pentru foldere copiate intr-un folder selectat:

3.2.10.4 Creare legatura pentru intrari

Crearea de legatura intre intrari (foldere sau documente) este disponibila in zona de lucru Arhiva. Utilizand
functia Link (Legdturd), utilizatorii pot ajunge la o intrare prin intermediul altei intrari folosind link-ul sau legatura
creata anterior.

Daca este disponibila o legatura, selectati intrarea si mergeti la intrarea legata prin apasare click pe butonul Go
to (Salt la).
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Functia Legdturd are urmatoarele optiuni pentru conectarea intrarilor:
e Conectati doua intrari
¢ Conectati o intrare cu mai multe intrari

e Conectati mai multe intrari

Conectarea a doua intrari sau a unei intrari cu mai multe intrari

Selectati o intrare pe care doriti sa o conectati cu o alta intrare, apoi in meniu apasati click pe View > Navigation
> Link (Vizualizare > Navigare > Legatura).

n fereastra deschisd apasati click pe cealalt3 intrare si apoi apdsati butonul Add as link (Addugare ca legdturd).
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Conectarea mai multor intrari

1. Selectati intrarea ale carei legaturi doriti sa le legati.

2. Apasati click pe pictograma care afiseaza un lant sau urmati calea View > Navigation > Link (Vizualizare>
Navigare> Link).

Pagina 198 din 337



3. Pentru a marca documentele pe care doriti sa le legati, apasati tasta CTRL si apoi apasati click pe toate
documentele pe care doriti sd le selectati. Daca doriti sa selectati toate documentele sau toate documentele pe
care doriti sa le selectati sunt legate, apasati tasta SHIFT apoi apasati click pe documentele de sus si de jos care
se doresc selectate.

4. Apasati click pe butonul Mesh links (Introducere legdturi in retea).

Toate intrarile sunt legate si pot fi accesate prin pictograma care afiseaza un lant si apoi se apasa pe butonul Go
to > Salt la.
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3.2.11 Desemnare inlocuitor

Pentru a realiza desemnarea unui inlocuitor, din meniul aferent utilizatorului se selecteaza optiunea Assign
substitute (Desemnare inlocuitor).

Se selecteaza inlocuitorul utilizand meniul de tip drop-down in cdmpul Add user/grup (Addugare utilizator/grup).
Se pot desemna unul sau mai multi inlocuitori prin selectarea din lista.

Daca nu este configurata nicio setare pentru un inlocuitor, acesta va avea statusul Incomplete (Incomplet) si de
aceea inlocuitorul nu poate fi folosit.
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Se pot configura diferite setari pentru diferiti inlocuitori prin urmatoarele optiuni:

¢ Perioada: Se poate seta o perioadd sau mai multe perioade in care un alt utilizator devine automat inlocuitor
pentru alta persoana.

¢ Drepturi de inlocuire: Aceasta optiune i acorda drepturi inlocuitorului desemnat pentru a inlocui o persoana.
n acest caz, inlocuitorul trebuie sa activeze si si dezactiveze el inlocuirea.

Perioada: Optiunea Active substitution in this period (Inlocuire activd in aceastd perioadd) activeaza campurile
pentru introducerea perioadei de inlocuire. Daca se debifeaza aceasta optiune, campurile de introducere a
perioadei de Inlocuire sunt dezactivate. Perioadele introduse anterior sunt salvate si pot fi reactivate mai tarziu
prin bifarea optiunii Active substitution in this period.

Se pot defini urmatoarele perioade:
¢ O perioada determinata (cu un inceput si un sfarsit)
¢ O perioada nedeterminata cu inceput

* Mai multe perioade determinate si/sau nelimitate

ELO permite si adagarea orei la data selectata. Ora se introduce dupa data. Exemple:
- 02/22/2022 15:30, unde 02/22/2022 reprezinta data de 22 februarie 2022 si 15:30 reprezinta ora setata.
- 22.02.2022 15:30, unde 22.02.2022 reprezinta data de 22 februarie 2022 si 15:30 reprezinta ora setata.
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Perioadele nu sunt sterse automat, trebuie sterse apasand click pe pictograma X aflata in dreptul perioadei. De
asemenea, dacd s-a setat o perioadd nedeterminata, se poate termina inlocuirea prin stergerea perioadei,
apasand click pe pictograma X, aflata in dreptul perioadei.
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Drepturi de inlocuire: Daca se activeaza optiunea May activate/deactivate outside a scheduled period (Poate
activa/dezactiva), inlocuitorul are permisiunea de a activa/dezactiva nlocuirea. Acest lucru da permisiunea de
inlocui o persoana in general, fara ca acea persoana sa defineasca o perioada pentru inlocuire.

Se pot configura individual cate drepturi se doresc pentru inlocuitori prin utilizarea optiunilor:
e Substitute inherits everything
e Restrict substitution

Avertisment: dacd se activeaza optiunea Substitute inherits everything, inlocuitorul va avea acces la toate
documentele, sarcinile si functiile la care are access persoana inlocuitd. Aceasta include si documentele
personale, sarcini si note pe care doar persoana inlocuita le poate vedea.

Optiunea Substitute inherits everything permite ca inlocuitorul sa mosteneasca toate drepturile, astfel ca acesta
va avea acces la:

e Documente in ELO (inclusiv cele personale)
¢ Fisierele din Intray

e Sarcinile si fluxurile de lucru personale

e Apartenenta la grup si sarcinile de grup

* Note (inclusiv cele personale)

e Functii client.
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Optiunea Restrict substitution permite configurarea drepturilor pentru inlocuitori, fiind disponibile urmatoarele
optiuni:

e Personal tasks and workflows (Activitati si fluxuri de lucru personale): daca se activeaza aceasta optiune,
inlocuitorul poate accesa sarcinile si fluxurile de lucru personale ale persoanei inlocuite, nu cele care s-au
transmis persoanei inlocuite ca membru al unui grup.

e Intray access (Acces la Intray): Daca se activeaza aceastd optiune, inlocuitorul are acces la zona de lucru Intray

e Inherit group membership: se utilizeaza meniul drop-down pentru a se selecta grupurile pentru care se aplica
nlocuirea. Tnlocuitorului i se atribuie drepturi, permisiuni pentru intrari, adnotri, intréri de feed si sarcini de
grup asociate cu grupul setat. Acest lucru permite sa fie creati mai multi inlocuitori pentru aceeasi perioada si li
se aloce permisiuni pentru diferite grupuri. Sunt disponibile pentru selectare numai grupurile care permit
inlocuirea.
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Zona de lucru Intray este disponibila numai in ELO Java Client. Pentru a permite accesul inlocuitorului la
documentele din Intray, documentele trebuie sa fi fost deja salvate pe server. Puteti activa aceasta setare in ELO
Java Client din meniul utilizatorului User menu [your name] > Configuration > Advanced settings > Settings for
the Intray work area > Save Intray on server when logging off.

Daca o persoana este Tnlocuita, se poate observa acest lucru pe baza pictogramei portocalii care afiseaza o
persoana, situata chiar langa meniul utilizatorului. De asemenea se poate vizualiza faptul ca o persoana este
Tnlocuita si numele Tnlocuitorului pe ecranul de pornire My ELO.
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Tnlocuirile nu sunt transmise automat. Aceasta inseamnd ca dacd utilizatorul desemnat ca si inlocuitor
desemneaza la randul lui alt utilizator ca inlocuitor al sau, acesta din urma nu primeste sarcinile, drepturile, care
i se acorda primului utilizator desemnat ca inclocuitor.

Optiunea May forward substitution (Poate redirectiona): prin activarea acestei optiuni, se permite inlocuitorului
desemnat de a transmite Thlocuirea unui alt utilizator. Nici Tn acest caz inlocuirea nu este transmisa automat, ci
utilizatorul trebuie sa redirectioneze in mod activ. Aceasta optiune trebuie utilizata cu precautie pentru a preveni
transmiterea neintentionata a drepturilor in cadrul companiei.
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Acceptarea rolului de inlocuitor

Sunt disponibile urmatoarele optiuni pentru acceptarea inlocuirii:

* Perioada: Un alt utilizator a definit o perioada in care inlocuitorul acceptd automat inlocuirea.

« Drepturi de inlocuire: Un alt utilizator a acordat dreptul pentru a fi inlocuit. in acest caz, trebuie activats
inlocuirea de catre utilizatorul desemnat pentru inlocuire.

Activarea inlocuirii se realizeaza prin apasare click in meniu, pe cel al utilizatorului si apoi din meniul deschis se
apasd pe Accept substitution (Acceptare inlocuire). In fereastra care se va deschide se va putea vizualiza ce
utilizator trebuie Tnlocuit sau ce utilizator este deja inlocuit.
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in partea stangd din cadrul fereastrei Accept substitution (Acceptare inlocuire), in zona | have the right to
substitute for (Am dreptul de inlocuire pentru) se poate vizualiza o prezentare generala a utilizatorilor pentru care
exista permisiunea de a fi inlocuiti.

Tnlocuirile active se recunosc pe baza unei bare de culoare verde aflata in stanga a fotografiei de profil.

Daca se apasa click pe un utilizator din fereastra Accept substitution (Acceptare inlocuire), in partea dreapta a
ferestrei se pot vizualiza permisiunile exacte de inlocuire ale respectivului utilizator, aceste informatii fiind strict
informative, fara a putea fi editate.

Editarea inlocuirilor

Sunt disponibile urmatoarele optiuni:

o Activate/deactivate (Activare/dezactivare): Aceste butoane permit sa activati inlocuiri care sunt in prezent
inactive sau sa dezactivati acele inlocuiri active pe care doriti sa le incheiati.

Aceste butoane sunt disponibile doar daca utilizatorul care a desemnat inlocuitorul i-a oferit dreptul de a activa
si dezactiva singur inlocuirea.

» Forward (Redirectionare): Cu acest buton, se poate redirectiona o inlocuire daca utilizatorul inlocuit a dat acest
drept. Se poate fie sa fie predata complet inlocuirea sau sa fie alocat un inlocuitor suplimentar.
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Daca un utilizator Tnlocuieste alt utilizator, se poate observa acest lucru pe baza pictogramei de culoare albastra
afisdnd o persoand, situata chiar langa meniul utilizatorului. De asemenea se poate vizualiza faptul ca se
inlocuieste un alt utilizator si numele celui inlocuit pe ecranul de pornire My ELO.

3.2.12 Stergere intréri si task-uri pentru monitorizare/remindere

Daca anumite intrari nu sunt vizibile in ELO, nu inseamna neaparat ca au fost sterse permanent.

Utilizatorul cu drepturi in acest sens poate sterge intrari si task-uri de monotorizare sau remindere.

Stergere intrari (foldere sau documente)
Folderele sau documentele pot fi sterse in ELO in doua feluri:
e Functia Delete (Stergere)
e  End of retention period (Terminare perioadd de pdstrare)

Folderele dinamice pot fi sterse ca si un folder obisnuit.

Functia Delete (Stergere)

Prin functia Delete (Stergere) nu se sterg permanent intrarile, ci doar li se atribuie un marcator de stergere si nu
mai sunt afisate in ELO. Nu exista posibilitatea ca un utilizator sa stearga permanent o intrare in ELO Web Client,
stergerea permanenta o poate realiza doar utilizatorul cu rol de administrator. Intrarile sterse pot fi restaurate
pana la momentul in care se sterg permanent de catre administrator.

Pentru stergere se selecteaza mai intai intrarea dorita si se apasa click pe Organize > Delete (Organizare >
Stergere).
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End of retention period (Terminare perioada de pastrare)

n functie de setérile realizate, folderele si documentele sunt mutate automat din ELO imediat ce expird perioada
de pastrare a lor. Informatia pentru perioada de pastrare se completeaza la indosarierea unui document in
fereastra Metadata (Metadate).

Stergere task-uri (activitati) pentru monitorizare sau remindere

Daca utilizatorul nu mai are nevoie de un task (activitate) care se refera la monitorizare sau remindere, acestea
se pot sterge din zona de Activitati.

Task-urile din fluxurile de lucru nu se pot sterge din zona Activitati. Acestea dispar prin transmiterea fluxului de
lucru mai departe.

Pentru a sterge un task, mai intai se selecteaza si apoi se apasa click pe Organize > Delete (Organizare > Stergere).
n acest fel, task-ul este sters permanent din zona de lucru Activitti, intririle la care face referire task-ul
ramanand in arhiva.
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3.2.13 Exportul informatiilor din ELO Web Client

Sunt disponibile mai multe optiuni in ELO pentru exportul intrarilor sau diverse informatii catre alti utilizatori ELO
si catre colegi sau parteneri de afaceri care nu utilizeaza ELO.

3.2.13.1 Transmitere intrari din ELO

Sunt disponibile mai multe optiuni in ELO pentru transmiterea intrarilor, informatiilor din ELO:

. Trimitere link ELO
° Creare link extern
° Transmitere document (ELO Web Add-ons)

Trimitere link ELO

Utilizatorii pot trimite un folder sau un document din ELO prin e-mail, fiind nevoie ca destinatarul sa aiba un cont
ELO si access la arhiva electronica pentru a putea deschide link-ul.

Utilizatorul selecteaza intrarea (folder sau document) pe care doreste sa o trimita si apoi apasa click pe butonul
Output > Send as ELO link (lesire > Trimitere ca legdturd ELO). Se va deschide automat un nou e-mail care va
avea ca subiect numele scurt al documentului/folder-ului. Destinatarul poate deschide locatia unde se afla
documentul/folder-ul in ELO Web Client prin link-ul ELO primit prin e-mail.

Pe langa link-ul catre ELO Web Client, e-mailul include si un link catre ELO Java Client.
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Creare link extern

Utilizatorul poate trimite prin e-mail un folder sau document din ELO, fara sa fie nevoie ca destinatarul sa aiba
un cont ELO pentru a putea deschide link-ul.

Utilizatorul selecteaza intrarea (folder sau document) pe care doreste sa o trimita si apoi apasa click pe butonul
Output > External link > Create external link (lesire > Legdturd externd > Creare legdturd externd).

Se va deschide fereastra Create external link (Creare legdturd externd) in care utilizatorul poate seta
disponibilitatea linkului si poate restrictiona numarul de accesari, apoi apasa butonul Create external link (Creare
legaturd externd).
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Se va deschide o fereastra cu link-ul documentului/folder-ului care se poate transmite prin e-mail (Send by e-
mail) sau copia in clipboard (Copy to clipboard).
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3.2.13.2 Export metadate

ELO permite exportul sub forma de fisier CSV pentru metadatele documentelor dintr-un folder, fara sa fie
exportate si documentele. Pentru exportul metadatelor se utilizeaza butonul Export table care este disponibil
doar in modul de vizualizare sub forma de tabel care se seteaza prin click pe butonul View > Table.

Primul pas este sd se selecteze folderul dorit pentru exportul metadatelor, iar apoi se apasa click pe butonul
Contents. Pentru selectarea documentelor a caror metadate se exportd, se apasa tasta CTRL si apoi click pe
documentele dorite pentru exportul metadatelor. Daca se doreste selectarea tuturor documentelor, se apasa
tasta SHIFT si apoi click pe prima si pe ultima intrare. Dupa selectarea documentului, se apasa click pe Output >
Save > Export table (lesire > Salvare > Export tabel).
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Downloads B Q - P

= elo export (1).csv
Open file

3.2.13.3 Printare documente

Utilizatorii au posibilitatea sa printeze documentele direct din ELO prin functia Print document (daca este utilizat
ELO Web Add-ons). Se pot printa documente chiar fara vizualizarea documentului.

Se selecteaza documentul dorit pentru imprimare si apoi se apasa click pe Output > Print document (lesire >
Imprimare document).
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4 Arhivare electronica

Arhiva electronica reprezinta o locatie centralizata in care sunt stocate informatiile referitoare la structura
organizatorica a arhivei (foldere), precum si documentele, indiferent de formatul acestora (electronice sau pe
hartie). Structura este arborescentd, permitandu-se crearea mai multor nivele, functie de modul sau de
preferintele de organizare a informatiei pe care le are compania. Suita ELO ECM permite definirea si
administrarea pentru fiecare element de structura a unui profil personalizat. Atunci cand un document sau un
folder este adaugat in structura de arhiva electronicd, acesta este indexat cu ajutorul cuvintelor-cheie asociate:
autor, data creare, versiune, descriere, tip, stare curenta etc.

n ceea ce priveste tipul de informatie necesara utilizatorului, se pot crea mai multe cdmpuri de indexare. Aceste
campuri se comporta ca o eticheta pentru respectivul element din structurd. Asocierea de cuvinte cheie unui
element al structurii faciliteaza o cdutare ulterioara mai eficienta a.

Organizarea arhivei si a structurii acesteia poate fi stabilita de catre administrator pentru fiecare tip de element
n parte. In arhiva, exista posibilitatea de a naviga Tnainte si fhapoi sau de a merge direct la un anume element.

Sistemul ofera posibilitatea de previzualizare a documentelor salvate, nedepinzand astfel de solutia care a creat
acel document, functionalitatea fiind disponibila pentru formatele standard (PDF, imagini, fisiere de tip Office,
email-uri, etc). Tn orice moment, existd posibilitatea de a defini noi tipuri de elemente de structura, care s
adreseze nevoile companiei. Pentru fiecare tip de element se pot defini mai multe campuri de indexare care
trebuie completate de fiecare data cand se adauga un element de acel tip.

Arhiva electronica ELO este un depozit unic pentru tot continutul stocat (documente scanate, documente
generate electronic, forme electronice, inregistrari, etc). Fisierele stocate in arhiva pot fi in orice format si pot
avea orice dimensiune, nu exista limitari.

Spatiul de lucru este Tmpartit in doud zone. Prima zona, din partea stanga a ecranului, are o structura
arborescentad, pastrand structura fizica a unei arhive. Asadar putem avea: dulapuri, dosare, separatoare de
documente si documente. Un exemplu a unui mod de organizare a structurii de fisiere este prezentat in figura
de maijos:

Figura 4 Structura arhivei de documente
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ELO suportd o mare varietate de continut in format electronic, de la imagini scanate ale documentelor pe hartie,
la documente create cu editoare de text de tip Office (DOC, DOCX, TXT, RTF, etc), foi de calcul tabelar (XLS, XLSX,
etc), prezentari (PPT, PPTX, etc), desene CAD, fisiere video (AVI, MPG, etc), fisiere audio (MP3, WAV, etc), fisiere
grafice (BMP, JPG, GIF, PNG, TIFF, etc), fisiere text (PDF, PDF/A, HTML, etc) si multe altele. Practic orice format
de fisier poate fi stocat.

Organizarea arhivei electronice folosind taxonomii poate fi determinata de catre administrator pentru fiecare tip
de document. De asemenea, utilizatorul cu drept de acces la organizarea arhivei poate adauga structuri ale
arhivei in conformitate cu politicile organizatiei. Este posibild navigarea inainte si inapoi, precum si navigarea la
0 anumita structura din arhiva.

Pentru documentele care sunt arhivate in depozitul ELO, se poate seta o data de expirare de catre utilizatorii cu
drepturi de acces. Dupa ce documentele au expirat se pot sterge sau muta intr-o arhiva de tip offline, functie de
regulile companiei.
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5 Managementul documentelor

5.1 Aspecte generale

Practic orice business si proces administrativimplica un numar mare de documente. Indiferent daca acestea sunt
in format electronic sau pe hartie, documentele contin informatii importante necesare pentru desfasurarea
activitatii. Succesul comercial depinde in mare masurd de un management eficient al documentelor. Cu toate
acestea, chiar Tn acest domeniu exista inca deficiente majore — informatiile sunt incomplete adeseori si dureaza
mult timp sa colectdm ceea ce lipseste din imaginea de ansamblu. Adesea, documentele si informatiile
importante nu sunt accesibile pentru ca au fost stocate de colegi in directoarele personale, in email-uri la care
nu avem acces sau in alte arhive pe care nu le stim. Aceasta aduce munca suplimentara si care nu este necesara
daca se implementeaza un sistem electronic de management al documentelor, asa cum este suita ELO, care
poate remedia astfel de situatii.

Cu doar cateva click-uri de mouse se poate seta o structura partajata de documente, care sa fie disponibila pentru
toata lumea. Evident, este nevoie si de un management al autorizarii eficient care sa controleze accesul la
informatiile confidentiale. Exista inclusiv optiunea de a cripta documentele sensibile cum ar fi dosarele de
personal, rapoartele pentru management, etc. Nu sunt limite pentru modul in care se poate organiza o arhiva
electronica de documente. Aceasta se poate face in mod conventional prin structurarea de directoare si cabinete
sau se pot crea zone de lucru pe echipe, activitati sau probleme.

Beneficiile managementului de documente incep prin consolidarea documentelor care sunt legate de un proces,
indiferent de formatul si originea acestora. Astfel, suita ELO ofera integrare cu o serie de alte aplicatii, cum ar fi
sisteme de tip CAD, ERP, CRM, GIS sau sisteme de management email-uri si produsele Microsoft Office. De
exemplu, o factura primita pe email ca atasament poate fi salvata in arhiva de facturi iar o copie logica a acesteia
sa fie plasata in folderul de proiect corespunzator.

Utilizand indexarea automata prin cuvinte cheie, toti membrii echipei de proiect pot regasi imediat documentele
noi adaugate. Un alt aspect pozitiv este simplitatea de a adauga documente care vin pe hartie prin scanarea
acestora. Prezentt documentelor in arhiva permite utilizatorilor sa navigheze printre fisiere si sa le gestioneze
mai usor. Functionalitatea integrata de vizualizare ajuta utilizatorii sa gaseasca rapid informatiile. Exista o paleta
foarte larga de optiuni prin care utilizatorii pot gestiona documentele pe tot parcursul ciclului de viata al acestora.
Avantejele nu sunt doar pentru munca individuala, cele mai mari beneficii sunt aduse celor care lucreaza in
echipe. Pasii de procesare sunt legati in mod natural si putem avea certitudinea ca lucram cu documentele
originale si nu cu niste copii. Avand un management de versiuni sofisticat, suita ELO asigura lipsa de conflicte
atunci cand se fac mai multe modificdri pe documente si tine loguri care pot arata ce s-a modificat, cand s-a
modificat si de catre cine. Acest lucru face posibila compararea versiunilor noi cu altele mai vechi si accesarea
tuturor versiunilor anterioare in orice moment.

5.2 Gestiunea documentelor

5.2.1 Versionare documente

Suita ELO detine un sistem de management al versiunilor sofisticat, care pastreaza toate versiunle documentelor
stocate in depozitul ELO. Fiecare versiune are propria eticheta si eventual un comentariu.
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Utilizatorul are posibilitatea sa:
- Personalizeze numerele de versiune
- Saadauge un comentariu
- Sa marcheze daca prezenta versiune este sau nu blocata la stergere
- Saajusteze data documentului

Pentru anumite formate de documente, suita ELO permite si compararea versiunilor fisierului.

De asemenea, utilizatorul poate stabili daca o versiune poate fi stearsa sau nu si poate defini masuri de retentie
a fisierelor prin stabilirea unei date de expirare. La expirare, documentele pot fi mutate intr-o alta structura
conform cu regulile interne ale companiei.

Versionarea este disponibila nu doar pentru fisiere dar si pentru informatiile asociate acestora, pentru a putea
determina modificarile realizate de la o versiune la alta.

In zona de Istoric versiuni sunt disponibile informatii cu privire la versiunile existente, editori, data realizarii
modificarilor, de pe ce statie de lucru, ora la care s-au realizat modificarile.

In partea de jos a ferestrei sunt disponibile informatii cu privire la informatiile asociate care au fost modificate.
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De fiecare data cand un document este suprascris, se va crea o noua versiune a acestuia, oferind utilizatorilor
posibilitatea de a se intoarce oricand la o versiune anterioara. ELO ofera suport atat pentru versionare majora
(de ex: 1.0, 2.0), minora (de ex: 1.1, 1.2) precum si pentru ramuri ale versiunilor (de ex: 1.0.1, 2.1.0.1).

Furnizarea unui control al versiunii (istoric versiuni, comparare versiuni, etc) implica si prezenta functionalitatilor
de mai jos:

5.2.2

Blocarea si deblocarea documentelor la editare
Vizualizarea documentelor

Conversie documente in format PDF sau TIFF
Adadugarea de adnotari pe documente

Accesibilitatea si controlul documentelor

Rapoarte de audit

Algoritmi de criptare

Gestionarea intregului ciclu de viata al documentului
Managementul substituentilor

Notificari

Distributie de documente (atat intern cat si in exterior)
Colaborare pe documente

Relationarea documentelor (legaturi intre documente)

Managementul substitutiilor

ELO ECM Suite permite gestionarea substitutiilor utilizatorilor din sistem prin functia de Desemnare inlocuitor.
Utilizatorul sau administratorul sistemului folosesc aceasta functie pentru predarea activitatilor pentru o

perioada de timp in care un angajat se afla in concediu sau este indisponibil.
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Utilizatorul are posibilitatea sa realizeze urmatoarele actiuni:

- Sadesemneze unul sau mai multi inlocuitori prin selectarea din lista ,Selectare utilizator/grup”.

- Saaloce mai multe perioade pentru desemnarea inlocuitorilor in zona ,,Inlocuire activa in aceasta
perioada”.

- Poate adauga un mesaj dedicat pentru inlocuitor

- Poate realiza si actiuni avansate precum sa ii acorde acces la zona sa de Intray si la activitati si fluxuri
de lucru personale

- Daca sa mosteneasca permisiuni sau apartenenta la un anumit grup.

- Sa bifeze daca inlocuitorul va avea dreptul de a accepta sau nu inlocuirea sau daca o va putea
redirectiona catre alt utilizator

Inlocuitorii vor receptiona fluxurile de lucru in zona Activitati.
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5.2.3 Managementul documentelor

Componenta de ,,zi-cu-zi” a managementului documentelor sprijina utilizarea si gestiunea intregului ciclu de viata
al documentelor si proceselor care au legaturd cu acestea. Suita ELO faciliteazd controlul asupra intregii
organizari a ciclului de viata al documentului — creare, protectie, acces si stergere, perioada de pastrare — in
conformitate cu o gama larga de politici de arhivare. Aceste unelte de management documente ajuta la pastrarea
conformitatii cu cerintele legale si cu procedurile interne referitoare la arhivare.

Managementul documentelor acopera toate aspectele procesarii digitale a documentelor: captura, gestiune,
stocare, distributie si pastrare pe termen lung. Aceste proceduri variaza de la captura datelor de pe documentele
pe hartie prin intermediul unui scanner si procesarea documentelor digitale (document management in sensul
mai restrans) si pand la arhivarea pe medii optice de stocare (arhivare pe termen lung). Sistemele de
management documente acopera astfel toate facilitatile necesare acestor proceduri.

Indiferent daca este vorba de copierea, redirectionarea sau cautarea unui document, ELO functioneaza
impecabil, datorita Tnaltei calitati dovedite ale sistemului de arhivare si de management al informatiilor si
documentelor.

5.2.4 Operatii cu documente

Utilizatorii pot realiza diferite operatii cu documentele si directoarele din depozitul de arhiva electronica ELO.

1. Editarea documentelor
2. Mutarea documentelor si a folderelor

Utilizatorii care au drepturi de acces alocate, pot muta elemente de structura si fisiere dintr-o locatie in alta in
arhiva. Utilizand aceasta functie, puteti muta cu usurinta fisiere, versiuni de fisiere, documente, referinte, de la
0 anumita cale a documentului in alta. Cand se realizeaza aceasta mutare, structura de fisiere a elementelor
ramane la fel.
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Mutarea se realizeaza imediat.

3. Copierea documentelor si a folderelor

Utilizatorii care au drepturi de acces alocate, pot copia elemente de structura si fisiere dintr-o locatie in alta in
arhiva. Utilizand aceasta functie, puteti copia cu usurinta fisiere, versiuni de fisiere, documente, referinte de la o
anumita cale a documentului in alta. Cand se realizeaza aceasta copiere, structura de fisiere a elementelor
ramane la fel.

Aceasta actiune permite copierea unui document/folder/ obiect din sistem — dintr-o parte in alta in cadrul
depozitului de arhiva, permitand o serie de criterii. Este posibila:

- copierea intrarii de baza

- copierea structurii de foldere

- copierea structurii de foldere cu documente

Pot fi copiate atat referintele, notele, toate versiunile documentelor si atasarile (inclusiv versiunile atasarilor).

Permisiunile cu privire la documentul/folderul/obiectul din sistem — se pot stabili in functie de necesitati.
Utilizatorul are posibilitatea sa inlocuiasaca permisiunile actuale cu cele ale folderului de destinatie, sa pastreze
permisiunile anterioare nemodificate sau sa inlocuiasca permisiunile preluate de la folderul anterior si sa
pastreze permisiunile individuale — permisiunile pe care intrarea le-a preluat din folderul parinte sunt inlocuite
cu permisiunile din folderul de destinatie. Daca exista permisiuni individuale pentru intrare, care difera de cele
ale folderului parinte, acestea sunt pastrate.

4. Relationarea documentelor - Link

Documentele pot fi relationate intre ele, atunci cand se referd la o tema comuna, la un proiect sau la un client
de exemplu. Legaturile sunt bidirectionale si se realizeaza prin utilizarea optiunii “Legatura” (Link).

Legatura X
E 83436467_1256865101356636_6811069140699" | =3 Salt la ‘
B clo wallpaper | < Deschidere in modul doar in citire ‘
° | @ Legturs permanent3 ‘
| % Eliminare ‘
14 »
@  Testare // Test monitoring // elo wallpaper Revocare ‘

5. Documente din sabloane

ELO va ofera posibilitatea permanenta de a utiliza documente (de ex: documente Office) pe post de sabloane, pe
baza carora se pot crea alte documente. Puteti defini singuri sabloanele de documente, pe care apoi le puteti
salva intr-o zona dedicata din arhiva electronica si utiliza prin intermediul butonului “Document din sablon”.
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Se va deschide o fereastra de dialog care ii permite utilizatorului sa selecteze un document din structura de
arhiva, din folderul dedicat, pe care sa il utilizeze ca template. Templateul va fi deschis pentru editare in aplicatia
in care a fost creat (ex. Fisierele office se deschid in Word, Excel, functie de aplicatia utilizata la definirea
documentului de tip template). Tn acest fel se va crea un document nou pornind de la sablonul selectat. Dupa
editare — documentul va fi salvat si check-in in arhiva.

6. Documente din sabloane, cu informatii precompletate

Se acceseaza tabul Contract / Create document:

Se selecteaza sablonul care va fi utilizat si care cuprinde configurarile necesare si placeholderele:
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Se deschide o fereastra care permite anexarea unor informatii. In tabul additional information sunt metadatele
deja existente in sistem cu privire la documentul nou creat. Se apasa OK.

Documentul nou se regaseste in structura de care apartine. Sistemul va solicita deschiderea fisierului word
pentru editare suplimentara.

Documentul nou va cuprinde valorile atributelor generice/specifice asociate.

5.2.5 Adnotare documente

ELO permite utilizatorilor adaugarea adnotarilor pe documente. Acestea pot fi in forma notitelor (care pot fi
personale, permanente sau generale), a stampilelor pe documente (Stampilele se pot pune sub forma de text
sau imagine), sticky notes (post-it-uri) pe document, markere de culori si dimensiuni diferite, note direct pe
document, etc. Utilizatorul are posibilitatea din interfata sa vizualizeze documentul ca original sau cu adnotarile
atasate. Suplimentar, functiile puternice de cautare permit realizarea actiunii de cautare si in textul adnotarilor
pe document.

1. Notite: Acestea se pot asocia tuturor tipurilor de documente din sistem. Utilizatorul poate selecta tipul

de notita dorita:
- Nota de margine generala — aceste tipuri de notite pot fi create si editate de catre toti utilizatorii.
- Nota de margine personala — doar creatorul acestei notite poate edita si vizualiza acest tip de notita
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Nota de margine permanenta — odata definite, aceste tipuri de notite nu mai pot fi editate sau sterse.

« preview » |[[]

Documentfolder Keywording Farm Full
A A ab |5
sdsdsd

© New_.» [J) General margin note
E§1 m Personal margin note
test 1 lﬂ Permanent margin note
test1
test 1

Sticky notes: similare post-it-urilor de hartie. Utilizatorul are posibilitatea de a alege culoarea post-it-
ului si aplicarea acestuia in zona dorita.

Stampile: Exista o serie de stampile definite deja de sistem. La accesarea optiunii de prezentare
generala marcaje — utilizatorul are posibilitatea sa vizualizeze stampilele existente, sa le editeze, sa le
stearga sau sa adauge altele noi.

RO .. 8-

| 5_34 Stamps overview

Approved
Booked
Canceled
Checked
Clarification necessary
Completed
Copy
Credit
Forwarded
Paid
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4. Markere: similare aplicarii markerului pe hartie. Utilizatorul are posibilitatea de a alege culoarea
markerului si aplicarea acestuia in zona dorita.

5. Note de tip text: similare notitelor, cu diferenta ca se aplica asupra documentului.

Pagina 228 din 337



5.2.6  Suport pentru arhivare fizica

Nomenclator arhivistic

Fizic, nomenclatorul arhivistic este documentul ce sta la baza organizarii fondului arhivistic, fiind constituit pe
baza organigramei companiei / institutiei dumneavoastra. El precizeaza tipul documentelor create si termenele
de pastrare ale acestora, generand indicativele necesare identificarii categoriilor parentale de documente in

cadrul inventarelor arhivei.
Nomenclatorul arhivistic transpus in mediul ELO reprezinta zona de Formualare de indexare/tipuri de
documente, ce poate fi accesata din consola de administrare.

Toate formularele de indexare/tipurile de documente din institutie se regasesc in lista ce poate fi consultata si
vizualizata in partea stanga a ecranului:
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Selectia unei intrari din lista permite definirea caracteristicilor formularului de indexare/tipului de document
respectiv. Perioada de pastrare se poate configura in sectiunea Entry options din cadrul fiecarui formular de
indexare/tip de document in parte.

Toate documentele noi adaugate in sistem poarta cu sine unul din formularele de indexare/tipul de document
din aceasta lista.

Lista poate fi printata sub forma unui raport centralizat prin apelarea optiunii de tiparire. Administratorul de
sistem are posibilitatea sa selecteze tipurile de informatii cuprinse in acest raport:

Actualizarea nomenclatorului arhivistic poate fi realizata prin modificarea formularelor de indexare/tipurilor de
documente din aceasta zona.
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Suplimentar, este disponibila optiunea de definire nomenclatoare sub forma listelor de indexare.

Acestea se pot defini in cadrul consolei de administrare, se pot actualiza in orice moment iar listele rezultate pot
fi utilizate in sistem pentru indexarea informatiei in mod standardizat:

Alocarea nomenclatorului se realizeaza din zona de designer formulare:

Modul in care este vizualizat nomenclatorul de catre utilizator:
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Indicarea unei clase din nomenclatorul arhivistic

Sistemul permite ca la incarcarea unui document nou in sistem, sa poata fi indicata o clasa din nomenclatorul
arhivistic in care se incadreaza tipul de document nou definit.

Acest lucru se poate realiza prin modalitati multiple, printre care enumeram:

Codificarea numelui formularelor de indexare/tipurilor de documente in momentul definirii acestora
in consola de administrare: exemplu pentru formularul de indexare/tipul de document ,Document de
intrare” — numele acestuia sa fie REGISTRATURA_DOCUMENT DE INTRARE. Astfel, in momentul in care
se doreste identificarea si listarea documentelor dintr-o anumita clasa, administratorul are
posibilitatea ca in consola de administrare in zona dedicata definirii formularelor de indexare, in
campul de cautare al formularelor de indexare, sa caute clasa respectiva. Rezultatele vor afisa doar
documentele din clasa respectiva.

In consola de administrare, in zona dedicata campurilor de indexare — se poate defini un camp cu
privire la clasa documentelor. O lista de indexare (nomenclator) pentru clasa — va putea fi asociata
acestui camp.

Campul va putea fi alocat in cadrul formularelor de indexare/tipurilor de documente. In momentul
adaugarii unui document in sistem, formularul de indexare asociat va cuprinde informatia cu privire la
clasa documentului.

Aplicarea marcajelor de retentie asupra documentelor

ELO ECM Suite permite aplicarea marcajelor de retentie asupra documentelor pentru a fi exceptate de la procesul
de distrugere impus de nomenclatorul arhivistic la expirarea termenului de pastrare.

Retentia documentelor este realizata prin configurarea functionalitatilor prezentate anterior:
,Sfarsitul perioadei de stergere” alaturi de campul ,,sfarsitul perioadei de retentie”. Prin setarea
informatiilor corespunzatoare in aceste campuri, documentele care au asociate mastile de
indexare/tipuri de documente respective vor fi marcate logic in sistem cu informatia de retentie
necesara astfel incat sa nu fie sterse automat de procesele de stergere/distrugere (procese care pot fi
configurate prin diverse fluxuri, reguli de as).

Daca se doreste marcarea vizuala a documentelor electronice cu informatia cu privire la retentie, se
pot realiza configurari in sistem astfel incat informatia sa fie disponibila ca o nota in sistem (aplicabila
pe document in forma electronica vizibila doar in aplicatie, nu si la scoaterea documentului din sistem)
sau direct in document prin configurari specifice.
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53 ELO Colaborare

Tn contextul procesérii documentelor electronice, colaborarea este un element foarte important si se referd la o
serie de functionalitati necesare pentru a sprijini cooperarea descentralizata, asistata de calculator, in cadrul si
intre echipele de lucru. Adesea, o sarcina de lucru este rezolvata de mai multe persoane, nu doar un singur om,
care se pot afla in locatii diferite si care pot lucra la momente diferite de timp. Prin instrumentele puse la
dispozitie, suita ELO fsi propune sa sprijine echipele de lucru si colaborarea intre angajatii cu diverse roluri si
sarcini in cadrul proceselor companiei. Functiile pentru colaborare din suita ELO au fost create pornind de la
ideea ca nu numai documentele si continutul acestora sunt importante, dar si purtatorii de informatie, adica
angajatii sunt importanti. Acestia detin informatii despre documente, iau decizii, discuta pe baza documentelor,
iar transparenta si trasabilitatea proceselor este cruciala.

Colaborarea in suita ELO include o serie de instrumente, printre care enumeram: MyELO, ELO Feed (Fluxul de
informatii ELO sau Forumul ELO) si Colaborare (co-editare).

5.3.1 MyELO

Numeroasele avantaje ale uneltelor de colaborare ELO sunt evidente in zona de lucru MyELO, care formeaza un
hub de informatii pentru toti utilizatorii. in aceasts zona sunt agregate informatii cu privire la documente, postari
si comentarii relevante pentru ei, totul intr-o maniera clara si structurata. Nu are importanta daca acestea sunt
documentele la care utilizatorul a subscris pentru a le urmari, sau daca utilizatorul a fost mentionat intr-o discutie
pe fluxul de informatii aferent unui document sau daca este vorba de sarcinile de pe un flux de lucru.

Posturile sunt afisate in ordine cronologica (cele mai noi sunt primele). Acestea sunt grupate si afisate pe baza
optiunilor de filtrare, dupa data, formular de indexare, tip, hashtag, etc. Centrul de informatii este actualizat cu
doar un singur click al mouse-ului. Utilizatorii au posibilitatea sa marcheze anumite documente si informatii ca
fiind importante, pot renunta la subscriere sau pot sterge din MyELO informatiile si documentele care nu mai
sunt relevante pentru ei.
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in plus fata de optiunile de filtrare a documentelor si informatiilor disponibile utilizatorilor, mai existd o
functionalitate importanta, cea de vizualizare a celor mai recente activitati din fluxurile de lucru pe care acestia
sunt implicati. Mai mult, se pot vizualiza fluxurile care au fost escaladate, adica cele pentru care s-au depdsit
termenele limita, acum fiind posibild o accesare rapida pentru rezolvarea acestora.

Un click pe fluxul de lucru respectiv deschide sarcina de lucru impreuna cu actiunile pe care utilizatorul trebuie
sa le realizeze, cum ar fi o aprobare sau o distributie. Aceasta permite automatizarea proceselor. Accesul rapid
la sarcinile de lucru este esential pentru un management eficient al sarcinilor si reprezintd o componenta
importanta a hub-ului de informatii MyELO.

In My ELO este disponibil inclusiv un hashtag cloud cu ultimele hashtaguri utilizate in sistem.

5.3.2 ELO Feed

ELO Feed are un obiectiv diferit de celelalte aplicatii sociale pe care le utilizam zilnic. Postarile utilizatorilor,
intrarile generate de fluxurile de lucru si evenimentele de sistem sunt toate salvate in fluxul de informatii. Aceste
evenimente de sistem includ, de exemplu, actiuni cum ar fi addugarea documentelor si versiunilor noi de
documente, modificari de stare a documentelor, evenimente care apar in fluxurile de lucru (informari, aprobari,
etc). Aceste evenimente nu trebuie inregistrate in mod activ de catre utilizatori, ci sunt inregistrate si adaugate
automat de sistem. Tn general, cerintele organizatorice ale unei companii determind modul de utilizare si
continutul fluxului de informatii din ELO Feed, deci implicit si modul de colaborare in cadrul organizatiei.

ELO Feed ofera utilizatorilor o platforma pentru schimbul de informatii si documente intr-un format asemanator
unui chat sau a unui forum de discutii. Utilizatorii pot crea posturi, pot mentiona colegi, pot lega documente, pot
adauga hashtag-uri. Se poate discuta pe un document in mod direct folosind functia de adaugare comentariu.
Astfel, ELO Feed prezinta in mod cronologic, un istoric complet al tuturor discutiilor si evenimentelor asociate
unui document sau unui folder.

Avem posibilitatea sa realizam actiuni precum:

o Mentionam colegi in comentariul nostru — cu @: ELO Feed ofera utilizatorilor posibilitatea de
a inregistra mesajele, instructiuni si notite importante pe document, adresate anumitor utilizatori prin
mentionarea acestora. Aceste informatii sunt mentinute pe parcursul inregului ciclu de viata al
documentelor si sunt legate de acestea
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. Se facem o referire la un document din sistem

. Sa inseram un hashtag care permite o filtrare ulterioara a comentariilor in functie de prezenta
acelui hashtag. Inserarea se realizeaza prin tastarea unui hashtag nou sau alegerea unui hashtag
preexistent din lista.
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o Sa restrictionam vizibilitatea comentariului astfel incat doar unul sau anumite grupuri de
utilizatori sa aiba posibilitatea de a vedea aceasta postare. Este disponibila inclusiv optiunea de a retine
vizibilitatea selectata pentru comentariile ulterioare.

. Sa ne abonam la un flux de comentarii: astfel vom primiin zona de lucru MyELO toate noutatile
cu privire la comentariile postate pentru subiectul/documentul/obiectul din sistem la care ne-am
abonat

o Comentariul se creeaza prin apasarea butonului Creare

Alte functionalitati disponibile in ELO feed:
- Comunicare Live pentru un transfer rapid al informatiei
- Creare sondaje in ELO feed.
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Optiunea de sondaj in ELO feed.

n ceea ce priveste continutul si structura ELO Feed, existd doud niveluri diferite — post&ri si comentarii.
Postarile sunt la nivelul superior, iar comentariile la nivelul inferior si se refera intotdeauna la un post,
asa cum se poate vedea si in imaginea de mai jos:

ELO Feed ofera utilizatorilor atat posibilitatea de a inregistra metadatele documentelor, cat si
mesajele, instructiunile si notitele importante. Aceste informatii sunt mentinute pe parcursul
intregului ciclu de viata al documentelor si sunt legate de acestea si se pot realiza cautari in cadrul
acestora.
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6 Cautarea documentelor

6.1 ELO iSearch

Cu o crestere de 30% a volumului datelor nestructurate aflate in sistemele informationale, regasirea datelor si a
documentelor relevante devine o activitate din ce in ce mai dificila. Dispunand de tehnologia integrata
»Elasticsearch”, ELO iSearch reprezinta solutia ideala pentru aceasta provocare.

Tehnologia sa moderna de cdautare combina o gama larga de optiuni, cum ar fi cautarea fulltext, cautarea in
metadate sau cautarea directa intr-o structura de arhivare ierarhica. Drept urmare, utilizatorul beneficiaza pe
deplin de capabilitdtile intregii infrastructuri IT. Actiunea de cautare ia in considerare fiabilitatea sistemului,
redundanta, scalabilitatea si viteza de regasire a informatiei. Cu toti acesti factori la indemana, precum si cu
capacitatea sa multilingva de cautare si utilizarea termenilor specifici industriei, ELO iSearch stabileste un
standard nalt, deschizénd un capitol complet nou in gasirea informatiei relevante pentru companie.

ELO ECM Suite ofera o solutie eficienta pentru preluarea informatiilor si localizarea rezultatelor relevante, chiar
daca avem in vedere volume mari de date. Cele mai importante potriviri se gasesc rapid si convenabil.

Ne petrecem o parte considerabild a timpului la serviciu cautand informatii si documente in fiecare zi. Acest timp
ar putea fi alocat unor sarcini mai utile. Cautarea informatiilor este un factor ce influenteaza major costurile.

Diversele functii de cautare disponibile va asigurad faptul cd puteti accesa documentele de care aveti nevoie,
precum si informatiile relevante din orice aplicatii integrate de la terti, cum ar fi ERP, CRM sau sisteme de e-mail.
ELO iSearch va ajuta sa gasiti informatii mai rapid completand automat termenii cautati pe masura ce introduceti
caractere in campul de cautare, corectand erori de scriere sau prin realizarea cautarilor de termeni similari sau
Tnruditi.

n plus, atunci cand ciutati ,,contract”, ELO iSearch v& va sugera si sinonime ale termenului cautat. Chiar daca
cdutarea nu returneaza un termen unic, ELO iSearch va ofera rezultatele dorite, sugerand termeni care au
legatura cu interogarea initiala. Dictionare inteligente impart cuvintele compuse precum ,polita de asigurare” in
formele lor de baza. Cuvintele pot fi si ele convertite inapoi la forma lor radacina, astfel incat nu mai trebuie sa
va faceti griji cu privire la pluralul termenilor sau forme compuse la introducerea termenilor de cautare. Motorul
de cautare face acest lucru in fundal.

Daca utilizatorul introduce ,,poliitca” in loc de ,politica”, ELO iSearch afiseaza mesajul: ,Vrei sa spui politica?"
Aceste sisteme inteligente de asistenta preiau erorile de tastare, imbunatatind rezultatele cautarii sau, in unele
cazuri, sa se asigure ca exista rezultate.

Interogdrile de cautare folosind instrumente de cautare structurate pentru metadate sunt adesea foarte precise
si foarte specifice. Cautarea unui numar de factura, contract sau cotatie in intregul depozit produce rapid si
rezultate de incredere.

O alta provocare este salvarea interogarilor de cautare utilizate frecvent, recurente sau complexe cu optiuni de
filtrare complicate si posibilitatea de a le aplica rapid si convenabil, dupa cum este necesar. Butoanele de
accesare rapida (tiles) introduse in cadrul versiunilor anterioare, pentru salvarea si gestionarea optiunilor de
cautare favorite ofera solutia perfectd pentru aceasta problema.

Programul va ofera numeroase modalitati de a gasi rapid ceea ce cautati, date, documente, chiar si in cazul unor
volume mari de date, in momentul in care se face filtrarea acestora. ELO oferd, de asemenea, diverse optiuni de
restrictionare a intervalului de cautare astfel incat plaja de rezultate sa fie una cat mai exacta.

6.1.1Arhitectura ELO iSearch
a. Elasticsearch
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Elasticsearch este un motor de cdutare open source distribuit, foarte scalabil, bazat pe Apache Lucene, care
permite utilizatorilor sa salveze volume mari de date si sa efectueze cautari extrem de rapide. Comunicarea de
desfasoara printr-o interfata web RESTful. Pentru detalierea Elasticsearch se poate consulta informatia
disponibila pe pagina oficiala: https://www.elastic.co/guide/en/elasticsearch/reference/current/index.html

b. Lucene

Elasticsearch foloseste Apache Lucene ca biblioteca principala. Cu Elasticsearch, fiecare index poate fi divizat Tn
mai multe parti (denumite ,shards”). Un shard corespunde unui singur indice Lucene, care consta dintr-un folder
care contine fisierele index asociate.

Shard-urile pot fi distribuite pe mai multe servere (noduri). De asemenea, pot fi definite replici. Acestea formeaza
un cluster.

Exemplu: alocarea Elasticsearch in clustere, noduri, replici si shards.

c. Suport din punct de vedere al limbii

Cdutarea Elastic foloseste propriile analizoare de limba atat in timpul indexarii, cat si al cautarilor, optimizand
regulile si modelele de cautare specifice limbii. In ELO limba depozitului de arhiva (selectata in timpul instalarii
sistemului) are o influenta majora asupra procesului de cautare.

Elasticsearch in ELO ofera suport pentru urmatoarele limbi: germana, engleza, franceza, spaniola, italiana,
portugheza, araba, daneza, suedeza, poloneza, olandeza, ceha, maghiara, romana si turca.

d. Procesarea cu ELO

Graficul urmator ilustreaza un model simplificat de procesare cu ELO.

ELO Indexserver transfera datele catre Elasticsearch, care utilizeaza propriul analizor de limba atat in timpul
indexarii, cat si in timpul procedurii de cdutare. Datele indexului sunt salvate in indici Lucene.

Cautarea Tn indexuri necesita acces la:
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e Fisierele index

e O baza de date Lucene consistenta

e Un analizor functional de limbaj Elasticsearch
e Un ELO Indexserver care ruleaza (ELOix).

e. Securitate

Comunicarea dintre ELO Indexserver (ELOix) si Elasticsearch este criptata (SSL) utilizand plug-in-ul ,Search
Guard”.

f.  Optiuni de interfata

Pentru zona de lucru cautare: este posibila setarea numarului de rezultate care sa se afiseze pe fiecare pagina
de rezultate la cautare. Utilizatorul poate vizualiza toate rezultatele, indiferent de aceasta setare, deruland
paginile inainte si inapoi.

Procesul de indexare implica transferul de informatii relevante dintr-un document catre baza de date fulltext.
Dupa aceea, fiecare cuvant dintr-un document primeste o valoare de indexare. Valorile sunt structurate pe plan
intern astfel incat orice cuvant care face parte dintr-un sir de cautare sa fie localizat repede de catre procesul de
cautare.

Baza de date fulltext se asigura ca functia de cautare a sistemului este intotdeauna rapida si de incredere, chiar
si atunci cand este folosita pentru un volum mare de documente sau informatie stocata. Un exemplu despre cum
functioneaza acest modul este prezentat in imaginea de mai jos:
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Indexare full text automata a documentelor

Exemplu: Document scanat

Pas 1: Documentul este scanat utilizand functionalitatea de OCR

Pas 2: Indecsii full text sunt compilati si introdusi in baza de date

Fulltext Databass

| E— —
j— Waughan Docd, Dod2
\\ _ introduse in baza de date
- “aughan s Painter,.....
o Fointer,.....
—/
the, in, on, g
Cuvintele siruriledec tere mai

mici de 3 caractere sunt sterse

Cand exista atribute structurate ale documentelor, cautdrile sunt de obicei foarte precise si specifice. Cautarea
unei facturi, contract sau document dupa un numar de inregistrare in toata arhiva functioneaza rapid si corect.

Dar de multe ori se intampla ca utilizatorul care cautd informatii sa nu fie 100% sigur referitor la ce cauta. Acest
tip de cautare este, de multe ori, consumator mare de timp.

Sistemul are o interfata standard de cdautare a documentelor pe baza unor criterii diverse (nume document, data
crearii, cuvinte cheie, diverse metadate, etc.). Utilizatorul poate sa restranga cdutarea la anumite zone de arhiva
separate logic. Acest lucru va asigura accesul utilizatorului la acele documente din cadrul arhivei (intreaga arhiva
sau sectiuni de arhiva) la care are dreptul, pe baza drepturilor de acces definite in sistem, in concordanta cu rolul
acestuia in cadrul companiei.

Exemplu de interfata de cautare din clientul web al ELO ECM Suite:
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6.1.2Sugestii de completare

Functia de sugestii de completare ofera o listd de posibili termeni de cdutare care se potrivesc cu secventa de
caractere deja introdusa. Cu cat termenul introdus este mai lung, cu atat sugestiile sunt mai exacte. ELO iSearch

sugereaza termeni pentru cautarea in ELO. Daca nu apar sugestii, nu exista potriviri pentru sirul de caractere
introdus.

6.1.3Functia de corectare

Corectarea ofera de fapt sugestii pentru termenii de cautare la care aveti rezultate foarte putine sau deloc. Acest
lucru poate fi util mai ales daca ati facut o greseala de tastare la introducerea termenului de cdutare. Daca acesta
este cazul, ELO va sugera termeni similari. Un mesaj apare sub cdmpul de cautare: ,Ati vrut sa spuneti...” urmat
de sugestiile generate de ELO.

Faceti clic pe unul dintre termenii sugerati pentru a afisa rezultatele cautarii termenul ales.
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6.1.4Functii si instrumente de cautare:

Functia de cautare booleana
Este o forma de cautare complexa care permite o formula de interogare pentru cautare folosind operatorii AND
si OR.
AND cauta potriviri care contin ambii termeni.
Operatorii pentru o cautare AND sunt:
e« Sl
e &&
Atentie: conexiunea AND este activata in mod implicit. Daca introduci mai mult de un termen, acestia sunt
legati automat cu Sl cu exceptia cazului in care utilizati alt operator.
SAU cauta potriviri care contin cel putin unul dintre termeni.
Operatorii pentru o cautare SAU sunt:
e SAU

°
’

Exemplu: comanda, factura
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Paranteze

Puteti utiliza parantezele logice pentru a introduce o cautare alternativa. Parantezele logice determina ce
termeni trebuie cautati in plus fata de termenul de cautare principal.

De exemplu, in situatia in care cautati o facturd, dar nu sunteti sigur daca documentul a fost arhivat ca factura

sau chitanta - in acest caz, introduceti termenul care ar trebui folosit primul pentru cautare si apoi adaugati
intre paranteze cele doua alternative de cautare. Exemplu: factura (factura, chitanta).

Excluderea termenilor

In procesul de cautare, ELO iSearch permite excluderea anumitor termeni de cautare. Termenul pe care doriti sa
il excludeti trebuie sa fie separat de termenul de cautare principal printr-un spatiu si o cratima (-). De exemplu,
daca cautati termenul factura si excludeti termenul de chitanta, trebuie sa introduceti urmatoarea comanda de
cautare: factura -chitanta.
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Cautare de expresii

Cautarea de expresii functioneaza cu grupuri de cuvinte care sunt conectate. Aceasta poate fi o expresie fixa, de
ex. ,introduction ecm”. Poate fi, de asemenea, oricare succesiune de cuvinte. Expresia cautata trebuie plasata in
interiorul ghilimelelor. De exemplu, daca doriti sa gasiti toate documentele cu combinatia de cuvinte introduction
ecm, tastati urmatoarea expresie: ,introduction ecm”.

Cautare interval

Cdutarea interval va permite sa limitati cautarea la un anumit interval. Acest lucru face cautarea mai rapida si
creste semnificativ precizia rezultatelor. Trebuie sa introduceti intervalul intre paranteze drepte si sa le separati
cu TO. De exemplu, doriti sa cautati in toate folderele din intervalul 03 la 05. Introduceti comanda de cdutare [03
TO 05].

Atentie! Cdutdrile in ELO iSearch nu fac distinctie intre majuscule si minuscule.

Sinonime

ELO iSearch ofera alternative (sinonime) pentru multi termeni. ELO iSearch sugereaza sinonime corespunzatoare,
daca sunt disponibile. Pentru a adauga un sinonim la o cautare, faceti clic pe sugestia dorita.
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Text rezultate

Este afisata o previzualizare a textului fulltext al documentelor gasite de iSearch in coloana de text Rezultate.
Potrivirile sunt evidentiate.

Atentie! Pentru a utiliza componenta de text Rezultate, trebuie sd o activati optiunea de text Rezultate din Meniu
> Meniul utilizator [numele tdu] > Configurare > Afisare > Cdutare. Optiunea poate fi activata de catre
administratorul sistemului la nivel individual — pentru un utilizator sau la nivel general — pentru un grup de
utilizatori.

Evidentiere integrala text

Dupa realizarea unei cautari in cuprinsul fulltext al unui document, rezultatele din cadrul documentului sunt
evidentiate in previzualizarea textului integral.
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In situatia in care documentul contine mai multe potriviri, puteti sari inapoi si apoi intre potriviri in textul complet
folosind butoanele , Afiseaza urmatorul rezultat” (sageata indreptata in jos) si ,Afisati rezultatul anterior (sageata
indreptata in sus).

Filtre
ELO iSearch va permite sa setati filtre pentru a rafina cautarea. Puteti accesa filtrele din Meniu > Cautare >
Filtre.
ELO iSearch ofera urmatoarele filtre:
¢ Formular metadate: filtreaza rezultatele cautarii dupa metadatele selectate/forma.
e Tip intrare: filtreaza rezultatele cautarii dupa tipul de intrare selectat (de exemplu, folder, document
imagine, document Word).
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e Data: filtreaza rezultatele cautarii dupa data documentului selectat.

e Indosariat de: Filtreaza rezultatele cautarii in functie de utilizatorul care a realizat indosarierea in
sistem.

e Toate campurile: Permite utilizatorului sa caute n toate campurile.

e Selectare camp: Permite utilizatorului sa caute un cdmp dintr-un formular de indexare.

*  Feed: permite utilizatorului sa caute in postari si hashtag-uri din zona de comunicare ELO feed.

e Editor: filtreaza rezultatele cautarii in functie de utilizatorul selectat ca editor in caseta de dialog din
formularul de indexare.

e Dataindosariere: filtreaza rezultatele cautarii in functie de data de indosariere a documentului in
sistem.

* Dimensiunea fisierului: filtreaza rezultatele cautarii in functie de dimensiunea fisierului selectat.

Activati/dezactivati filtrul:

Utilizatorul are posibilitatea de a activa/dezactiva filtrele printr-un simplu click. Un filtru activat este evidentiat
prin intermediul chenarului de culoare gri ce marcheaza butonul dedicat filtrului. De indata ce a fost activat un
filtru, cdmpul corespunzator apare sub zona de cautare.

Faceti clic pe pictograma sdgeata din dreapta campului pentru a deschide un meniu de tip drop-down pentru
selectarea optiunilor.
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Optiunea selectata va fi vizibila in campul de filtrare, iar filtrul devine activ atunci cand incepeti o cautare.

Daca se doreste realizarea unei noi cautari, utilizatorul va apela optiunea de resetare filtre pentru a reveni la
interfata initiala de cautare.

Exista posibilitatea de a selecta filtre multiple si de a le utiliza in procesul de cautare. Utilizatorul nu este
restrictionat la numarul de filtre pe care le poate selecta pentru a filtra rezultatele obtinute in cadrul procesului
de cautare.
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o Filtre multiple: prin combinarea diferitelor filtre, puteti restrange rezultatele cautarii pe baza mai multor criterii.
Acest lucru va permite sa creati solicitari de cautare precise.

e Filtre multiple de un singur tip: Folositi mai multe valori din acelasi tip pentru a seta un filtru avansat.

Puteti seta filtre pentru a exclude anumite valori. Faceti clic dreapta pe campul de filtru pentru a deschide meniul
contextual. Aici activati optiunea ,,nu contine”.

Pentru a elimina filtrul, faceti clic pe pictograma X de langa valoarea filtrului selectat.
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Cautare metadate
Pe langa utilizarea ELO iSearch, ELO va permite sa cautati metadate folosind diferite formulare.

Tncepeti cautarea metadatelor in ELO Java Client in zona Meniu > Ciutare > Proces logic de cdutare > Ciutare
metadate.

Se deschide caseta de dialog Cautare metadate. Sunt afisate toate metadatele care pot fi utilizate pentru cautare
in zona formulare disponibile. Selectati formularul pe care I-ati folosit pentru a depune documentul pe care il
cautati, de ex. Dosar. Acest lucru limiteaza cautarea documentelor la cele carora li s-au atribuit aceste metadate.
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Campurile de cautare ale formularului de metadate sunt afisate pe fisierul corespunzator.

Puteti utiliza campurile de cautare pentru a identifica in mod specific intrarile din aceste campuri, cum ar fi
pentru numarul facturii sau data de depunere.

Atentie: Cand cautati metadatele, este posibil sa faceti completari in mai multe cdmpuri ale unui formular de
cdutare. Acest lucru va permite sa creati interogari complexe de cautare.

Cautari anterioare

Daca ati efectuat deja mai multe solicitari de cautare, aveti posibilitatea sa selectat in formularul de cautare
metadate pe pictograma cu sageata verde (cele mai recente intrari salvate/afisate). Se va deschide o lista cu
solicitarile de cautare anterioare.

Sunt afisate atat termenul de cautare, cat si campul utilizat.
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Selectati una dintre intrarile listate si faceti clic pe OK. Termenii vor fi transferati in formularul de cdutare.

Cautare cu ,,Si/Sau”

Pentru a realiza cautarea folosind operatorii SI/SAU, termenii de cdutare trebuie sa fie pusi intre ghilimele. Unul
dintre operatori (Sl sau SAU) trebuie fie plasat intre termenii de cautare.

Cautare folosind wildcard

In procesul de cautare este permisa utilizarea caracterului *. Acest lucru inseamna ca puteti folosi substituentul
* pentru a cauta secvente sau siruri de caractere.
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Atentie: puteti utiliza un semn de intrebare ca wildcard. Va trebui apoi sa introduceti termenul de cautare cu
litere mici.

Semnul intrebarii poate fi folosit ca wildcard la sfarsitul unui cuvant.

Cautare secvente

ELO pune la dispozitia utilizatorului mai multe optiuni pentru acest tip de cautare, dupa cum urmeaza:

Sa presupunem ca se doreste cautarea documentelor care contin ,test” in nume. Introduceti *test* in campul
Nume scurt din formularul de cautare. Cautarea va returna toate documentele care contin literele ,test”. Cu alte
cuvinte, cautarea se realizeaza pentru intervalul dintre cele doua asteriscuri.

Cautd ,inceput cu" sau "termindnd cu" - O alta metoda de cautare disponibila este prin ,incepand cu” sau
,terminand cu”. Aceastd optiune de cautare poate fi setata ca implicita in formularele de metadate.
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Cautare universala

ELO permite efectuarea unei cautari universale pentru anumite atribute. Aceasta se aplica tuturor campurilor de
indexare care utilizeaza acelasi grup. Cautarea este disponibild si pentru cdmpurile al caror nume de grup are
parti similare (de exemplu: NOINV, NOCUST, NOSUPPL). Folosind acelasi nume de grup pentru mai multe campuri
de indexare din formulare de indexare diferite putem crea legaturi orizontale intre aceste cimpuri, asa cum se
poate vedea in imaginea de mai jos:

Power search
Acest tip de cautare poate fi utilizat atat in clientul de Java cat si in Web.

Incepand cu caracterul egal (=), introduceti interogarea in campul de cautare, asa cum se arata in exemplul de
mai jos.

Cautarea de tip power search transmite cereri direct catre Elasticsearch prin ELO Indexserver. ELO Indexserver
efectueaza o verificare de autorizare pentru a se asigura ca utilizatorul care executa power search-ul vede doar
documentele pentru care are permisiuni acordate.

Sintaxa de cdutare corespunde sintaxei , QueryStringQuery”, asa cum este documentata de Elasticsearch:
https://www.elastic.co/guide/en/elasticsearch/reference/5.6/query-dsl-query-string-query.html
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Este deosebit de important ca utilizatorul sa poata scapa de caracterele speciale. Acest lucru este necesar daca
utilizatorul doreste ca caracterul sa fie interpretat ca o litera normala pentru a ignora orice semnificatie speciala
in contextul Tn care sunt utilizate, ceea ce ar afecta cautarea. Urmatoarele caractere au o semnificatie speciala
in sintaxa ,,QueryStringQuery” si, prin urmare, trebuie sa fie excluse daca sensul respectiv trebuie ignorat:

Caracter Inteles

+<word> <word> trebuie sa apara in document

-<word> <word> nu trebuie sa apara in document (exceptie daca il precede un spatiu)

<word1l> && Documentul trebuie sa contina ambele cuvinte

<word2>

<wordl> || Documentul trebuie sa contina cel putin unul din cele doua cuvinte

<word2>

>X<X Mai mare/mai mic ca (functioneaza pentru numere sau cuvinte)

>= X <=X Mai mare ca sau egal cu / mai putin de sau egal cu (functioneaza pentru numere sau
cuvinte)

= Nu are o semnificatie de unul singur; pozitionat la inceputul liniei: power search

{xTO vy} Cautare interval (fara x si y)

[xTO V] Cautare interval (cu x siy)

<word>" Semnificatia cuvantului

"<word> <word>" Cautare expresii

<word>"~ Cautare aproximativa (fuzzy search)

* Wildcard, indiferent de numarul de caractere

? Wildcard, exact numarul de caractere ce trebuie inlocuite

\ Caracter ,escape”

/ Fara insemnatate

<field Cautare in <field name> pentru <word>

name>:<word>

6.1.5 Functii suplimentare

Rulati cereri de cautare recente

ELO salveaza cele mai recente zece cdutari in Meniu > Cautare > Solicitari de cautare recente. Faceti clic pe
cererea de cautare pentru a rula cdutarea din nou.

Atentie: Solicitarile de cautare sunt salvate cand inchideti ELO.
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Creati vizualizarea de cautare

Daca utilizati functia Vizualizare noua (pictograma ,,+” de la sfarsitul listei de rezultate) in zona de lucru Cautare,
creati o vizualizare de cdutare temporara.

O vizualizare de cdutare este utilizata pentru a salva temporar rezultatele cautarii.

Atentie: aceste vizualizari de cautare sunt sterse cand inchideti ELO. Daca doriti sa salvati o solicitare de cautare,
utilizati functia Salvare Cautare (in zona de lucru Cautare din Meniu > Cautare > Preferinte de Cautare).

Salvarea cautarilor favorite

De asemenea, puteti salva cautarile ca favorite. Pentru a salva o cautare ca favorita, accesati meniul si faceti clic
pe Cautare > Salvare cautare.
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Veti gasi favoritele dvs. de cautare in Meniu > Cautare >Preferinte de Cautare > Search favorites.

Cautati numai in folderul curent

Functia ,Numai in folderul curent” va permite sa restrictionati cautarea la nivel de folder selectat in zona de lucru
Repository.

Veti gasi aceasta functie In Meniu > Cautare > Proces logic de cautare > Numai folderul curent.

Cautare intrari sterse
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Pentru a cauta exclusiv intrari sterse, activati functia Afisare intrari sterse. Veti gasi aceasta functie in Meniu >
Cautare > Proces logic de cautare.

Daca optiunea Afisare intrari sterse este activata (evidentiata galben), veti vedea doar intrari sterse in rezultatele
cautarii.

Zonele cautate

Faceti clic pe ,In Toate Zonele” pentru a selecta zonele in care sa fie realizata cautarea. Utilizatorul are
posibilitatea sa selecteze dintre optiunile:
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Puteti alege dintre urmatoarele optiuni:
e Text complet (fulltext): optiunea Text complet restrictioneaza cautarea la totalitate continutul textului.

¢ Metadate: optiunea Metadate va permite sa activati sau dezactivati urmatoarele optiuni in acelasi timp:
nume scurt, Campuri si text suplimentar.

e Nume scurt: optiunea Nume scurt restrictioneaza cautarea la continutul numelor scurte ale fisierelor.

e Campuri: optiunea Campuri restrictioneaza cautarea la continut de campuri.

e Textsuplimentar: optiunea Text suplimentar restrictioneaza cautarea la continutul textului suplimentar.

*  Flux: optiunea Flux restrictioneaza cdutarea la continutul zonei de feed a ELO. Aceasta include
comentariile versiunii.

Activati sau dezactivati diferitele optiuni facand clic pe casetele de selectare.

Dosar dinamic

Aveti optiunea de a salva cererile de cautare ca dosar dinamic. Folderele dinamice sunt actualizate automat
atunci cand intrarile care corespund la criteriile de cdutare se afla in baza de date ELO.

Dosarele dinamice sunt salvate in zona de lucru Repository.

Veti gasi aceasta functie in Meniu > Cautare > Rezultat > Folder Dinamic.
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Eliminati din rezultatele cautarii

Functia Eliminare din rezultatele cautarii vd permite sa eliminati elementele selectate (accepta selectia multipla)
din rezultatele cautarii. Aceasta sterge doar intrarile din lista de rezultate din cdutarea curenta. Intrarile raman
in ELO.

Veti gdsi aceasta functie in Meniu > Cautare > Rezultat.

Afiseaza rezultatele cautarii

Rezultatele cdutarii sunt afisate In mai multe coloane cand sunt utilizate setarile standard/implicite. Coloanele
tabelului corespund campurilor din formulare de metadate. Rezultatele pot fi filtrate in cadrul coloanelor. Prin
click pe anteturile coloanei, rezultatele pot fi sortate crescadtor sau ordine descrescatoare.
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Faceti clic dreapta pe antetul unei coloane pentru a deschide un meniu contextual. Selectati coloanele pe care
doriti sa le afisati.

Listele de rezultate pot fi afisate in sistem prin afisarea sau ascunderea coloanelor prin bifarea sau debifarea
acestora:
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Sortare dupa coloane:
- sortare ascendenta/descendenta

- particularizare pe coloana respectiva (optiuni valabile pentru toate coloanele din lista)
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navigare intre pagini

redimensionarea si rearanjarea coloanelor prin drag and drop, fata de coloanele ordonate anterior:
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Fuzzy search
Fuzzy search sau cautarea aproximativa este o functie disponibila in zona de cautare. Pentru apelarea acesteia,
se introduce partial/aproximativ termenul cautat si se acceseaza optiunea de cautare.

Pe langa lista de rezultate, sistemul va semnala utilizatorului in zona chiar de sub campul de cautare: ,Ati vrut sa
spuneti” alaturi de o serie de termeni ce se pot regasi in sistem. Un click pe oricare din acesti termeni va inlocui
termenul cautat introdus in campul de cautare cu noul termen, iar utilizatorul va putea efectua noua cautare.
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7 Fluxuri de lucru

Procesele bine organizate si automate sunt baza cresterii oricarei companii. Suita ELO ECM este o baza ideala
pentru conectarea sistemelor, automatizarea fluxurilor informationale si de documente si controlul acestora in
functie de necesitatile companiei. Motorul de fluxuri de lucru integrat in serverul ELO (ELO Workflow Engine)
este un element cheie al suitei pentru obtinerea beneficiilor dorite.

Motorul de fluxuri de lucru detine functionalitati puternice de gestiune a fluxurilor informationale si de
documente. Interfata grafica permite modelarea in mod facil a celor mai complexe procese de business. Mai
mult, motorul de fluxuri de lucru permite si implicarea sistemelor software deja existente si a datelor acestora.
Interfetele standard puse la dispozitie permit integrarea fluxurilor de lucru in infrastructura software existenta.
Pe langa functiile standard, motorul de fluxuri de lucru ELO poate fi extins cu usurinta prin dezvoltarea de
scripturi JavaScript pentru implementarea de automatizari suplimentare sau reguli de business.

Principala caracteristica a motorului de fluxuri de lucru o reprezinta furnizarea unui flux de informatii in interiorul
companiei, prin atribuirea de sarcini catre fiecare persoana in parte, prin trimiterea documentelor catre angajatii
implicati in fluxurile de lucru definite, totul intr-o maniera predefinita si standardizata.

Atunci cand un flux de lucru este pornit, este posibila afisarea imaginii grafice a sablonului pe baza caruia s-a
construit fluxul, in care pot fi vizualizate nodurile (pasii) fluxului si persoanele care sunt implicate in flux pe fiecare
pas in parte.

Printre avantajele fluxurilor de lucru ELO se numara:

- Cartografierea proceselor dinamice din cadrul companiei prin intermediul fluxurilor si subfluxurilor de
lucru. Totul se poate realiza intr-o maniera predefinita si standardizata, prin intermediul editorului
grafic integrat

- Vizualizarea si adaptarea fluxurilor de lucru in timpul desfasurarii acestora

7.1  Workflow designer

Accesare meniu — functionalitatea

7.2 Zonede lucru

Fluxurile de lucru predefinite, sunt concepute pentru procesele care apar adesea intr-o companie. Fluxurile de
lucru predefinite, pot fi utilizate pentru a acoperi un grad larg de cerinte. Aveti nevoie de un sablon de flux de
lucru corespunzator pentru a incepe un flux de lucru predefinit.
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Workflow designer consta in umartoarele zone:
1. Sabloane

Toate sabloanele de flux de lucru disponibile sunt listate in coloana Sabloane din partea stanga. Faceti clic pe o
intrare pentru a deschide interfata grafica, care afiseaza fluxurile de lucru ca o diagrama in mijlocul panoului de
vizualizare. Tn plus, veti g&si un buton pentru gestionarea sabloanelor de flux de lucru in coloan.

2. Spatiu de lucru

In spatiul de lucru, sabloanele fluxului de lucru sunt afisate in vizualizarea grafica. Puteti vedea statiile (nodurile)
si elementele din care consta un flux de lucru si cum sunt conectate.

3. Bara de instrumente

Aici gasiti instrumentele pentru crearea si editarea unui sablon de flux de lucru.

4, Editor nod

Aceastd zona contine o fereastra de previzualizare si zona de setari nod. Definiti setarile pentru nodurile fluxului
de lucru individuale in zona Setari nod.

5. Bara de stare

Aici gasiti ID-ul sablonului fluxului de lucru, versiunea curenta si ID-ul nodului nodului fluxului de lucru selectat
in present.

7.2.1 Detaliere instrumente
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1. Select Tool

Cand modul de editare este activat, butoanele pentru editarea sabloanelor de flux de lucru apar in bara de
instrumente a proiectantului de flux de lucru.

Sunt disponibile urmatoarele functii:
- Daca optiunea Selectare este activata, puteti trage nodurile sablonului de flux de lucru in

pozitii noi.

- Daca sunt selectate mai multe noduri, nodurile selectate pot fi mutate impreuna. Selectati
mai multe noduri facand clic unul dupa altul in timp ce apasati CTRL sau tragand un cadru
in jurul nodurilor.

2. Connection

Functia Stabilire conexiune intre doud noduri va permite sa conectati noduri sablon de flux de lucru. Directia
conexiunii este determinata de ordinea in care faceti clic pe noduri. Faceti clic mai intai pe nodul de pornire si
apoi faceti clic pe nodul tinta.

De asemenea, puteti identifica directia conexiunii prin pictograma sageata din mijlocul liniei de conectare.

3. Successor node on timeout

Functia Specificare nod succesor la expirare va permite sa conectati un nod la altul, care este apelat automat la
depasirea termenului stabilit.

Puteti seta termenul limita Tn setarile nodului in Gestionare escalare> Escalare generald. Daca termenul a trecut,
fluxul de lucru continua direct catre nodul succesor respectiv. La fel ca in cazul escaladarilor, utilizatorul de la
nodul succesor nu trebuie sa accepte fluxul de lucru.

4. Delete
Functia Sterge, elimina elementele de pe plansele fluxului de lucru.

Daca plasati cursorul peste un element, apare o pictograma de radiera si puteti face clic pe element pentru al
sterge.
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5. User node

Nodurile de utilizator determina statiile la care fluxul de lucru ar trebui procesat de un utilizator sau de un grup.

6. Decision node
Acest nod este utilizat pentru a defini o conditie care afecteaza fluxul documentului.

Puteti utiliza noduri de decizie pentru a compara campurile din formularul de formulare cheie a unui document
cu valori specifice, de exemplu, pentru a verifica valoarea unei facturi.

Daca conditia este indeplinita, fluxul de lucru este transmis Tnainte la nodul A (conexiune verde). Daca conditia
nu este indeplinitd, fluxul de lucru este transmis Tnainte la nodul B (conexiune rosie).

7. Distribution node

Puteti utiliza un nod de distributie pentru a trimite fluxul de lucru catre mai multi noduri succesori in acelasi timp.

8. Collection node

Un document este transmis inainte catre urmatoarea statie de catre un nod de colectare odata ce toate nodurile
precedente au fost finalizate sau doar un numar predefinit de raspunsuri este in asteptare.

De exemplu, daca o factura trebuie aprobata de doi angajati, aceasta nu este transmisa pana cand ambii angajati
nu au aprobat factura.

9. Cycle node

Tn fluxurile de lucru, existd procese care trebuie repetate pani la atingerea unei stiri specifice. Pentru aceasta
sunt utilizate nodurile de tip Cycle. n a doua bucl3, informatiile despre noduri nu se pierd deoarece nodurile sunt
copiate si inserate langa nodurile existente.

10. Server transfer

Tipul de nod de transfer server este utilizat pentru a transfera un document de flux de lucru pe un al doilea
server. Identificatorul de depozit al celui de-al doilea server trebuie introdus in nodul de transfer al serverului.

Dupa sincronizarea datelor cu al doilea server, puteti continua procesarea fluxului de lucru pe al doilea server.
Fluxul de lucru este apoi blocat pe primul server.

11. Subworkflow

Functia Apel sub-flux va permite sa adaugati noduri de sub-flux. Odata ce fluxul de lucru ajunge la nodul sub-
fluxului, este pornit fluxul secundar corespunzator.

Fluxul de lucru inceput depinde de sablonul pe care I-ati selectat in meniul derulant Selectati sablonul.

12. End node

Nodul final este utilizat pentru a defini un punct final unic al unui flux de lucru.
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Nu trebuie sa utilizati un nod final. Daca nu exista nod final, fluxul de lucru se termina de Tndata ce nu mai exista
noduri neprocesate. Este logic sa folositi noduri finale daca utilizati un nod de colectie care asteapta un anumit
numar de noduri predecesoare, de exemplu. Cand se atinge acest numar, nodul de colectare este trecut, dar
fluxul de lucru ramane activ, deoarece exista inca noduri neprocesate. Pentru a finaliza fluxul de lucru este
necesar un nod final.

7.2.2 Optiuni configurare
Permissions

Faceti clic pe butonul Permisiuni pentru a deschide caseta de dialog Permisiuni flux de lucru. in aceasta caset3

de dialog, puteti edita setarile de permisiuni pentru fluxurile de lucru care sunt pornite cu un sablon de flux de
lucru.

Workflow settings

General

| =1 . .
o5& Permissions

Type
Start node

lcon

=

Icon

Alegeti o pictograma noua prin meniul de tip lista, denumit Icon.
otart node

Transfer to server @

User
Cwner

Priority

Transfer to server

Campul Transfer catre server este locul in care introduceti identificatorul de depozit al unui server pe care
urmeaza sa fie transferat fluxul de lucru.
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Start node

lcon

guﬁ Start node E|

Transfer to server @

Llser
Owner Select

Priarity

User

Setarea implicita pentru campul Utilizator este Proprietar. Proprietar inseamna: persoana care porneste fluxul
de lucru va edita toate nodurile cu aceasta setare. Aici nu puteti efectua modificari la nodul de pornire.

:" User node -

User

Owner Select

Priarity

A v

Comments

Priority

Puteti defini nivelul de prioritate al fluxului de lucru in meniul derulant Prioritate. Puteti alege dintre
urmatoarele prioritati: A (= ridicat), B (= mediu) si C (= redus). Aceasta functie este utila daca aveti un numar
mare de fluxuri de lucru si doriti sa le evaluati in functie de importanta.

Owner Select

Priarity
A

Node name

Comments

Utilizati cAmpul Comentarii pentru a introduce informatii pe nodul de pornire. Acest text apare in prezentarea
generala a fluxului de lucru, in fluxurile de lucru pentru aceasta intrare si in casetele de dialog Afisare flux de
lucru.
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ser
Chwner

Priority

: <]

Select

Comments

Workflow step

Numele sablonului de flux de lucru este utilizat automat pentru nodul de pornire. Daca doriti, puteti schimba

numele Tn cdmpul pas de flux de lucru.

Node name
Waorkflow step @

Mewsletter

» Translation variable

» Escalation management

Escalation management

n zona de gestionare a escaladarii, puteti seta termene pentru intregul flux de lucru (prin nodul de pornire) sau

noduri individuale

Exclude weekends

Daca optiunea exclude weekend-uri este activata, durata maxima a fluxului de lucru va lua in considerare faptul
ca sambata si duminica nu sunt zile lucratoare obisnuite. Weekend-urile vor fi omise atunci cand se calculeaza

durata fluxului de lucru.

Daca aceasta optiune este dezactivata, sdmbata si duminica sunt incluse in calcul. Toate zilele calendaristice

conteaza la calcularea duratei maxime a fluxului de lucru.

~ Escalation management

[] Exclude weekends @

General escalation @
Days Hours Min Escalation to
Cwner

Escalation B

General escalation

Campurile de sub Escalare generala va permit sa definiti cat timp poate ramane fluxul de lucru la nodul curent.
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Daca fluxul de lucru nu a fost finalizat pana la termen, acesta apare in lista sarcinilor restante. Utilizatorului
introdus Tn campul “Escalation to” va primi un mesa;j.

Daca nu introduceti o durata maxima, nu exista o verificare automata a termenelor ratate.

Escalation B

Exclude weekends @
General escalation @
Days  Hours Min Escalation to

B 30 Chwner

Escalation B

Days  Hours Min Escalation to

Select

Campurile de sub Escalare B va permit sa definiti un al doilea nivel de escaladare. Cu privire la acest termen este
trecut, utilizatorul corespunzator este informat.

Escalation C

Campurile de sub Escalare C va permit sa definiti un al treilea nivel de escaladare. Daca acest termen este trecut,
utilizatorul corespunzator este informat.

Start script

TRVTTET

Escalation B

Days Hours Min Escalation to
2 Byte
Escalation C

Days Hours Min Escalation to

Anderson

% Additinnsl antinne

Select

Select

Tn campul Start script, puteti introduce o functie care va fi rulat atunci cdnd nodul devine activ, faceti clic pe

Selectare.

Form

Start script @

Farm @

Script properties ©

Select

Select
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Tn cAmpul Formular, puteti conecta o parte a unui formular (sablon) la nod. Sabloanele selectate sunt afisate

atunci cand apelati nodul. Pentru a deschide caseta de dialog pentru selectarea formularului de flux de lucru,
faceti clic pe Selectare.

Start script ©

Select

Form @

Select

SCript properties &

7.3  Fluxuri de lucru standard (predefinite)

Acest tip de sablon de flux de lucru este potrivit pentru procese repetitive, frecvente si complexe. Aceste tipuri
de procese de business (de exemplu, cereri de concediu) pot fi create in cadrul interfetei grafice din designer-ul
de fluxuri de lucru care este la dispozitia administratorului de sistem sau a unui utilizator cu drepturi de editare
ssabloane de fluxuri de lucru. Aceasta interfata grafica asigura gestionarea tuturor sabloanelor de fluxuri de lucru

predefinite, permitandu-le utilizatorilor sa versioneze fluxurile de lucru, sa modifice, sa exporte si sa stearga
sabloanele de fluxuri de lucru.

Optiuni principale disponibile pentru administratorul de fluxuri de lucru:
- Sablon nou de flux de lucru

- Copiere sablon flux de lucru
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- Versionare sablon flux de lucru
- Permisiuni de acces la sablon flux de lucru
- Salvare sablon flux de lucru

Pentru utilizatorii standard ai sistemului, exista o bara de unelte aferenta zonei de lucru Activitati, acolo unde se
primesc sarcinile de lucru si de unde se pot realiza diferite operatiuni referitoare la sarcinile primite.

Sarcinile de pe fluxurile de lucru se pot delega catre un alt utilizator sau se pot amana din diverse motive pentru
o perioada de timp. De asemenea, se pot adauga remindere pentru anumite sarcini de lucru, care vor apare in
zona de activitati. Zona de activitati pentru un utilizator este oarecum similara cu cea a unei cutii de posta
electronica in care se primesc sarcinile de lucru.

O functionalitate importanta este aceea care ofera posibilitatea utilizatorilor ca in orice clipad sa se poata vedea
statusul fluxului de lucru pentru un anumit document sau dosar in mod grafic, precum si statusul tuturor
fluxurilor de lucru pornite in sistem, indiferent daca acestea sunt sau nu finalizate. Fiecare actiune care are locin
sistem este jurnalizata si auditata astfel incat exista posibilitatea realizarii de rapoarte referitoare la fluxurile de
lucru:

Motorul de fluxuri de lucru furnizeaza de asemenea functii pentru managementul substituentilor, care sunt
foarte folositoare pentru fluxurile de lucru, avand scopul de a inlocui utilizatorii care nu sunt disponibili pentru o
anumitd perioada de timp. Folosind aceste functii, un utilizator isi poate delega sarcinile de lucru catre alti
utilizatori, iar cei care trebuie sa il inlocuiasca au posibilitatea de a accepta sau nu inlocuirea (de exemplu: daca
0 persoana este in concediu, atributiile 7i pot fi preluate de o alta persoana si astfel nu se blocheaza fluxul de
lucru).
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7.4 Subfluxuri de lucru

Subfluxurile de lucru au aceeasi structura ca cea a fluxurilor de lucru standard. Sunt initiate din cadrul fluxurilor
de lucru standard imediat ce nodul decisional corespunzator al fluxului a fost atins.

Apeland optiunea Show workflows — se deschide o fereastra de dialog ce prezinta o viziune de ansamblu asupra
tuturor subfluxurilor existente. Pentru a vizualiza detaliile unui subflux de lucru, se va selecta subfluxul
corespunzator din lista existenta in partea stanga a ferestrei.

Pentru a vizualiza statusul unui subflux de lucru, se va selecta una din urmatoarele optiuni:
- Active — vor fi listate doar subfluxurile active
- Finalizate — vor fi listate doar subfluxurile incheiate

- Toate fluxurile — la selectarea acestei optiuni, vor fi afisate toate fluxurile de lucru
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- Doar cele cu termen limita depasit — cand aceasta optiune este selectata, vor fi vizibile doar
subfluxurile de lucru escaladate. Aceasta optiune poate fi selectata simultan cu una din optiunile:
Active, finalizate sau toate fluxurile.

- Incarcarea campurilor index — la selectarea acestei optiuni, informatia de indexare disponibila va fi
afisata in meniul de tip drop-down de sub coloanele cu titlul Index. Aceasta optiune poate fi selectata
simultan cu una din optiunile: Active, finalizate sau toate fluxurile, precum si cu cea referitoare la
fluxurile cu termen limita depasit.

In bara de unelte a designerului pentru fluxuri de lucru, este disponibila si optiunea pentru generarea
subfluxurilor de lucru.

7.5 Fluxuri de lucru ad-hoc

Acest tip de sablon de flux de lucru este potrivit pentru procese simple si coerente care pot fi secventiale sau
paralele (de exemplu, cateva documente care ar trebui sa fie partajate intre mai multi angajati). Se utilizeaza
atunci cand nu exista un sablon predefinit sau Tn cazuri in care se lucreaza in echipe si atunci se pot transmite
documentele cu usurinta tuturor membrilor echipei pentru informare. Un flux de lucru ad-hoc poate fi pornit de
orice utilizator care are drepturi de pornire fluxuri de lucru si tot ceea ce trebuie sa faca este sa selecteze
utilizatorii sau grupurile carora doreste sa le trimita documentele si tipul de flux de lucru ad-hoc. Exista patru
tipuri de fluxuri de lucru ad-hoc: aprobare in serie, aprobare in paralel, informare/distribuire in serie si
informare/distribuire in paralel. Totul se realizeaza din interfata grafica, asa cum se poate observa in imaginea
de mai jos:

In fereastra de deschidere a fluxului de lucru ad-hoc se completeaza utilizatorul/utilizatorii care trebuie sa
primeasca sarcina, se poate selecta nivelul pentru prioritate si se poate seta un timp de rezolvare pentru
rezolvarea sarcinii.

Prioritatea sarcinii se poate stabili atat din zona dedicata pentru prioritate, cat si setand un termen limita pentru
rezolvarea taskului respectiv, cu punctarea persoanei catre care sa se raporteze termenul limita omis daca este
cazul.
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7.6 Formulare electronice

Una dintre cele mai importante functionalitati disponibile Th mod standard in suita ELO ECM este aceea de creare
in mod grafic a formularelor electronice care se pot utiliza atat pe fluxurile de lucru definite in sistem cat si pentru
indexarea documentelor si dosarelor din depozitul ELO. Aceasta functionalitate este disponibild administratorilor
de sistem, atat din interfata web a consolei de administrare, cat si din clientul desktop Java.

Utilizand capabilitatile designer-ului de formulare electronice, compania are posibilitatea de a-si modela toate
formularele fizice si documentele tipizate in format electronic, iar fluxurile de lucru cu hartie se pot transforma
n fluxuri electronice de lucru, in acest fel realizandu-se o optimizare a proceselor si castigandu-se timp pretios
in prelucrarea informatiilor si documentelor.

Designer-ul de formulare electronice pune la dispozitia utilizatorilor toate uneltele necesare pentru modelarea
acestora, precum si posibilitatea de a introduce reguli de business ELOas, validari pe campurile formularului,
preluarea de date din surse externe de informatie (sisteme software, baze de date externe, etc), completarea
automata a anumitor campuri, formule de calcul, posibilitatea de addugare sau stergere de campuri din
formulare, utilizarea de script-uri JavaScript pentru implementarea diverselor automatizari, liste de valori
dinamice, etc. Mai mult, formularele electronice suporta internationalizare, astfel incat un formular se poate
incdrca in limba preferata, folosindu-se tabele de traducere.

Tipurile de campuri disponibile sunt urmatoarele:
- Campuri de introducere informatii (string, numeric, etc)
- Campuri de tip data
- Campuri de tip text
- Campuri de tip area text
- Campuri de tip check-box
- Campuri de tip radio button
- Campuri de tip combo box
- Campuri de tip semnatura
- Campuri de tip buton, inclusiv adaugare linie sau stergere linie
- Campuri de tip imagine
- Campuri de tip link

Pagina 278 din 337



Avantajele utilizarii formularelor electronice:
- Completarea fluxurilor de lucru prin crearea automata a formularelor
- Optiuni extinse de design al formularelor prin utilizarea custom a CSS si linkuri
- Functie de precompletare pentru valorile cunoscute
- Recunoasterea automata a documentelor si extragerea datelor pentru procesari ulterioare

Printre optiunile disponibile in cadrul formularelor electronice enumeram:
- crearea de formulare cu tab-uri si metadate dinamice, prin configurarea in functie de nevoile
si cerintele clientului.

Exemplu de formular cu taburi:

- sistemul permite definirea formularelor cu metadate dinamice cu afisare de metadate in
functie de diverse conditii, ca exemplu — la selectia anumitor optiuni de pe interfata, sa se
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ascunda sau sa fie afisate campuri cu metadate asociate ale formularului sau valorile din
anumite campuri ale formularului sa se modifice in functie de selectia realizata (in cazul
realizarii unui calcul de exemplu).

- In designer-ul de formulare electronice se pot implementa formule de calcul intre diferite
campuri, cu posibilitati multiple.

- Designerul de formulare permite introducerea regulilor de validare pentru a verifica date,
lungimea textului sau intervale de valori. Este permisa inclusiv adaugarea mesajelor
personalizate care sa fie afisate daca validarea esueaza.

Exemplu de mesaj preconfigurat care avertizeaza utilizatorul asupra faptului ca nu a completat un camp marcat
ca obligatoriu in sistem:
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Campuri de introducere informatii (string, numeric, etc)

Campuri de tip data

Campuri de tip text

Campuri de tip area text

Campuri de tip check-box

Campuri de tip radio button
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- Campuri de tip combo box

- Campuri de tip semnatura

- Campuri de tip buton, inclusiv adaugare linie sau stergere linie

- Configurarea parametrilor campurilor
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- Posibilitatea de adaugare sau stergere de campuri din formulare.

- Posibilitatea de adaugare a listelor de valori dinamice. Acestea se apeleaza din cadrul
designerului de formulare, in zona de proprietati a celulei selectate:

7.7 Delegarea fluxului de lucru si managementul inlocuitorilor

Sarcinile de pe fluxurile de lucru se pot delega/preda cétre un alt utilizator sau se pot amana din diverse motive
pentru o perioada de timp. Folosind aceste functii pentru managementul inlocuitorilor, un utilizator isi poate
delega sarcinile de lucru catre alti utilizatori, iar cei care trebuie sa il inlocuiasca au posibilitatea de a accepta sau
nu Tnlocuirea (de exemplu: daca o persoana este in concediu, atributiile ii pot fi preluate de o alta persoana si
astfel nu se blocheaza fluxul de lucru).

In zona de activitati a sistemului sunt disponibile mecanisme de atribuire/delegare a activitatilor catre utilizatori.
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Configurarea delegarii fluxului de lucru se realizeaza in fereastra dedicata prin mentionarea utilizatorului sau a
grupului catre care se va transmite pasul de pe fluxul de lucru, se pot adauga notite pentru destinatari si bifa
pentru notificare in momentul in care nodul a fost procesat de catre destinatar.

De asemenea, sistemul permite desemnarea unui inlocuitor pentru o perioada de timp prin accesarea meniului
de configurare si selectare inlocuitor:

Inlocuirea poate fi restrictionata pentru:
- activitati si fluxuri de lucru personale
-acces la zona de intray

-mostenirea apartenentei la grupuri
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Dupa realizarea setarilor pentru perioada de inlocuire, inlocuirea va fi activata automat la data de incepere
specificata. Daca se specifica si o data de sfarsit, inlocuirea va fi dezactivata automat la expirarea datei. In
momentul in care a fost setata perioada de inlocuire, sarcinile de lucru sunt redirectionate automat.
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8 Rapoarte si audit

Suita ELO pune la dispozitie rapoarte de audit care pot fi generate pe toate documentele si informatiile din
depozitul ELO, precum si pe toate procesele de lucru. Din motive de securitate, auditarea tuturor proceselor si a
fluxurilor de lucru din sistem sunt esentiale pentru o arhiva electronica. Rapoartele generate i-ar putea ajuta pe
administratori sa gaseasca si sa analizeze erori, daca acestea apar.

Rapoartele pot fi setate sa includa anumiti parametri de interes, cum ar fi optiunea ca acestea sa contina o lista
de activitati care au avut loc in depozitul ELO si au fost marcate anterior pentru afisare.

Administratorii pot determina procesele inregistrate — addugare document, editare document, stergere
document, si multe altele, folosind optiunile de raportare puse la dispozitie. Pentru o mai usoara afisare a datelor,
optiunile de raportare includ posibilitatea de filtrare a rezultatelor dupa diverse criterii, cum ar fi data, utilizator,
numar element si chiar prin setarea optiunii de a afisa un raport mai detaliat sau mai concis.

Utilizatorii sistemului pot avea acces la rapoarte detaliate despre sarcinile zilnice, despre activitatile terminate
sau in lucru, precum si la rapoarte centralizatoare pe departamente, avind astfel o imagine completa a activitatii
cu documentele din sistem.

Suita ELO ofera posibilitatea de a vizualiza si un raport in care se poate vedea spatiul de stocare utilizat de sistem
pentru documente. Raportul se poate rula pe tot depozitul electronic de documente, sau doar pentru anumite
structuri din acesta si poate fi salvat in format PDF.

Exista o serie de functionalitati ce permit auditarea/ monitorizarea actiunilor utilizatorilor in aplicatie.

Raport pentru intrare

Informatii cu privire la actiunile realizate asupra unui obiect din sistem, se selecteaza obiectul respectiv, apoi din
meniul Organizare, se apeleaza functia Raport pentru intrare:

Se va deschide o fereastra noua care va permite configurarea informatiilor care sa fie disponibile in raport:
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- Numarul de intrari salvate pe pagina

- Data sau intervalul de timp pentru care sa fie generat raportul
- Utilizatorul pentru care sa fie generat raportul

- Actiuni specifice realizate asupra obiectului

De asemenea optiuni de Auditarea/monitorizarea a actiunilor utilizatorilor in aplicatie se mai regasesc si prin
apelarea functiilor:

Metadata
Se realizeaza selectia documentului, se apeleaza functia metadata si se selecteaza optiunea de istoric versiuni.

Aceasta actiune va prezenta istoricul metadatelor — cine/ce/cand a modificat asupra informatiilor anexate
documentelor, cu indicarea modificarilor efective.
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Fluxuri de lucru pentru aceasta intrare si/sau Prezentare generala flux de lucru

Selectia functiilor permite vizualizarea fluxurilor de lucru, a stadiului acestora, monitorizarea fluxurilor si a
utilizatorilor implicati, etc

Modulul de audit

Suita ELO detine un modul de audit care permite realizarea de rapoarte customizate pentru fiecare client in parte.
Acest modul de audit include functionalitati de filtrare si generare a rezultatelor unui raport pe baza acestor
filtre.

Rezultatele raportului pot fi filtrate suplimentar, pe baza coloanelor afisate in raport sau anumite coloane pot fi
ascunse din raport daca consideram ca acestea nu sunt necesare.

Monitorizarea caracteristicilor de performanta
1. Prin HealthCheck Service oferit de ELO ECM Suite, ceea ce presupune ca sistemul sa se conecteze in
exteriorul retelei pentru a transmite exclusiv date statistice catre serviciul de monitorizare ELO
localizat in Germania.

Pagina 288 din 337



Prin VisualVM, care reprezinta un tool de monitorizare al serviciilor tomcat, unde ruleaza toate
serviciile ELO. Practic cu acest tool se pot obtine informatii similare cu cele obtinute prin HealthCheck
Service de la ELO, dar acesta poate rula in reteaua locala si nu este necesara o conexiune catre
exterior.

Prin vizualizarea sectiunii ,,Statistics” din JavaClient, aceasta varianta permite identificarea
performantelor clientului:
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9 ELO Administration Console

Suita ELO include unelte de administrare si monitorizare complexe care permit administratorilor de sistem sa
gestioneze, dintr-o interfata web, depozitele de documente ELO si procesele de sistem. Aceste unelte sunt puse
la dispozitie prin intermediul unei console de administrare web, denumita ELO Administration Console.

Prin intermediul consolei de administrare se asigura un singur punct de acces pentru managementul si
administrarea tuturor depozitelor de documente, a serverelor, utilizatorilor si grupurilor de utilizatori, indiferent
de locatia acestora. Consola de administrare web-based ofera suport pentru o serie de browsere web standard
de larga raspandire.

Consola de administrare ELO se instaleaza odata cu serverul ELO si este disponibila prin intermediul browser-ului
web: http://<server-name>:<port>/AdminConsole/.

Pagina de login ELO Administration Console

Fereastra de autentificare este afisata administratorului de sistem, unde se introduc numele utilizator, parola si
repository-ul pe care doreste sa-l administreze.
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Optiuni de login

Printre optiunile existente in fereastra de login se numara:
- Posibilitatea de vizualizare a unui raport de status asupra consolei de administrare

- Posibilitatea de editare a fisierelor de configurare
- Posibilitatea de vizualizare a unui raport de sistem

Raportul de sistem permite alcatuirea unui fisier zip ce contine loguri si informatii din sistem. Prin intermediul
unei ferestre dedicate, se poate obtine un raport care sa contina exact elementele dorite referitoare la sistem.

Fereastra de primire a utilizatorului din consola de administrare consta intr-o zona de meniu.

Sectiunea superioara a meniului cuprinde elemente precum: posibilitatea de cautare a functionalitatilor si
setarilor puse la dispozitia administratorului de sistem, accesul la setarile de configurare, informatii despre
depozitul de arhiva si ELO administration Console (locul in care pot fi editate setarile cu privire la arhiva curenta
si program), acces la sistemul de ajutor si deconectare.
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Zonele consolei de administrare

Sub sectiunea de header, in consola de administrare, sunt disponibile o serie de optiuni, grupate in zone de lucru:

e Pachete

e (ClientInfos
e  Proxy

e Servers

e System settings (Setari sistem)

e Maintenance (Mentenanta)

e  Server modules (Module server)

e  System information (Informatii sistem)
e (Clients (Clienti)

e LDAP

n cele ce urmeazd vom prezenta optiunile oferite de fiecare zon de lucru in parte.

9.1 Pachete

In aceasta zona pot fi creeate, exportate, importate si sterse pachetele de solutie.

Pagina 292 din 337



Pachetele contin o solutie la cheie dezvoltata peste platforma, in afara standardului ELO, cu toate referintele,
scripturile si customizarile realizate, care odata instalate, livreaza un modul complet functional, asupra caruia nu
mai sunt necesare modificari suplimentare sau sunt necesare actualizari minore.

La accesarea optiunii se deschide o interfata care permite definirea unui pachet nou, exportul sau importul

acestuia, precum si explorarea continutului acestuia.

9.2 Clientinfos

Zona detine informatii cu privire la Business Solutions instalate pe instanta. Sunt afisate iconitele specifice
fiecarui Business Solution instalat. La accesarea acestora se deschide configuratorul specific pentru fiecare
Business Solution in parte. Pentru detalierea optiunilor acestora, va rugam sa consultati capitolul corespunzator

fiecarui Business Solution in parte.

9.3 Proxy
Sectiunea gestioneaza configurarile pentru modulele ELO Flows, ELO App manager, designerul de formulare ELO,
optiunile de configurare ale clientului Web precum si instrumentul pentru indexare manuala eficienta: ELO Smart

Input.
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9.3.1 ELO Flows configuration

Clientul este bazat pe ELO Apps si este dedicat gestionarii sarcinilor de lucru in sistem, in principal pentru
participarea si aprobarea fluxurilor de lucru.

9.3.2 ELO App Manager

In cadrul acestei sectiuni este posibila definirea si gestionarea app-urilor ELO si a diferitelor module componente.
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9.3.3 ELO form designer

Una dintre cele mai importante functionalitati disponibile Th mod standard in suita ELO ECM este aceea de creare
in mod grafic a formularelor electronice care se pot utiliza atat pe fluxurile de lucru definite in sistem cat si pentru
indexarea documentelor si dosarelor din depozitul ELO. Aceasta functionalitate este disponibila administratorilor
de sistem, atat din interfata web a consolei de administrare, cat si din clientul desktop Java.

Utilizand capabilitatile designer-ului de formulare electronice, compania are posibilitatea de a-si modela toate
formularele fizice si documentele tipizate in format electronic, iar fluxurile de lucru cu hartie se pot transforma
in fluxuri electronice de lucru, in acest fel realizandu-se o optimizare a proceselor si castigandu-se timp pretios
in prelucrarea informatiilor si documentelor.

Designer-ul de formulare electronice pune la dispozitia utilizatorilor toate uneltele necesare pentru modelarea
acestora, precum si posibilitatea de a introduce reguli de business ELOas, validari pe campurile formularului,
preluarea de date din surse externe de informatie (sisteme software, baze de date externe, etc), completarea
automata a anumitor campuri, formule de calcul, posibilitatea de addugare sau stergere de campuri din
formulare, utilizarea de script-uri JavaScript pentru implementarea diverselor automatizari, liste de valori
dinamice, etc. Mai mult, formularele electronice suporta internationalizare, astfel incat un formular se poate
incdrca in limba preferata, folosindu-se tabele de traducere.

Tipurile de campuri disponibile sunt urmatoarele:

- Campuri de introducere informatii (string, numeric, etc)
- Campuri de tip data

- Campuri de tip text

- Campuri de tip area text

- Campuri de tip check-box

- Campuri de tip radio button

- Campuri de tip combo box

- Campuri de tip semnatura

- Campuri de tip buton, inclusiv adaugare linie sau stergere linie
- Campuri de tip imagine

- Campuri de tip link
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In designer-ul de formulare electronice se pot implementa formule de calcul intre diferite campuri, cu posibilitati
multiple.

Designerul permite introducerea regulilor de validare pentru a verifica date, lungimea textului sau intervale de
valori. Este permisa inclusiv adaugarea mesajelor personalizate care sa fie afisate daca validarea esueaza.
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Avantajele utilizarii formularelor electronice:
- Completarea fluxurilor de lucru prin crearea automata a formularelor
- Optiuni extinse de design al formularelor prin utilizarea custom a CSS si linkuri
- Functie de precompletare pentru valorile cunoscute
- Recunoasterea automata a documentelor si extragerea datelor pentru procesari ulterioare

9.3.4 ELO Web Client configuration

Accesarea acestei optiuni conduce administratorul sistemului in clientul de web al ELO, in zona de configurare si
personalizare a interfetei atat la nivel de utilizator, cat si la nivel de grup.

9.3.5 ELO Smart Input

ELO Smart Input este o functionalitate ce permite clasificarea inteligenta a documentelor si analiza textului.

ELOsi Status

Status RUNNING

Name ELO Smart Input

Version 21.01.002

BuildDate 2021-10-29T19:12:21Z

webappcenfigdir CA\ELO\\config\\si-ELODEMO\\ELO-ELODEMO-OCR
proxyUrl https://ELODEMO:2093/ix-ELODEMO/ plugin/de.elo.ix.plugin.proxy/si/
ixUrl https://ELODEMO:9093/ix-ELODEMO/ix

ixUsername ELO Service

ixPassword T

dataPath CMELOV\data\\si-ELODEMO\\ELO-ELODEMO-OCR
taxes.1 7.0

In zona dedicata din consola de administrare, administratorul de sistem poate monitoriza functionarea serviciului
precum si configurarea acestuia din zona dedicate de administrare.
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Pentru fiecare formular de indexare disponibil in sistem, sistemul permite selectia si configurarea in vederea
clasificarii si extragerii metadatelor relevante printr-o analiza inteligenta a textului.
Se pot realiza direct in interfata customizari precum:

- Alocarea unei cai de arhivare care poate sa fie fixa sau variabila (in functie de diverse metadate
asociate)

- Unflux de lucru declansator

- Definirea campurilor care urmeaza sa fie recunoscute si pentru care se vor oferi utilizatorilor
propuneri si variante de indexare.

9.4 Servers

In aceasta zona este posibila administrarea botului ELO pentru Microsoft Teams. Prin configurarea acestuia este
posibila integrarea ELO in Microsoft Teams ca element standard si pune la dispozitia aplicatiei functii ECM
cuprinzatoare (adaugare foldere, documente, descarcare/incarcare documente, lansare fluxuri de lucru, etc)

9.5 System settings (Setari sistem)

Tn aceastd zon& de lucru se gestioneaz setarile sistemului, cum ar fi: utilizatori, grupuri, drepturi de acces, cii de
stocare, indecsii si formularele de indexare, cheile de criptare, seturile de replicare, etc.
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Zona dedicata setarilor de sistem

9.5.1 Gestiunea utilizatorilor si a grupurilor de utilizatori

Sectiunea dedicata gestiunii utilizatorilor si a grupurilor de utilizatori este locul in care administratorul de sistem
are posibilitatea sa defineasca utilizatori si grupuri si sa le aloce drepturile de baza .

Interfata dedicata definirii utilizatorilor si a grupurilor noi de utilizatori

Definirea unui utilizator nou sau a unui grup de utilizatori se realizeaza din accesarea butoanelor corespunzatoare
din meniul vertical al interfetei:
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La apelarea acestora, se deschide interfata pentru utilizator nou in care se pot adauga:
- Informatii generale precum:

- nume utilizator si parola
- Adresa de email — necesara pentru transmiterea notificarilor din sistem, daca acestea sunt

configurate pentru transmitere
- Supervizor — seful ierarhic al utilizatorului
Apartenenta la grupuri de utilizatori — unde utilizatorul nou poate fi alocat unui grup predefinit in

sistem sau i se poate aloca aceeasi apartenenta la grupuri ca unui utilizator/grup tert.

- Drepturi si setari de baza — diagrama de drepturi se poate prelua de la alti utilizatori deja definiti in
sistem sau se poate aloca prin distribuirea utilizatorului in grupuri sau manual prin bifarea optiunilor

necesare.
Tot din aceasta zona, prin bifarea optiunii de Lock account, poate fi blocat accesul la sistem al

utilizatorului.
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Drepturile utilizatorilor sunt acordate de administratorul de sistem si se pot seta de la nivelul folderelor, pana pe
documente si chiar si pana la nivel de camp de indexare. Un utilizator poate fi membru in mai multe grupuri.
Drepturile acestuia vor reprezenta suma tuturor drepturilor din grupul din care face parte, plus drepturile sale
individuale. De exemplu, se poate crea un grup, caruia sa i se desemneze toate cheile de acces necesare. Fiecare
membru din acest grup va detine automat cheile grupului.

Pentru fiecare cheie de acces, exista urmatoarele drepturi de acces pentru fiecare utilizator:

R (Read) — vizualizare — poate vizualiza obiecte ELO (documente, elemente de structurd) precum si
informatiile indexate

W (Write) — scriere — utilizatorul poate edita sau modifica obiecte ELO precum si informatiile
indexate

D (Delete) — stergere — utilizatorul poate sterge obiecte ELO precum si informatiile indexate

E (Edit) — editare — utilizatorul poate doar sa editeze obiecte ELO. Utilizatorii cu acest drept nu pot
accesa informatiile indexate. Acest fapt inseamna ca se poate desemna unui utilizator dreptul de
editare asupra documentelor fara ca acestia sa aiba dreptul de a modifica informatiile de indexare
L (Edit lists) — editare liste — Aceasta permisiune se aplica strict folderelor. Utilizatorii ce detin
permisiunea de Edit lists pot schimba continutul respectivului folder. De exemplu, pot crea
documente in folder sau pot muta documente din folder.

P (Permission) — permisiuni — acest drept permite utilizatorilor sa gestioneze schimbarile in
permisiuni si drepturi de acces asupra obiectelor ELO din arhiva (documente, foldere). Utilizatorii
ELO care au drepturi de acces pe un anumit obiect ELO pot schimba setarile de permisiuni.
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Proprietati precum: posibilitatea de a aloca o data de expirare a parolei, necesitatea de a schimba parola
in mod obligatoriu sau optional, posibilitatea de alocare unei unitati organizationale

9.5.2 Unitati organizationale
Unitatile organizationale sunt necesare pentru organizarea utilizatorilor. Acestea pot combina mai multe grupuri
de utilizatori. Utilizatorii dintr-o unitate organizationala vor fi capabili sa vada doar utilizatorii din acea unitate.

9.5.3 Campuri de indexare
Campurile de indexare si formularele de indexare sunt doua zone de lucru strans legate intre ele si se refera la
modalitatea de indexare a documentelor si formularele electronice necesar a fi completate de utilizatori atunci

cand adauga un document sau un element de structura nou.
Definirea campurilor de indexare se realizeaza din sectiunea dedicata din consola de administrare prin apelarea

meniului vertical din interfata.
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La apelarea acestuia, se deschide interfata pentru camp de indexare nou in care se pot adauga:
- Informatii generale precum:

- Numele campului de indexare
- Modalitatea de afisare: cu acces normal, read-only sau camp ascuns din interfata
- Caracteristicile informatiei care se va putea indexa (Input):
- Se poate aloca tipul datelor (text, numeric, ISO date, etc)
- Se poate stabili o lungime minima/maxima a informatiei indexate
- Se pot utiliza expresii regulate pentru validarea continutului
- Poate fi alocata o valoare standard, precompletata
- Posibilitatea de a marca acest camp ca obligatoriu la completare
- Este posibila includerea unei descrieri a campului care sa fie afisata utilizatorului in momentul
in care acesta trece cu mouse-ul peste campul respectiv
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Proprietatile campului de indexare: in aceasta zona pot fi definite campurile cu prioritate ridicata sau
pot fi setate posibilitati de mostenire a informatiei catre elementul parinte/copil. Se asigura astfel

preluarea metadatei chiar daca aceasta nu a fost asociata de la bun inceput obiectului/documentului
respectiv

Liste de indexare asociate: sectiunea permite doar intrari din liste de cuvinte cheie. Acest lucru

permite structurarea metadatelor si prevenirea erorilor manuale. Este astfel asigurata standardizarea
informatiei.
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Permisiuni: drepturile in sistem se pot acorda pana la nivel de camp de indexare. In aceasta zona se
poate stabili daca un utilizator/grup de utilizatori are acces la acest camp. Drepturile ce pot fi stabilite
pentru campul de indexare sunt de vizualizare si scriere.

Prezentare generala a formularelor de indexare: in aceasta zona sunt listate toate formularele de
indexare care contin acest camp de indexare, ca in exemplul de mai jos:
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9.5.4 Formulare de indexare / tipuri de documente

Sectiunea permite administratorului de sistem sa defineasca, sa modifice, sa intretina si sa stearga formulare de
indexare.

Interfata in care actioneaza administratorul de sistem este impartita in mai multe zone:

- Informatii generale unde se atribuie numele formularului si se pot consulta detalii precum ID-ul
formularului in sistem sau GUID-ul atribuit. De asemenea, tot aici este disponibila informatia cu privire
la ultima modificare realizata asupra formularului, cu mentionarea datei si a orei la care aceasta a fost
realizata.

- Utilizare: Formularele de indexare pot fi folosite la nivel de folder, documente, cautare si/sau relatie.
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Daca aceasta optiune este activata, puteti stabili o legatura intre formularul de metadate si campurile de tip
Relatie. Prin intermediul campului de tip relatie, puteti selecta doar formulare de metadate in care aceasta
optiune este activata, cum se poate vedea si in exemplul de mai jos:

Campurile de relatie stabilesc o conexiune cu formularele de metadate relationale corespunzatoare. Campurile
de relatii pot fi utilizate pentru a afisa campurile prioritare ale formularului de metadate asociat ca o lista de
cuvinte cheie. Puteti recunoasteti cdmpurile de relatie dupa pictograma lantului.

Nu in ultimul rand, optiunea de , utilizare determinata de elementul parinte”. Daca aceasta este activata, atunci
acest formular de metadate este disponibil doar in situatia in care utilizatorii inregistreaza sau creeaza o intrare
secundara intr-un folder care este restrictionat la acest formular de metadate.

- Campuri: in aceasta zona este afisat preview-ul campurilor ce compun formularul de indexare. Pot fi
realizate o serie de actiuni asupra acestora: se pot adauga campuri de indexare noi, se pot sterge din
cele existente, se pot muta campuri. Interfata permite creearea a pana la 200 de campuri de metadate
pe fiecare formular de indexare.

De asemenea campurile de indexare pot fi organizate in tab-uri separate, care se pot defini tot din aceasta
interfata.
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- Permisiuni la nivel de formular

ELO permite aplicarea automata a unui set de reguli de securitate, la incarcarea documentelor in arhiva si
ulterior, in functie de metadatele documentului. Regulile de securitate pot fi stabilite per tip de document in
consola de administrare, prin aplicarea politicii de drepturi si permisiuni asupra acestora:

Astfel, doar utilizatorii/grupurile de utilizatori mentionate vor avea acces asupra acestora. Regulile se aplica
automat la incarcarea documentelor in arhiva.

- Optiuni pentru intrare: aceasta zona este dedicata pentru configurarea optiunilor cu privire la
informatia indexata. Pot fi stabilite detalii precum culoarea fontului la afisarea tipului de document

sau setarea statusului documentului, care va fi aplicat documentelor arhivate cu acest formular de
indexare.
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Aici se poate stabili durata de viata a unui tip de document (formular de indexare) prin completarea a doua
campuri: perioada de retentie si perioada de stergere. Sunt permise configurari cu privire la optiunile de pastrare
la nivelul zilelor, al saptamanilor, al lunilor si chiar al anilor.

De asemenea, pentru protejarea informatiei continute, este permisa atribuirea cheilor de criptare in situatia in
care se doreste criptarea documentelor ce urmeaza a fi arhivate cu acest formular de indexare. De asemenea, se
poate opta si pentru varianta de fara criptare.

- Permisiuni pentru intrare — aici se definesc drepturile pentru documentele arhivate. Drepturile se pot
atribui la nivel de utilizator sau grup de utilizatori si se pot aloca toate drepturile disponibile:
vizualizare, scriere, stergere, editare, editare, editare liste si setare permisiuni.
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Reguli de arhivare: este permisa configurarea modalitatii de generare a caii de arhivare a
documentelor sau asocierea unor fluxuri de lucru la arhivare/check in documente:

crearea caii de arhivare in mod automat in situatia in care folderele de destinatie nu exista
inca in momentul in care se arhiveaza documente noi in sistem

crearea caii de referinta in mod automat, care se genereaza in conditii similare cu calea de
arhivare

administratorul sistemului are posibilitatea de definire a caii de arhivare prin intermediul unei
reguli dedicate care va guverna modul in care documentele sunt arhivate automat in ELO.
Aceste reguli pot contine componente fixe sau variabile — Exemplu:
[flInvoices]+LD(7,4)+[]+L1(1,1)

Flux de lucru implicit: din interfata este permisa selectia fluxului de lucru care va fi initiat in
momentul in care se arhiveaza un document nou in sistem cu formularul de indexare specific.
Flux de lucru la check-in: din interfata este permisa selectia fluxului de lucru care va fi initiat
in momentul in care un document este arhivat prin check-in cu acest formular de metadate.

Informatii cu privire la codurile de bare: Aceasta zona listeaza regulile definite folosind wizardul
pentru coduri de bare.
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Privire de ansamblu asupra campurilor componente: aceasta zona contine o prezentare generald a
campurilor alocate formularului de indexare. Tabelul cuprinde, de asemenea, ID-urile campurilor ce
pot fi utilizate la definirea caii de arhivare.
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9.5.5 Liste de indexare
Sectiunea aceasta este dedicata creearii, editarii si intretinerii listelor de cuvinte cheie sau nomenclatoare.

Interfata prezinta trei sectiuni:
- In partea stanga sunt afisate listele de indexare existente in sistem

- In partea dreapta sunt prezentate informatii generale ale unei liste, precum si componenta acesteia.

Pentru editarea si intretinerea unei liste de cuvinte cheie se selecteaza lista din coloana din partea stanga a
interfetei si se realizeaza modificarile si actualizarile necesare.

Sunt disponibile o serie de operatii ce pot fi realizate asupra unei liste de cuvinte cheie existente:
- Se pot adauga intrari suplimentare in cadrul listei
- Pot fi adaugate intrari de tip copil, anexate uneia sau mai multor intrari principale din lista

- Interfata permite eliminarea intrarilor necorespunzatoare una cate una sau pe toate in acelasi timp
- Ordonarea alfabetica ascendenta si descendenta a intrarilor
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- Posibilitatea de a uni cuvinte cheie din sistem cu o intrare copil selectata
- Posibilitatea de a dezactiva un cuvant cheie, fara a-l elimina din lista

Listele pot fi generate prin importul unui fisier txt.

De asemenea, listele pot fi exportate in format xml.

9.5.6 Tipuride intrari

Prin atribuirea unui tip de intrare, utilizatorul are posibilitatea sa vada dintr-o privire cu ce tip de intrare —
document sau folder- lucreaza. Pictogramele utilizate in acest scop pot fi personalizate. Zona dedicata tipurilor

de intrari cuprinde optiuni precum:
- Posibilitatea de download sau incarcare a seturilor de pictograme sub forma unui fisier ZIP

- Pictograme si definitii pentru foldere
- Pictograme si definitii pentru documente

- Pictograme si definitii pentru foldere

Zona Pictograme si definitii pentru foldere este locul unde se pot defini pictogramele pentru diferite niveluri si
tipuri de foldere in ELO.

- Pictograme si definitii pentru documente

Aceasta zona este locul unde se pot defini pictogramele pentru diferite tipuri de documente in ELO.

La arhivarea in sistem, tipul de document este recunoscut automat in functie de extensia fisierului. Pentru a se
atribui pictogramele folosite la diversele tipuri de obiecte, administratorul de sistem are posibilitatea sa
introduca extensiile de fisiere dorite in cdmpul corespunzator din interfata.
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9.5.7 Caidocumente

ELO gestioneaza mediile de stocare (stocare fizica) folosind caile de documente. In aceasta zona se pot configura
medii noi, se pot face accesibile din nou medii mutate sau se poate verifica spatiul de stocare disponibil pe un
mediu. Calea documentului specifica locul in care documentele sunt stocate fizic. Exista o cale de stocare
predefinita care se seteaza la instalare, dar se pot defini si alte cai de stocare, cum ar fi o cale de salvare, sau se
pot adduga si alte cdi de stocare sau se poate verifica spatiul disponibil.

Este posibila inclusiv mentionarea unei cai separate de document pentru fiecare document in parte in momentul
in care i se asociaza metadatele. Acest lucru este posibil in situatia in care administratorul de sistem selecteaza
optiunea ,No fixed assignment” drept cale a documentului in momentul in care se defineste formularul de

metadate.

Setari pentru gestionarea mediilor de stocare:
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ELO permite administratorului sa opteze pentru cale WORM (write once read many). In cazul selectiei acestei
optiuni, calea va putea fi utilizata de aplicatii de tipul jukebox storage.

9.5.8 Cai implicite documente

In zona cai implicite pentru documente, se pot specifica ce cai sa fie utilizate drept cai de documente sau cdi de
restaurare.

9.5.9 Chei de criptare

ELO ECM permite utilizatorilor sa protejeze documentele depozitate in arhiva folosind criptarea AES-256
(Advanced Encryption Standard). Cheile de criptare sunt create si configurate in ELO Administration Console.
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Se poate utiliza orice numar de chei de criptare. Se recomanda sa nu se depaseasca un numar ce ar putea deveni
greu gestionabil.

Documentele criptate cu AES-256 pot fi adaugate la baza de date fulltext.

9.5.10 Managementul URL-urilor

Administratorul de sistem are posibilitatea ca in aceasta zona sa introduca URL-urile pentru diferite module ELO.

9.5.11 Stampile

In aceasta zona administratorul sistemului are posibilitatea definirii unor tipuri de stampile noi pe care utilizatorii
sa le poata utiliza pe documente in mod similar stampilelor fizice.
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Setarile pentru stampile se pot realiza la nivel global pentru toti utilizatorii sistemului sau la nivel de individ sau
de grup.

Este disponibila o lista de stampile standard din care se pot selecta si edita stampilele dorite, pot fi adaugate
stampile noi sau sterse din cele existente.

Pentru fiecare stampila este disponibil un editor care permite configurarea proprietatilor acestora:
- Numele stampilei
- Textul cuprins
- Fontul si caracteristici ale acestuia: dimensiune, bold, italic, underline, culoare, etc
- Exista o zona de preview care etaleaza stampila

Asupra fiecarui tip de stampila in parte se pot aloca permisiuni catre utilizatori sau grupuri. Sunt disponibile
urmatoarele tipuri de permisiuni:

- Vizualizare (R) — utilizatorul/grupul poate vizualiza stampila aplicata

- Modificare (W) - utilizatorul/grupul poate modifica dimensiunea stampilei

- Stergere (D) - utilizatorul/grupul poate sterge stampila

- Mutare (E) - utilizatorul/grupul poate muta stampila in cuprinsul documentului

- Setare permisiuni (P) - utilizatorul/grupul poate schimba nivelul de permisiuni al stampilei. Acest grup

necesita si dreptul de editare permisiuni.

Mai pot fi aplicate urmatoarele drepturi:
- AND group — selectia butonului conecteaza doua sau mai multe grupuri. In cazul acesta, permisiunile
alocate se vor aplica strict membrilor care fac parte din toate grupurile conectate ca un AND group.
- Owner rights — butonul ofera permisiuni utilizatorului care a definit stampila

Configurarea stampilelor permite inclusiv utilizarea placeholderelor, precum se poate vedea si in exemplul
urmator:
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De asemenea, este permisa inclusiv incarcarea unei stampile noi format imagine de tipul PNG, JPG, GIF si BMP.

9.5.12 Proprietati depozit de arhiva

Aici se seteaza numele afisat al depozitului de arhiva. Acest nume este vizibil in mai multe locuri din client
(exemplu: folderul radacina al structurii arborescente a clientilor). Schimbarile realizate asupra numelui afisat au
efect dupa restartul clientului.

9.5.13 Culori fonturi

Zona este dedicata culorilor utilizate pentru afisarea intrarilor. Este posibila atribuirea unei culori separate pentru
fiecare tip de document si folder. Lista de culori contine toate culorile fonturilor disponibile pentru depozitul de
arhiva corespunzator. In zona setérilor de culoare este permisa editarea setérilor intrarilor selectate. Culorile pot
fi stabilite prin intermediul picker-ului din campul si glisorul de culoare sau prin selectia exacta utilizand valorile
RGB, HSB sau hexadecimale.
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9.6 Maintenance (Mentenantad)

n aceasta zona de lucru se gestioneazd urmatoarele: rularea in modul administrator a sistemului, optiuni pentru
raportare, setdri de backup, proprietati parole, mutarea fisierelor pe alte medii de stocare.

Zona dedicata Mentenantei
9.6.1 Modul administrator

Modul de administrare poate fi folosit pentru a restrictiona accesul utilizatorilor la clientii ELO, pentru situatii
precum realizarea operatiunilor de intretinere a sistemului.
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Daca modul de administrare este activat, numai utilizatorii cu drepturi de administrator se pot conecta la clientii
ELO. Modul de administrare este activ pentru toate depozitele care sunt accesate de acelasi ELO Access Manager.

9.6.2 Optiuni raportare (Report options)

n aceasta zona de raportare, administratorul poate defini setirile pentru fisierele de jurnalizare (log) si activitati
inregistrate Tn ELO. Se poate alege intre variantele de raport succinct care sa afiseze in fisierul log doar
evenimentele selectate, raport extins care sa cuprinda evenimentele selectate si raport integral cu toate actiunile

din sistem.

9.6.3 Stergere si indepartare

Functia de stergere si indepartare contine setdrile pentru stergere si eliminarea documentelor din depozit.
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In zona pentru stergerea permanenta administratorul are posibilitatea de a sterge definitiv intrari, versiunile
documentului si fisierele atasate care sunt marcate pentru stergere (functia de stergere) din ELO si baza de date.
Aceste intrari nu pot fi restaurate in sistem dupa stergere.

Eliminati intrarile sterse: pentru a elimina definitiv toate folderele si documentele sterse din ELO, se activeaza
aceasta bifa.

Eliminati versiunile documentelor sterse si versiunile atasate: pentru a elimina definitiv toate versiunile de
document si atasamentele de fisiere sterse, se activeaza aceasta bifa.

Data stergerii pana la: Data specificata in aceasta zona este data pana la care trebuie sterse obiectele din sistem.
Prin apasarea butonului Delete permanently — se activeaza procesul de stergere cu setarile selectate.

In zona pentru stergerea intrarilor a caror perioada de retentie a expirat, administratorul are posibilitatea de a
sterge definitiv documentele cdrora li s-a atribuit o perioada de retentie. Sistemul permite optarea pentru
stergerea stricta a documentelor sau a documentelor si a folderelor.

9.6.4 Taskuri de backup

Sectiunea gestioneaza activitatile pentru backup. Tot in aceasta zona administratorul de sistem are posibilitatea
sa elimine automat documentele vechi. (Documentele vechi sunt documente stocate in ELO pentru care s-a
realizat backup si care au atins durata de viata minima definita).
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9.6.5 Reguli pentru parole

Zona este dedicata pentru definirea regulilor de securitate pentru parole.

Sistemul permite definirea politicilor de parolare atat pentru utilizatori individuali si grupuri, cat si la nivel global.
ELO permite administratorului de sistem sa selecteze un grup si sa creeze o regula de parolare pentru acel grup.
Se pot activa de exemplu optiuni ca parola sa contina de exemplu:

- Cel putin o litera

- Cel putin un caracter special

- Cel putin o litera mica si o litera mare

- Cel putin un numar

Setarile din aceasta zona alaturi de optiunile existente in zona de gestiune a utilizatorilor stabilesc regulile de
securitate pentru parole.

In zona de gestiune a utilizatorilor, la proprietatile acestora, se pot alege optiuni precum:
- utilizatorul trebuie sa-si schimbe parola la data mentionata
- utilizatorul trebuie sa-si modifice parola la urmatoarea logare in sistem
- utilizatorului i se solicita modificarea parolei dar are posibilitatea de a refuza acest lucru si sa continue
logarea cu parola originala, caz in care cererea de modificare va fi afisata la fiecare incercare noua de
logare in sistem, pana la modificarea parolei.

ELO nu stocheaza parolele utilizatorilor in text clar sau folosind o functie hash care este considerata nesigura.
Sistemul permite definirea politicilor de parolare atat pentru utilizatori individuali si grupuri, cat si la nivel global.

De exemplu, pentru utilizatori individuali, administratorul de sistem are posibilitatea de a defini proprietati cu
privire la parola direct din zona dedicata definirii userului:

9.6.6 Fisiere pentru mutare
n zona de fisiere pentru mutare administratorul are posibilitatea sa mute fisiere, versiuni de fisiere,

atasamente si/sau versiuni de atasamente catre o alta cale. Se pot selecta informatii precum:
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- Calea sursa: se poate alege mutarea documentelor din toate caile sau doar dintr-o anumita cale
selectata

- Calea target

- Intervalul datei de arhivare: actiunea poate fi restrictionata la nivelul unei perioade specifice. La
selectia unei perioade, doar documentele arhivate in intervalul respectiv vor fi mutate.

- Interfata detine si o optiune de generare a unui raport asupra numarului si dimensiunii fisierelor care
trebuie mutate in functie de setarile administratorului.

9.7 Module server (Server modules)

n aceastd zond de lucru se gestioneazi setérile pentru ELO Automation Services si ELO Backup, setérile pentru
serviciul fulltext, pentru ELOtransport, pentru fisierele de configurare si parole criptate

Setari pentru Server modules

9.7.1 ELO Automation Services
[ | ELO Automation Services permite definirea de reguli automate de business pentru a controla sau realiza
anumite sarcini si evenimente in depozitul de documente ELO. Seturile de reguli se pot gestiona in aceasta
zonad din consola de administrare.
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9.7.2  Backup Profiles

Administratorul poate defini profilele de backup folosind aceasta functie. Zona dedicata contine:

- o sectiune pentru lista profilelor de backup: de aici se pot realiza cautari in lista de profile de backup,
se pot adauga profile de backup noi sau se pot sterge profilele existente

- o sectiune pentru setarile acestora: aici se pot stabili detalii precum numele profilelor de backup, se
pot adauga stringuri SQL dedicate. Interogarea SQL poate fi utilizatd, de exemplu, pentru a restrictiona
documentele selectate pentru backup.
Tot din aceasta sectiune se pot stabili dimensiunea pachetelor sau calea pentru backup. In campul
pentru numarul slot-ului, in situatia in care se utilizeaza juckebox-uri pentru backup, se poate
introduce numarul slotului din meniul de tip drop-down.

9.7.3  Full text service (Textreader)

Zona aceasta este dedicata setarilor pentru serviciul fulltext si Textreader. La sectiunea dedicata return directory
administratorul are posibilitatea de a specifica locul unde doreste salvarea fisierului procesat.
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Sectiunea pentru folderele pentru output si configurarile specifice este dedicata definirii directoarelor de iesire
pentru diferite tipuri de fisiere. Serviciul fulltext face diferenta intre extensiile fisierelor in timpul procesarii.

Setarile Textreader pot fi configurate in zona de setari si configurari suplimentare (de exemplu se pot defini
detaliile cu privire la timpul de start pentru operatiunile de export si import).

Optiunile OCR sunt configurate din zona dedicata. Se pot stabili aici:
- modul de citire OCR — una sau mai multe coloane. OCR face citirea textelor din tabele linie cu linie in

modul pentru o singura coloana. Textul este recunoscut mai rapid in modul pentru coloane multiple.

- Tipul de citire OCR poate fi detaliata sau rapida. Un scan OCR detaliat este recomandat pentru situatia
in care calitatea scanarii este scazuta. Pentru o calitate buna a scanarii, optiunea de citire OCR rapida
este suficienta.

- Selectia limbilor suportate de procesul OCR

9.7.4 Create password

Aici este permisa crearea parolelor criptate pentru ELO. In zona de Input este adaugata parola necriptata.
Parolele criptate apar automat in campurile pentru parola criptata ELO, parola criptata ELOas database si parola
Coded Base64.
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9.7.5 ELO Transport

Zona ELO Transport este folosita pentru a crea fisiere de transport. Un fisier de transport poate contine informatii
despre utilizatorii ELO, culorile fontului, liste de cuvinte cheie, formulare de metadate, dosare si documente.
Informatia este stocata intr-un fisier care poate fi importat intr-un depozit de arhiva ELO.

Aceste fisiere de transport sunt utilizate atunci cand dorim sa mutam configurari de pe un sistem de test pe unul
de productie, de exemplu.

9.7.6  Configuration files

O imagine de ansamblu a fisierelor de configurare este disponibild in optiunea ”Configuration files”. Tot de aici
fisierele de configurare pot fi editate prin simpla selectie a acestora si realizarea modificarilor in script.
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9.8 Informatii sistem (System information)

Aceastd zona de lucru ofera o serie de informatii despre sistemul ELO, cum ar fi: informatii despre folderul de
administrare, despre server si Indexserver, statistici referitoare la depozitul de documente ELO, un raport al
licentelor, lista utilizatorilor autentificati in sistem, vizualizarea fisierelor de log al sistemului, monitorizarea starii

aplicatiilor ELO sau verificarea de tip check-sum a documentelor.

Zona dedicata pentru Informatii sistem
9.8.1 Administration folder

In aceasta zona sunt afisate GUID-urile pentru foldere. Lista GUID-urilor este utila in situatii care presupun
automatizari de taskuri si gestionarea acestor foldere prin scripturi dedicate.
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9.8.2 Server information

Administratorul de sistem poate consulta un raport cu privire la setarile serverului. Informatiile cuprind detalii
despre Indexserverul curent precum si Indexservere aditionale alocate ELO Access Manager.

9.8.3  Utilizatori din sistem

Zona contine o prezentare generala a utilizatorilor care sunt in prezent conectati la sistem, prin intermediul carei
aplicatii si versiunea acesteia. Se pot realiza cautari in raport in functie de utilizator si sistem.
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9.8.4  Statistici

Administratorul de sistem poate vizualiza o statistica a ID-urilor asignate in depozitul de arhiva pentru intrari si
documente.

9.8.5 Privire de ansamblu asupra licentelor (License overview)

Aceasta optiune ofera o prezentare generala a utilizarii licentelor. Raportul poate fi descarcat ca fisier txt
compresat intr-un fisier ZIP.
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9.8.6 Raport de licenta (License report)

Optiunea ofera un raport cu privire la accesul si licentele utilizate in ELO.

Raportul poate fi descarcat in format txt comprimat intr-un fisier ZIP. Acest raport este utilizat de catre
administratorul de sistem in momentul actualizarii licentelor.

De asemenea, tot aici se pot consulta si informatii despre utilizatori care au efectuat actiuni de scriere prin client
ELO si prin Indexserver sau modulele corespunzatoare.
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9.8.7 Fisiere log

Prin intermediul optiunii ”"Log files” se pot vizualiza fisierele de log pe care le-a generat serverul. Sunt disponibile
mai multe optiuni de filtrare a fisierelor de log, astfel incat sa fie prezentatd doar informatia pe care
administratorul doreste sa o vizualizeze, precum si nivelul de detaliu al acesteia. Aceste loguri pot fi accesate de

administratorii sistemului.

De asemenea, logurile componentelor se afla stocate pe disk in directorul de instalare si pot fi accesate de
administratorii sistemului de operare pe care este instalat ELO

9.8.8 Monitoring

Functia permite administratorului de sistem monitorizarea si vizualizarea statusului diferitelor aplicatii web.

Sistemul permite adaugarea unor aplicatii suplimentare prin intermediul unui wizard. Dupa setarea datelor de
conectare, este posibila selectia aplicatiilor care vor fi monitorizate.
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9.8.9 Test checksums

Aceasta functie este destinata verificarii de tip checksum pentru unul sau mai multe documente.

Sistemul permite realizarea acestei verificari pentru un document, pentru un interval de documente prin
introducerea in cele doua campuri a gamei de ID-uri care sa fie verificate sau pentru verificarea tuturor ID-urilor
din sistem. In mod standard, la accesarea functiei, sunt incluse cel mai mic si cel mai mare ID din platforma.

Raportul poate fi in forma scurta sau complet (prin bifarea optiunii de full report). Raportul generat poate fi
descarcat in format txt si consultat de catre administratorul sistemului.

] ChecksumReportCollectorTask_13045807434157119395 - Notepad

File Edit Format View Help
http://192.168.10@.102:9090/ix-ELODEMO/ix

From document

ID: 1

To document ID: 28563

docid=1, MdS:
docid=2, Md5:
docid=3, Md5:
docid=4, MdS:
docid=5, Md5:
docid=6, Md5:
docid=7, Md5:
docid=8, Md5:
docid=9, Md5:
docid=18, MdS
docid=11, Md5
docid=12, Md5

docid=13. Md5:

[stored=358FE78C121D60A6DB2565ADB1799A48,
[stored=8F823A5D57D066(81B26C1593DES6REBRS,
[stored=39F5D565DE35C9F6D5@43E39379D3705,
[stored=394543E81A9890ED96IEBCAIESEBDE53,
[ stored=B4B27CBC1276D4BF3D1CE7CBB66ASADD

[stored=3C1281ED89369B5095AF76423FB6B5AF,
[stored=6096F2C4739BE913F2E135B7E5D587C7

[stored=8CB7EAEA92128AI9EDDAB32A13E359A91

[stored=-886BDIAAB3569444E4AAB3F496F170D3,
: [stored=FC93DA543C56AF1F2F773EAB112481A5,
: [stored=F4D@93EBICISD1274F26B3E83F945D56
1 [stored=C44B4C826FBACAATCAE28659A12F9971
[stored=9FD@1E422FAR384691637DFF662E201B

new=358FE78C121D60A6DB2565ADB1799A48,
new=8F823A5057D66(81B26C1593DE560EBS,
new=39F5D565DE35C9F6D5@43E39379D3705,
new=994543E@1A9898EDI6IEBCAIES68D853,
new=B4B27CBC1276D4BF3D1CE7CBB66ASADD
new=3C1281ED89369B5895AF76423FA6B5AF,
new=6096F2C4739BE913F2E135B7E505B7C7,
new=@CB7EAEA92128A9EDDAB32A13E359A91,
new=886BD9AAB3569444E4AAB3F496F170D3,
new=FC93DA543C56AF1F2F773EABL12401A5,
new=F4D@99EB1CISD1274F26B3EB3FI45D56,
new=C44B4C826FBACAATCAE2Z8659A12F9971,
new=9FD@1EA22FAB384691637DFF662E2018

match=true]
match=true]
match=true]
match=true]
match=true]
match=true]
match=true]
match=true]
match=true]
match=true]
match=true]
match=true]
match=truel

Pagina 332 din 337



9.9 Clients (Clienti)

Aceasta zona este dedicata definirii setarilor pentru clientul ELO Web si app-urile ELO pentru Dispozitive Mobile.

Zona dedicata clientilor ELO

9.9.1 Configurare ELO Web Client

Pentru ca optiunea de configurare a ELO Web Client sa fie disponibila, este necesara instalarea si functionarea in
parametri optimi a clientului ELO web.

Functia este dedicata configurarii clientului ELO Web. La accesarea acesteia, administratorul este transferat
automat la zona de configurare a clientului ELO Web.
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9.9.2 Configurare ELO pentru Dispozitive Mobile

Aceasta zona este dedicata modificarii functiilor dinsponibile in clientii pentru dispozitive mobile pentru Android
si i0S. Administratorul de sistem are posibilitatea sa restrictioneze accesul la anumite zone de lucru pentru
utilizatori sau grupuri.

Setarile se pot asigna la nivel general, in mod standard interfata permite realizarea configurarilor aplicabile la
nivel global, pentru toti utilizatorii si grupurile din sistem. De asemenea, este permisa asignarea setarilor la nivel
individual sau la nivel de grup, prin accesarea butonului de selectie user.

9.10 LDAP

Pentru integrarea cu LDAP/Active Directory exista zone dedicate de configurare pentru a realiza importul si
sincronizarea ulterioara:
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Zona dedicata integrarii cu LDAP

9.10.1 LDAP Import

LDAP import asigura importul utilizatorilor si al grupurilor din directorul LDAP in solutia ELO.

9.10.2 Interfata de configurare LDAP

Functia asigura legatura intre serverul de indexare ELO si interfata LDAP. Administratorul de sistem are
posibilitatea sa introduca setarile pentru domenii multiple.
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9.10.3 Autentificare LDAP

Optiunea asigura setarile globale si activeaza autentificarea prin LDAP.

In situatia in care optiunea de Creare automata a utilizatorilor noi este activata — un utilizator nou este creat
automat in ELO dupa conectare.

Daca optiunea Atribuire grup este activata, utilizatorii sunt alocati automat grupurilor LDAP corespunzdtoare.
Pentru ca aceasta sa functioneze, grupurile trebuie create in ELO si numele trebuie sa se potriveasca cu numele
grupurilor din LDAP.

Functia are si o optiune care sa permita selectia utilizatorilor/grupurilor ELO care sa nu se autentifice cu LDAP, ci
sa se autentifice direct.

9.11 Altele

9.11.1 Blocare acces

Cu aceasta functie, administratorul de sistem are posibilitatea de restrictionare a accesului la ELO pe baza
apartenentei la un grup selectat.

La accesarea optiunii, in campul dedicat accesului pentru grupuri, se poate selecta un grup existent in sistem. In
cazul acesta, doar membrii componenti ai grupului respectiv vor avea posibilitatea de a se autentifica la depozitul
de arhiva.
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10 Integrarea cu alte sisteme

10.1 Rest API

ELO detine o componenta Rest API care ofera aplicatiei conectivitate si data transformation, posibilitatea de
orchestrare a serviciilor, message streaming in timp real, captura de date si management API, toate intr-un singur
loc, pentru a conecta aplicatii si date intr-o infrastructura hibrida. Este combinat cu o serie de instrumente ce
sprijina dezvoltarea moderna a aplicatiilor.

10.2 ELO XML

ELO XML este un modul care furnizeaza un serviciu pentru importul masiv de documente in depozitul ELO
folosind fisiere de tip XML.

Un fisier XML contine informatii despre organizarea listei de cuvinte cheie din cadrul unui document, precum si
locul din arhiva electronica unde documentul ar trebui stocat alaturi de drepturile de acces pe care acesta ar
trebui sa le primeasca. O sursa de date, precum un sistem ERP implementat intr-o companie, genereaza automat
un document (factura, chitanta, confirmare de predare, etc) iar in plus pe langa acest document, datele aferente
sunt stocate si intr-un fisier secundar de tip XML.

Informatiile despre cuvintele cheie pot fi localizate tot aici. Serviciul de import al ELO XML preia ambele fisiere,
evalueaza fisierul XML si clasifica documentul in locul corespunzator din arhiva electronica ELO, impreuna cu lista
de cuvinte cheie. Nu mai este necesara culegerea manuala a informatiilor cu privire la cuvintele cheie din
documente. Serviciul de import arhiveaza automat documentele in ELO, cu un minim de efort de programare.
Stabilirea cuvintelor cheie Tn avans este etapa cea mai importanta, serviciul de import al ELO XML avand singur
grija de restul operatiunii.

Metoda de integrare folosita de ELO pentru sistemele externe care folosesc fisiere in format XML este prezentata
n figura de mai jos:

Procesul de import masiv — ELO XML
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